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Raster Imaging Technology copyrighted by Snowbound Software Corporation 1993-2001
CAM-POST ® Version 2001/14.0 © ICAM Technologies Corporation 1984-2001. All rights reserved
The 2D/2.5D Display analysis function, the MSC.Nastran interface and the ANSYS interface are based on LMS
International technologies and have been developed by LMS International
ImpactXoft, IX Functional Modeling, IX Development, IX, IX Design, IXSPeeD, IX Speed Connector, IX Advanced
Rendering, IX Interoperability Package, ImpactXoft Solver are trademarks of ImpactXoft. Copyright ©20012002 ImpactXoft. All rights reserved.
This software contains portions of Lattice Technology, Inc. software. Copyright © 1997-2004 Lattice
Technology, Inc. All Rights Reserved.
Copyright © 2005, Dassault Systèmes. All rights reserved.
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Overview
Welcome to the Quick Surface Reconstruction User's Guide!
This guide is intended for users who need to become quickly familiar with the product.
This overview provides the following information:
●

Quick Surface Reconstruction in a Nutshell

●

Before Reading this Guide

●

Getting the Most Out of this Guide

●

Accessing Sample Documents

●

Conventions Used in this Guide

Quick Surface Reconstruction in a Nutshell
Quick Surface Reconstruction
easily and quickly recovers surfaces from digitized data that has been
cleaned up and tessellated using the Digitized Shape Editor product.
Quick Surface Reconstruction offers several approaches to recover surfaces depending of the type of shape :
●

Organic shapes, i.e. free form surfaces, without features such as cylinders, fillets, planes, etc.

●

Mechanical shapes (plane, cylinder, sphere, cone).

Thanks to Quick Surface Reconstruction tools that analyze curvature or iso-slope properties, users can easily
create mesh segmentations in pertinent surfaces area. Quick Surface Reconstruction includes its own quality
checking tools.
The Quick Surface Reconstruction user's guide has been designed to show you how to reconstruct surfaces
using these powerful tools. We recommend that you go through the "Getting Started" chapters first, to learn
more about those working methods.

Before Reading this Guide
Prior to reading the Quick Surface Reconstruction User's Guide, you are recommended to have a look at
the Infrastructure User's Guide for information on the generic capabilities common to all products.

Getting the Most Out of this Guide
To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter
first of all and the Workbench Description to find his way around the Quick Surface Reconstruction
workbench.

Quick Surface Reconstruction
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Accessing Sample Documents
To perform the scenarios, sample documents are provided all along this documentation. For more information
about this, refer to Accessing Sample Documents in the Infrastructure User's Guide.

Quick Surface Reconstruction

Version 5 Release 16

Page 8

What's New?
New Functionalities
Sketch from Scan
This action recognizes line, circles or ellipses from planar scans and builds a sketch with those elements.
Automatic Surface
This action creates surfaces automatically from a mesh.
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Getting Started
The following tutorial aims at giving you a feel of what you can do with Quick Surface Reconstruction.
It provides a step-by-step scenario showing you how to use key capabilities.
Quick Surface Reconstruction offers several approaches:
●

●

●

N-side domain approach with boundary constraints and deviation tolerance through inner points:

●

reconstructs surfaces that do not require the conservation of fillets or mechanical features,

●

is a good compromise between quality and productivity,

●

the result can be adjusted by deformation of the domain.

Untrimmed approach:

●

reconstructs surfaces including the fillets,

●

does not require the creation of curves,

●

enables the recovery of virtual sharp edges,

●

applies fillets on virtual edges (adjustable radius).

Mechanical approach:

●

reconstructs surfaces with fillets and mechanical features

●

models virtual sharp edges,

●

identifies mechanical features,

●

reconstructs fillets on virtual edges

●

enables to modify fillets and mechanical features through their parameters.

Whatever the method you choose, we recommend to work with meshs rather than with clouds of points.

The "Getting Started" part of this guide will illustrate the first approach, with the following tasks:
Starting the Quick Surface Reconstruction Workbench
Preparing the Part
Reconstruction of Surfaces
Note that we have changed the color of curves to blue and eventually renamed elements in the specification
tree.

Quick Surface Reconstruction
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All together this scenario should take 15 minutes to complete.
The final cloud element will look like this:
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Starting the Quick Surface Reconstruction
Workbench
The first task will show you how to enter the Quick Surface Reconstruction workbench and open data.
The only pre-requisites for this task is to have a current session running.
1. Choose Quick Surface Reconstruction from the Start menu.
2. The Part name dialog box may appear depending on the way you customized your session.
It provides
❍

a field for entering the name you wish to assign to the part,

❍

an option that enables hybrid design

❍

and another one that inserts a geometrical set in the part to be created.

For more information, refer to the Part Document chapter in Customizing section of the
Part Design documentation

Click OK. The Quick Surface Reconstruction workbench is displayed and ready to use.

3. Click the Open icon
appears:

or select the File > Open... command. The following dialog box

Quick Surface Reconstruction
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4. In the File Selection box, select the file location.
Open the GettingStarted01.CATPart from the samples directory.

For more information, see Creating, Opening and Saving Documents in the Infrastructure User's Guide.
If you wish to use the whole screen space for the geometry, uncheck Specification in the View menu.
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Preparing the part
This task prepares the part for the reconstruction:
●
creation of a curve defining a symmetry plane,
●

creation of a surface tangent to the mesh,

●

definition of reconstruction zones.

Open the GettingStarted01.CATPart from the samples directory.
Create the curve defining the symmetry plane:

1. Click the Planar Sections icon

and the select the mesh.

2. Select the xy plane, enter 1 for the number of sections.
Move the plane slightly upwards until a complete scan is visible.
Click Apply, the scan is computed, PlanarSections.1 is displayed in the specification tree.

3. Check the curve creation option. The Curve from Scans dialog box is displayed.
A curve is computed. Its segmentation is displayed, and Curve.1 is displayed in the specification tree.

Page 13

Quick Surface Reconstruction

Version 5 Release 16

4. Set the parameters in the Curve from Scans dialog box to your needs and
pick the requested points on the computed curve to split it into several smaller curves.
The first segmentation proposed is erased and the splitting points are displayed.
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5. Click Apply in the Curve from Scans dialog box: the curves are computed.
Their segmentation is displayed as well as the gaps between the curves and the mesh.
If necessary, pick on a green square to remove this split point,
and pick another point of the scan to create a new split point.
Click Apply to take those modifications into account.

6. If necessary, check the Curvature analysis option to check the quality of the curves created.

7. Once you are satisfied, click OK to validate the curves.
The Curve.1 to Curve.10 elements are created in the specification tree.
8. If you wish, you can change the color of those curves using the Edit/Properties menu.

Create a tangent surface around the mesh:
1. Click the Join icon

and select the curves on the screen.

Change the merging distance to 0.01mm. Click OK.
The Join.1 element is created in the specification tree.
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2. Click the Translate icon

and select Join.1 Enter the z axis for Direction and -15 mm for Distance.

3. Click Preview and OK. The Translate.1 element is created in the specification tree.

4. Click the Multi-sections Surface icon

. Select Join.1 and Translate.1. Click Preview and OK.
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Multi-sections Surface.1 is created in the specification tree.

Define reconstruction zones on the mesh:
1. Use the Plane action from the WireFrame toolbar to create planes through 3 points using
split points of step 1 and their counterpart on Translate.1:
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2. Click the Planar Sections icon

. Select the mesh.

3. Click the Plane icon in the dialog box and select one of the plane you have created.
Enter 1 in the Number field. Create a curve as above. Repeat this step for each plane.
Curve.11 to Curve.16 are created in the specification tree.

4. Click the 3D Curve icon

and create curves as follows:

3D Curve.16 to 3D Curve.21 are created in the specification tree.
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Reconstruction of Surfaces
The first task will show you how to create a clean contour
To make selection easier, hide the following elements:
●
the mesh
●

the curves created to build the tangent surface.

Create a clean contour:

1. Click the Clean Contour icon

and select the following curves or edges:

2. You see that the clean contour action takes the existing constraints into account:
the edges of the surface are fixed.
Click Apply and OK. A Join.2 element is created in the specification tree.
The input curves have been sent to the NoShow.

Page 19

Version 5 Release 16

Quick Surface Reconstruction

Page 20

3. You see that curves have been trimmed.

4. Recall the mesh from the NoShow.

Reconstruct a surface:
1. Click the PowerFit icon

. Select the mesh. It is sent to the NoShow. Select Join.2.
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You can see that existing constraints are again taken into account.
2. In the Parameters frame, check the Radius option and enter 10 as a radius value.
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3. Click Apply and OK. A Surface.1 element is created in the specification tree.

Reconstruct a second surface:
1. If necessary, recall hidden curves from the NoShow and create a clean contour as above.
A Join.3 element is created in the specification tree.
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2. Recall the mesh from the NoShow.
3. Create a second PowerFit surface as above using the recently created clean contour.

4. You can reconstruct the other surfaces the same way.
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User Tasks
Using the Keyboard
Cloud Edition
Scan and Curve Creation
Clean Contour Creation
Surface Creation
Operations
Transformations
Segmentation
Analysis
WireFrame
Interoperability
Display Options
Managing Geometrical Sets
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Using the Keyboard
Key

Command

Action

Shift Activate

Deselects selected elements

Shift 3D Curve

Activates/de-activates the Snap on elements option

Ctrl

Curve from Scans Moves the split points

Ctrl

3D Curve

Projects a point on its constraining element
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Cloud Edition
This chapter deals with the Activation of portions of clouds of points or meshs.
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Activating a Portion of a Cloud of Points
This task shows how to select a portion of a cloud of points or of mesh in order to create a work area,
either:
●
by picking directly elements of the cloud (points, scans, grids, cells, clouds) or
●

by defining a portion of the cloud or mesh with a 2D or 3D trap,

●

by moving a brush over a portion of a mesh.

The free edges displayed are those of the complete mesh:
●
if you activate only a portion of a mesh, the free edges of that portion are not displayed.

Open the Cloud.CATPart model the from the samples directory.
Click here for more information on the dialog box.
1. Click the Activate Areas icon

and the mesh. The Activate dialog box is displayed.
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2. Draw a rectangle by dragging the mouse over the portion you want to select.
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As you release the mouse, the triangles selected are highlighted in red.
When you move the mouse over one corner of the rectangle, dimensioning arrows are displayed,
enabling you to resize the rectangle.

3. Push the Valid Trap button that is now available and draw a second rectangle. Push Valid Trap
again.

Quick Surface Reconstruction
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4. Push the Swap button. The selection is inverted.
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5. Click OK to validate and exit the action.
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Scan and Curve Creation
You can use the following tools to create scans or curves:
Projecting Curves
Cutting by Planar Sections
Free Edges
Creating Associative 3D Curves
Creating Associative 3D Curves on a Scan
Curves from Scans
Sketch from Scan
Creating Intersections
Creating Projections
Selecting Using Multi-Output
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Projecting Curves
This task shows how to project curves on clouds of points or meshes.
The action proposes options to:
●

project the curves perpendicularly onto a mesh (not available for clouds of points),

●

modify the projection direction,

●

smooth computed scans directly into curves.

Open the CurvesOnCloud1.CATPart model the from the samples directory.
You can use either the cloud or the mesh.

1. Click the Project Curves icon

. The curve projection dialog box is displayed.

2. Select the curves to project and the target cloud or mesh.

Curves can be selected:
❍
from the specification tree,
❍

with a selection trap,

❍

with the preselection navigator.

3. If the target is a cloud of points, the projection is automatically computed along a direction.
If the target is a mesh, you can select the Projection type from the list:
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4. If the projection is computed along a direction, the direction proposed by default is the Z axis.
You can choose another direction, using the contextual menu of the Direction field:

❍

❍

the Edit Components option let you enter the coordinates of the direction:

The Compass Direction option takes the compass current orientation as the projection direction.
If you want to change this direction, modify the compass orientation and re-select Compass Direction
to take the new direction into account.

5. If the target is a cloud of points, you may set the working distance:
the input curve is discretized, and each discretization point is projected on the cloud.
The working distance is the distance taken into account around each projection point to compute
the output scan.
Enter 10 then 3 :
The working distance is 10
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The working distance is 3

6. You can set a sag value:
the curve to project is discretized according to this sag value, and each discretization point is
projected on the mesh.
The Sag is set to 1

The Sag is set to 0.01
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7. If you want to create curves, check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature comb
(no curvature analysis dialog box) is displayed.
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❍

If the Curve creation option is checked, curves and only curves will be created.

❍

If the Curve creation option is not checked, scans and only scans will be created.

❍

❍

Page 37

If you need a complete curvature analysis of the curves you create, you have to create the scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into account.

8. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.

❍

Scans are created in the specification tree under the name Curve Projection.x.

❍

Curves are created in the specification tree under the name Curve.x.
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Cutting a Cloud of Points or a Mesh by Planar
Sections
This task shows how to cut a cloud of points or a mesh by planes to compute scans
and to smooth those scans directly to curves.
The computation of sections with limiting curves has been improved:
●
You no longer need to check the Lock Privileged Plane Orientation Parallel to Screen
option of the compass.
●

●

But be careful to choose a view parallel to the screen.
This enhancement enables you to define planar sections with the compass
while using limiting curves.

For an easier selection of curves, you can use the pre-selection navigator
(see the Infrastructure User Guide for more information).
Although cutting a cloud of points is quicker (no need to mesh first), creating planar sections on a mesh
rather than on a cloud of points has some advantages:
●
the action is dynamic on meshes: no need to apply to visualize the modifications
(position of the reference plane, step, number of planes,...),
●

●

In the case of a cloud of points, the intersection may be interpolated, since the plane does not necessarily
intersect points. That problem is reduced with meshes since the plane intersects facets,
providing a better accuracy.

if you process an hybrid CloudsUnion element made of a mesh and a cloud of points,
the planar sections will be created on the mesh only.

Open the Cloud.CATPart model the from the samples directory.

1. Click the Planar Sections icon

and the cloud of points or the mesh.

The Planar Sections dialog box is displayed with its default settings (as shown below):
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❍

Number (of sections) is 1,

❍

Step value is 1,

❍

The Scans option is set to Grouped.

❍

Fixed is set to Step.

❍

The cutting planes are parallel to either YZ, XZ or XY depending on which is
perpendicular to the largest edge of the working box.

❍

The status of the Infinite, Fixed and Scans are modal,

❍

The Number and Step values are modal.

2. Use the Plane Definition

icons to select the reference plane according to your need:
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❍

push the YZ

❍

push the compass icon

❍

push the plane icon

❍

or XZ

or XY

Page 40

icon to select a predefined plane, or

to orient the reference plane with the compass, or
to select an existing plane or

Push the section guide icon
and select a curve: the sections will be perpendicular to this curve.
The degree of the section guide must be greater than 2.
It is not possible to input a join (in the Generative Shape Design sense) as a section guide.
❍

❍

❍

One manipulator is available on the reference plane.
It can be used to position the reference plane either by dragging the manipulator or
by using the contextual menu Edit.

Another manipulator is available on the last cutting planes proposed.
This manipulator is used to modify either the step between cutting planes,
or the number of planes, depending on the option selected in the Fixed field
or in the contextual menu attached to this manipulator.

Check the Keep this point option on any of those manipulators to create the corresponding
point.

3. After setting the orientation of the reference plane, you can move it along its normal or

Quick Surface Reconstruction
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along the section guide by dragging the center of the green manipulator in the required direction.

4. If required, you can select one or two limiting curves for any of the plane option.

❍

Pick the first limiting curve, its name is displayed in the First curve field.

❍

You can then select a second limiting curve. Its name is displayed in the Second curve field.

❍

To replace a limiting curve by another, uncheck the corresponding field: the name is erased.
Check the field again and select the new curve. Its name is displayed.

❍

The limiting curves should lay on the cloud of points or the mesh.

❍

The section guide curve can be selected as second limiting curve (not as the first).

❍

When using a limiting curve, the scans may be created on the "wrong" side of the curve.
In fact, this side is determined by the origin of the reference plane.
So move the reference plane to create the scans on the "right" side, either with the contextual
Edit menu of the plane, or using the compass.

5. Cutting planes can be defined :
❍

either from the step (distance) between two consecutives planes:
■
check Fixed, Step,
■

■

❍

then enter the value of the Step in the dialog box,
and enter the Number of planes in the dialog box or drag the green arrow until you reach the
required number of planes (the dialog box is updated automatically).

or from their number :
■
check Fixed, Number,
■

■

then enter the Number of planes in the dialog box,
and enter the Step between two planes or drag the green arrow until you reach the required step
(the dialog box is updated automatically).

You can also check the Infinite option, especially when dealing with large models.
In that case, the planes displayed on screen are used only to position the reference plane and
define the step between two planes, if it is not fixed.
The system computes all the cutting planes necessary to cut the whole model.
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6. The Influence Area parameter defines a computation area around the cutting planes:
when the points are not dense, a cutting plane (black line) may be unable to intersect the points.
The Influence area is the area shown in yellow that contains the points considered to intersect
the cutting plane. You can define its value according to your needs.
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7. Select the type of the result scans: either :
❍

❍

Distinct: the intersections are created as as many Planar Sections elements in the specification tree.

Grouped: the intersections are created as one cloud (one Planar Sections element) in
the specification tree.
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8. If you want to create curves, click Apply in the Planar Sections dialog box to display a scan in the
specification tree and check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature
comb
(no curvature analysis dialog box) is displayed.
❍

If the Curve creation option is checked, curves and only curves will be created.

❍

If the Curve creation option is not checked, scans and only scans will be created.

❍

❍

If you need a complete curvature analysis of the curves you create, you have to create the
scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into
account.

9. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.
❍

The scans are created in the specification tree, as Planar Sections.x.

❍

The scans created are ordered.

❍

Scans can then be exported to an ASCII file.
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Creating Free Edges
This task shows you how to create scans or curves by creating the free edges of a mesh.
You can:
●

create scans on all the existing free edges, or only selected free edges,

●

create scans on the whole free edge or only a portion of it, and select which portion,

●

create curves directly from these scans and check their curvature if required.

●

This action is available for meshes only!

●

This action is available on a complete mesh or on a portion of it .

●

If the Curve creation option is checked, curves and only curves will be created.

●

If the Curve creation option is not checked, scans and only scans will be created.

●

●

If you need a complete curvature analysis of the curves you create, you have to create the scans first,
and then create the curves with the Curve from Scans action.
When you modify a parameter, click Apply in the corresponding dialog box to take it into account.

Open the FreeEdges1.CATPart from the samples directory

1. Click the Create Free Edges icon

and select a mesh.

The dialog box is displayed and scans are proposed in cyan.
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2. Select the scans to process.
By default, all computed scans are proposed.
Place the cursor on a label Selected and right-click to launch the contextual menu.

You can:
❍

Select or deselect singles scans,

❍

Select or deselect all scans.

3. If necessary, pick two points on a selected scan to define a portion of scan to create.
Both extremities of the scan are displayed, together with its direction (as a red arrow).
You can invert this direction by clicking on the red arrow.
Proposed direction, Before Apply

After Apply
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Inverted direction, Before Apply
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After Apply

4. To remove one extremity point, right-click on its label to start the contextual menu:

5. Click Apply to apply any change you make.
6. If you want to create scans, check the required option:
❍

Distinct to create distinct scans,

❍

Grouped to create one single scan.

7. If you want to create curves, check the Curve creation option.
The operating mode is the same as for the Curve from Scans action except that only the curvature comb
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(no curvature analysis dialog box) is displayed.
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Creating Associative 3D Curves

This task explains how to create a 3D curve that is associative meaning you can add or delete points (whether control points or passing
points) both at creation time or when editing.
These curves can be created in space or lie on a geometrical element, or both. When the curve lie on a geometrical element and the later is
modified, the curve is updated automatically, provided you choose the Automatic update option in Tools -> Options -> Mechanical
Design -> Assembly Design -> General tab.
●
Selecting all 3D points
●

Editing

●

Keeping a point

●

Imposing a tangency constraint

●

Imposing a curvature constraint

●

Setting as arc limit

Open a new CATPart document.
1. Click the 3D Curve icon

.

The 3D curve dialog box is displayed.
2. Choose the curve creation type.

●

Through points: the resulting curve is a multi-arc curve passing through each selected point.

●

Control points: the points you click are the control points of the resulting curve

Quick Surface Reconstruction

●
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Near points: the resulting curve is a single-arc, with a set degree and smoothed through the selected points.

You can edit the order by right-clicking the displayed text (displayed using the U, V Orders icon

from the FreeStyle

Dashboard or the Order option from Tools -> Options menu, Shape -> FreeStyle -> General tab), and choosing a new order
value.
The Automatic order option enables you to automatically compute an order that will respect at best all the curve constraints.
The computed value is displayed near the Auto tag.

●

The Deviation option enables the user to set the maximum deviation between the curve and the construction points.

The result is a set degree through the selected points.

Quick Surface Reconstruction

●

●

Version 5 Release 16

Page 51

The Segmentation option enables the user to set the maximum number of arc limits. These arcs are construction points and are
inserted into the curve automatically.
The minimum value is set to 1.
The Max Order option enables you to set a bound for the computation of a mono-arc curve.
This option is only available with the Control Points and the Near Points types (provided the Automatic Order is selected).
❍
Control Points: when the Max order value is exceeded, the mono-arc curve becomes a multi-arc curve. As a consequence, the Max
order value is no longer taken into account, as arcs have always 6 as order.
❍

Near Points: you cannot create a 3D curve with an order higher than the Max order value. The Max order value is always taken into
account, whatever the result (mono-arc or multi-arcs curve).

The minimum value for the Max order option is set to 5 for Control Points and 2 for Near Points. If the value defined in Tools -> Options > Shape -> FreeStyle is set to 5, then, for Control Points, the Max order value is 6 (minimum and maximum bounds must be different).
The maximum value for the Max order is the same as defined in Tools -> Options -> Shape -> FreeStyle. If you decrease the value in
Tools -> Options and it is lower than the Max order value, then the latter value prevails.
●
Smoothing options are available to parameterize the curve:
●

●

●

Chord Length (default parameterization)
Smoothing parameter = 0

Uniform
Smoothing parameter = 0

Smoothing parameter: enable a better control points distribution of
the smoothed curve.
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Smoothing parameter = 130

Deviation, Segmentation, and Smoothing options are only available for the Near Points creation type.
3. Move the pointer over a point.
A manipulator is displayed allowing you to modify point location as you create the curve.
By default, this manipulator is on the last created point.
A contextual menu proposes several options to construct the 3D curve.
Right-click on the manipulator to display the contextual menu. From then on you can choose the Edit item to display the Tuner dialog box
and enter space coordinates for the selected point, or choose the Impose Tangency item to set a tangency constraint on the curve at this
point.
4. Click the Insert a point icon

within the dialog box.

The curve freezes.
5. Click the segment, between two existing points where you wish to add a new point and click the point location.

Once the point has been created, you are back to the edition capabilities on the curve.

6. Click the Remove a point icon

within the dialog box, and select one of the existing points.

The curve is recomputed immediately without the selected point.

7. Click the Free or constrain a point icon

within the dialog box, then select the point.

Quick Surface Reconstruction
●
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If the point is a point in space (free), move the pointer close to the point or a wire to which it should be linked. You can then move the
pointer over a geometric element and:
❍

move the point to the indicated point by clicking

❍

press and hold the Control key (Ctrl) to project this point onto this element according to the shortest distance from the point initial
location.

●

If the point was lying on another point or a wire (curve, line, spline, and so forth), it is freed from its constraint onto this element, and
can be moved to any new location in space.

You can snap a point onto a surface using the Free or constrain a point icon. The point will be lying onto the surface, but not
constrained. It can be moved using the manipulators.
8. Click OK to create the curve.
A 3DCurve.xxx appears in the specification tree.

●

●

Check the Disable geometry detection button, when you need to create a point close to a geometric element yet without
constraining it onto the existing geometry.
Check the Hide previsualisation curve to hide the previsualisation curve you are creating.

Selecting all 3D points
It is possible to select all the points either in the specification tree or directly in the geometry.
The Select all points contextual menu is available within the 3D curve action only, when the 3D Curve dialog box is open.
●

●

In the specification tree:
❍
select the geometrical set just by clicking it, or
❍

right-click the geometrical set and choose Select all points in the geometrical set from the contextual menu, or

❍

select a point in the geometrical set, right-click it and choose Select all points in the geometrical set from the contextual menu.

In the geometry: select a point, right-click it and choose Select all points in the geometrical set from the contextual menu.

Quick Surface Reconstruction
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Contextual Options
Double-click your curve, right-click on the manipulator to display the contextual menu.

According to the creation type, the following options are available:
Through Points

Control Points

Near points

Edit

X

X

X

Keep this point

X

X

X

Impose Tangency

X

X

Impose Curvature

X

X

Set as Arc Limit

X

Remove this point

X

X

X

Constrain this point

X

X

X

Editing
1. Right-click any of the manipulators, and choose the Edit contextual menu to display the Tuner dialog box. This option allows you to
redefine the tangency position (X, Y, and Z axes), and its vector's step.

Quick Surface Reconstruction
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The Relative check box enables you to redefine the tangency relative position (X, Y, and Z axes), and its vector's step.
The Reset Origin button allows you to reset the origin of the relative position.

Keeping a point
1. Right-click an existing point and choose the Keep this point menu item to create a point at this location.
A datum Point.xxx appears in the specification tree.
You can create a Point.xxx either on each control point or on the selected control points.

Imposing a Tangency Constraint
Automatic Constraint
●

When a curve is created in Through points or Near points mode, and its first point is constrained on any point of another curve, the
new curve automatically is tangent to the curve on which its first point is constrained. As soon as the curve's second point is created,
the imposed tangent is displayed on the new curve.
To deactivate the default option, uncheck the Impose Tangency contextual menu on the tangent vector.

Quick Surface Reconstruction
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Tangency Constraint on Points
When creating a 3D curve, you may want to impose tangency constraints on specific points of the curve. Then if you move the point at
which a tangency constraint has been set, the curve will be recomputed to retain this tangency constraint at the point's new location.
Depending on the creation mode, you can impose this constraints on a limited number of points:
●
In Through points mode: tangency can be imposed on any point
●

●

In Near points mode: tangency can be imposed independently on each end points only
In Control points mode: no tangency constraint can be imposed (end points can be constrained on other elements as described in step
7 above. See also Constraining a Control Points Curve.

Here is how to do it:
Open the FreeStyle_03.CATPart document.
1. Move the pointer over an existing point, double-click it (the 3D curve dialog box appears), then right-click and choose the Impose
Tangency menu item.
Two sets of manipulators are displayed:
●
two arrows representing the normed directions (vectors) of the tangency
●

circles representing manipulators for this vector

You can also modify the tangency constraint by:
●
pulling the arrow
●

gliding the circles

●

double-clicking the arrow to invert the tangency direction

You can set the tangency length by clicking on the arrow then dragging the mouse.

Quick Surface Reconstruction
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Right-clicking on any of the manipulators, you can also choose to define the constraint according to an external element:
●
Use current plane orientation (P1)/Use compass normal (P2): the tangency constraint is defined in relation to the normal to the
current plane, possibly defined by the normal to the compass main plane
When several points are constrained on the compass, all are modified if the compass settings are changed.
When this option is checked, the direction cannot be modified directly using the vector manipulator, but only using the compass.

●

Constrain on element: available only when a point is already constrained on a curve. The curve being created/modified becomes
constraint in tangency or curvature to the constraining curve at this point.
❍
Tangency constraint: in this case you can only modify the vector's norm using the Edit contextual menu, and no longer the vector's
direction, the latter being defined by the constraining curve.
❍

Curvature constraint: in this case you neither modify the vector's norm using the Edit contextual menu, nor the vector's direction,
the latter being defined by the constraining curve.

By default, when the tangency vector is constrained onto another curve, its initial direction is retained.
●

Snap on elements: the vector's direction is defined by an external element. Grabbing a manipulator, you drag the pointer over a
curve, and the curve becomes tangent to the curve detected by the pointer.

Quick Surface Reconstruction
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If the pointer is over a point the direction is computed as the line going from the constrained point and the detected point.
If the pointer is over a plane, the tangency is defined by the normal to this plane.

●

●

When snapping on an element, use the Control (Ctrl) key to obtain an exact snap, taking into account both the detected element and
the vector's norm.
Use the Shift key as a shortcut to activate/de-activate the Snap on elements option when passing the pointer over geometric
elements.

Once you are satisfied with the tangency constraint you imposed, simply release the manipulator and move the pointer around to recover
the curve preview indicating that you are ready to create a new point.

Control Points Curve Constraint

Even though you cannot impose a tangency constraint on a curve created in Control points mode, you can constrain its end points on
another curve, as described in step 7 above.
When setting a constraint on an end point, a text is displayed indicating the type of continuity between the two curves.

Right-click the text to display the contextual menu from which you can choose another continuity type: tangency, or curvature.

Quick Surface Reconstruction
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Note that:
●
in Point continuity, only the selected point is constrained
●

in Tangent continuity, the selected point and the next one are constrained

●

in Curvature continuity, the selected point and the next two points are constrained

This means that these second and third points will be modified if you move the constrained point along the constraining element, using the
manipulators. However, you cannot constrain these points, because they are considered as already constrained. If you try to do so, a
warning message is displayed. Nevertheless, you can add/remove points directly after the constrained end point, and the system resets the
points as second and third points to be affected by the constraint, where applicable.
A Continuity warning is displayed when trying to move the manipulators in a direction that is not compatible with the set constraint.

Imposing a Curvature Constraint
Right-click an existing point and choose the Impose Curvature menu item. An arrow representing the curvature direction (vector) is
displayed. Modifying the vector direction modifies the curvature direction.
The direction of the curvature is constrained in the plane defined as normal to the tangent vector.

Quick Surface Reconstruction
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●

To impose a curvature continuity, you must ensure that a tangency continuity already exists.

●

This option is only available for the Through points and Near Points creation type.
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Setting as Arc Limit
Right-click an existing point and choose the Set As Arc Limit menu item to start/stop an arc limit on this point. The curve will pass
through this point.

This option is only available for the Near points creation type.
●

Use the F5 key to move the manipulators into a different plane of the compass. See Managing the Compass.

●

Use the standard shortcuts (Ctrl and Shift keys) to select, multi-select, and unselect any combination of control points on these curves.

●

●

You cannot add a point past the end points. To do this, you need to add a point before the end point, move the new point where the
end point lies, then move the end point to a new location.
The creation plane for each free point is defined according to the current plane/compass orientation on the previous point. Therefore
you can change creation planes within the same curve, by setting a new current plane/compass orientation on several points.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum creation, temporary analysis, auto
detection (except for Snap on Control Point option), attenuation, and furtive display.
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Creating Associative 3D Curves on a Scan
This task explains how to create a 3D curve on a scan:
●

either before entering the 3D curve action. In that case, you can select only one scan,

●

or after entering the 3D curve action. In that case, you can select one or more scans.

●

●

either graphically. In that case, use the contextual menu Select all points to create a 3D curve on all
the points of the scan,
or from the specification tree. In that case all points of the scan are taken into account even if you do
not activate the Select all points menu.

Open the FreeStyle_04.CATPart document.
1. Click the 3D Curve icon

.

The 3D curve dialog box is displayed.
2. Choose the curve creation type.

●

Through points: the resulting curve is a multi-arc curve passing through each selected point.

Quick Surface Reconstruction

●

●
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Control points: the points you click are the control points of the resulting curve.

Near points: the resulting curve is a single-arc, with a set degree and smoothed through the selected
points.

3. Click OK to create the curve.
A 3DCurve.xxx appears in the specification tree.

For further information on the options of the dialog box, please refer to the Creating Associative 3D
Curves chapter.

Selecting all points in a scan of cloud
It is possible to select a scan of cloud either in the specification tree or directly in the cloud from the
contextual menu:
The Select all points contextual menu is available within the 3D curve action only, i.e. it appears when the
3D Curve dialog box is open.
●

Right-click the Scan on Cloud.xxx in the specification tree and select Select all points in the scan.

Quick Surface Reconstruction

●
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Right-click the cloud and select Select all points in the scan.

Here is an example with Through Points

Contextual Options
Double-click your curve, right-click on the manipulator to display the contextual menu.
Please refer to the Creating Associative 3D Curves to get the corresponding information.
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Only scans of the type "scan on cloud" can be selected since other types of scans might contain too many
points.
●

●

●

●

Use the F5 key to move the manipulators into a different plane of the compass. See Managing the
Compass.
Use the standard shortcuts (Ctrl and Shift keys) to select, multi-select, and unselect any combination
of control points on these curves.
You cannot add a point past the end points. To do this, you need to add a point before the end point,
move the new point where the end point lies, then move the end point to a new location.
The creation plane for each free point is defined according to the current plane/compass orientation on
the previous point. Therefore you can change creation planes within the same curve, by setting a new
current plane/compass orientation on several points.

Available capabilities from the Dashboard, and/or specified through the FreeStyle Settings, are: datum
creation, temporary analysis, auto detection (except for Snap on Control Point option), attenuation, and
furtive display.

Quick Surface Reconstruction
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Curves from Scans

This task shows how to create curves from a scan or a set of scans.
The Curve from Scans action tries to create curves
●

with the defined tolerance,

●

with the least possible number of segments of the least possible order.

The Curve from Scans action proposes a dynamic definition of split points.
Open the CurveFromScan.CATPart model from the samples directory.
For a better understanding, some images below show only one scan.
1. Select the Curve from scans icon

and a set of scans.

The Curve from Scans dialog box is displayed.

The scan is displayed in the "Polyline+Point" mode with the current graphic symbol.
By default, the end points are fixed.

●

●

Scan modifications are not dynamic.
You have to click on Apply to take new parameter values into account.
The scans can be selected in the specification tree.
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2. Make sure the Smoothing Creation mode is checked.
3. Click Apply. A temporary curve is displayed in white, indicating the tolerance is met.

4. Change the Split Angle value to 60. A Split point is automatically inserted at the angle.

5. Push the

6. Release the

icon to display the curvature analysis:

icon and now push the

icon to display the maximum deviation
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icon to display the order and the number of segments:

7. Click OK to exit the action and create the curve(s).
Curve.x elements are created in the specification tree. The segmentation display is erased.

Parameters
Creation mode
Two creation modes are proposed:
●

Smoothing or

●

Interpolation.

In the Smoothing creation mode, the curve is created by smoothing all the points between two split points.

Three parameters are available in this mode:
●
Tolerance,
●

Max. Order,

●

Max. Segments
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Tolerance is the maximum distance between the curve and the points.
●

Decrease the value of Tolerance to reduce that distance.

●

You can check the distance between the curve and the points with the

●

If the tolerance is met, the computed curve is displayed in white.

icon.

If the maximum deviation display is activated, the maximum error is displayed in green.

●

Otherwise, the computed curve is displayed in red.
If the maximum deviation display is activated, the maximum error is displayed in red.

Max. Order is the maximum order of the curves created, i.e. the number of control points of those curves.
Max. Segments which is the maximum number of spans between two cutting points.
The Curve from Scans action tries to create curves with the defined tolerance,
with the least possible number of segments of the least possible order. I.e.:
●
the action tries to create a curve with one segment of order 2.
●

●

If the tolerance is not reached, the order of the segment is increased up the the Max. Order value.
If the tolerance is not yet reached, the number of segments is increased, the segments having the least possible order.
This order is increased to meet the tolerance, then the number of segments,
and so on until both the maximum order and the maximum number of segments are reached.

You can check the segmentation and the order of the curves with the

icon.
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In the Interpolation mode, the curve is created by interpolating the points of its support scan.

No parameters are proposed for this mode

Visualization and Analysis icons
Three visualization icons are available:

analyzes the curvature of the resulting curves:
●

This is a temporary analysis, no analysis element is created in the specification tree.

●

Click on More to display more analysis options.

●

Click on Less to display the quick analysis options

●

More information is available in the Curvature Analysis section.

displays the maximum deviation (not available for the Interpolation mode):
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The label is green if the tolerance is met, otherwise it is red.

displays the order and the number of segments (not available for the Interpolation mode):
When the curve computed is segmented, the segmentation is displayed with blue x symbols.
This color and symbol are not editable.

Push the icons to activate the display, release the icon to erase the display.
Those three displays can be combined together.

Split angle
A split angle is proposed by default at 90 degrees. This value is editable.
Whenever the computed curve forms an angle greater than this value, it is split automatically into two curves.
The split point is displayed and two curves are created.
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If you modify the split angle value after having computed curves and before having validated them,
the display of the split points is updated. Click Apply to update the display of the computed curves.
You can also:
●

add split points by picking points of the scan.

●

or move a split point to another point of the scan:

●

●

pick the split point you want to move: press the control key and the left-click on the label of the split point,
with the control key and the left button of the mouse still pressed, drag the split point
to the required scan point and drop it there.

The default constraint on a split point is "Point", i.e. passage.
Click on the green label to change it to "Tangent". A second click will return it to "Point".
You can also use the Impose tangency of the contextual menu of the constraint.

This contextual menu can also be used to remove one split point or all split points.
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End points
End points propose more items in their contextual menu.

You can remove the extremity point of a computed curve, and replace it with a new or existing split point.
Remove the end point:

The end point is removed:
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Pick a point on the scan:

Click Apply to visualize the new curve:

You can free or constrain the end points by checking the appropriate option in the contextual menu.

Label

Meaning
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O

O

O

Not
available

Free

The extremity is free

X

O

O

Not
available

Fixed

The extremity is fixed, it is the
scan extremity (this is the option
by default)

X

O

X

Not
available

Fixed on
element

If the element is a point, the
extremity of the curve is this
point, not the scan extremity
See constrain on element

If the element is a curve, the
curve extremity is the nearest
extremity of the constraining
curve
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See constrain on element

If the element is a plane, the
curve extremity is the point of
the plane nearest to the scan
extremity
See constrain on element

X

X

X

X

O

X

Available

Available

Fixed and
tangent

Fixed and
tangent on
element

The tangency direction is given
by a vector going through the
first (or the last) two points of
the scan.

The extremity is fixed and
tangent to the constraining
element.
See constrain on element
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O

O

X

Not
available

Free on
element

The extremity is free and
depends on the element.
See constrain on element

O

O

X

X

O

X

Available

Available

Free and
tangent

Free and
tangent on
element

The extremity is free. The
tangency direction is given by a
vector going through the first (or
the last) two points of the scan.

The extremity is free and
depends on the element. The
tangency direction is given by the
element (plane or curve).
See constrain on element

Constrain on element:
The extremity of the curve computed is the scan extremity, unless the Constrain on element option is checked.
●

●

●

If the constraining element is a point, the curve extremity is that point,
if the constraining element is a curve,
the computed curve extremity is the nearest extremity of the constraining curve,
if the constraining element is a plane,
the curve extremity is the orthogonal projection of the scan extremity on to the plane.

If an extremity is constrained on an element, and if a tangency is imposed, the tangency direction is given by:
●

the tangent vector of the curve on the constraining curve extremity,

●

or the normal to the constraining plane.
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Whenever the Impose tangency is checked, you can modify the tangent vector with the following box
(Edit tangent in the contextual menu):

●

It is useful to impose a tangency constraint at the extremities if you intend to reconstruct a part in two steps:
❍
reconstruction of the first half of the part,
❍

recovery of the whole part by performing a symmetry.

The tangency constraint will ensure that the two halves fit perfectly.
●

Only the tangency direction is taken into account, the norm is not.

This option is available in the Curve from Scans action only.
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Sketch from Scan
This task will show you how to retrieve basic primitives (line, circle, ellipse) from planar scans.
Those primitives are created as sketches.
Open the SketchFromScans01.CATPart from the samples directory.

1. Click the Sketch from Scan icon

.

2. The Sketch from Scan dialog box is displayed.

3. Select Elongated.9. The dialog box displays the name of the element selected.
4. Click again in the Scan text box and then select Quadrangle.11.

or

●

click the

icon to display the multi-selection dialog box Scans

●

select as many elements as you want.

●

Click Close to revert to the main dialog box.
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●

The input scans must be planar.

●

You can also select Geomerical sets, multi-outputs and Selection sets.

●

Use the contextual menu to clear all the selection or to visualize the list of the elements selected.

●

or click the

icon to visualize, Remove or Replace elements in the selection.

5. The dialog box displays now the number of elements selected.

The elements selected are highlighted and split points are proposed with

their associated constraints.
Those split points are not necessarily the endpoints of the primitives created.
You can move them with the Ctrl key.

Quick Surface Reconstruction
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To manage split points, make sure the Display option Constraint is selected.

You can manage split points:
●

manually:
❍
pick a point of the scan to add a split point,
❍

❍

●

use the contextual menu to remove one or all points,
Select Impose tangency in the contextual menu to set a tangency constraint,
or deselect Impose tangency to set a passage (Point) constraint.

automatically:
❍
Select the Threshold option and define its value.

The Threshold acts like a sag value.
The scan is cut into segments, according to the threshold value.
The endpoints of those segments are potential split points.
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The Threshold option is selected:

The Threshold option is not selected.
Only the endpoints of the scans are proposed as fixed split points.

6. If necessary, change the Tolerance, that is the deviation allowed between
the output elements and the points of the scan.

7. Click Apply. An automatic computation of the sketch is carried out.
You can see that the sketch on Quadrangle.11 is not complete.
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8. Create additional split points as follows:

9. Click Apply. The sketch is now fully computed.
10. Push More to display the global statistics in the dialog box:
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You can find:
❍
the number of recognized elements,
❍

the maximum deviation,

❍

the mean deviations,

❍

the percentate of points under Tolerance.

11. Push the

icon to display local deviations results on the graphic area:

The maximum and mean deviation, as well as the percentage of points under the required
Tolerance are displayed in the graphic area, for each segment of points:
❍
These statistics are displayed in green if the maximum deviation is lower than Tolerance,
❍

❍

They are displayed in red otherwise.
The percentage of points under the required tolerance are displayed only if the maximum
deviation is higher than the tolerance
(otherwise, the percentage is equal to 100% and its display is not relevant).

12. Click OK. A sketch is created for each input scan.
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●

its reference plane is that of the scan,

●

the required constraints are created in the sketch (if possible),

●

a fixed constraint is created and applied to each primitive.

Primitive
If you set the Display option to Primitive, the constraints on split points are replaced
by recognition options on each scan segment. By default, an automatic recognition is proposed:
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For each segment, you can impose another computation option, using the contextual menu:

●

Automatic: the best primitive is computed,

●

Nothing: nothing is computed,

●

Line, Circle, Ellipse: the best line, circle or ellipse is computed.
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Creating Intersections
This task shows you how to create wireframe geometry by intersecting elements.
You can intersect:
●

wireframe elements

●

solid elements

●

surfaces

Open the Intersection1.CATPart document.

1. Click the Intersection icon

.

The Intersection Definition dialog box appears as well as the Multi-Selection dialog box allowing to
perform multi-selection.

2. Select the two elements to be intersected.
The intersection is displayed.
Multi-selection is available on the first and second selection, meaning that you can select
several elements to be intersected as well as several intersecting elements. For instance you
can select a whole geometrical set.
3. Choose the type of intersection to be displayed.

Quick Surface Reconstruction
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❍

a Curve (when intersecting two curves):

❍

Points (when intersecting two curves):

❍

a Contour: when intersecting a solid element with a surface :

❍
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a Face: when intersecting a solid element with a surface (we increased the transparency
degree on the pad and surface):
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4. Click OK to create the intersection element.
This element (identified as Intersect.xxx) is added to the specification tree.

The above example shows the line resulting The above example shows the curve resulting
from the intersection of a plane and a surface from the intersection of two surfaces

Additional Parameters
Several options can be defined to improve the preciseness of the intersection.
Open the Intersection2.CATPart document.

Quick Surface Reconstruction
●

●
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The Extend linear supports for intersection option enables you to extend the first, second or both
elements.
Both options are unchecked by default.
Here is an example with the option checked for both elements.

The Extrapolate intersection on first element check box enables you to perform an extrapolation
on the first selected element, in the case of a surface-surface intersection. In all the other cases, the
option will be grayed.
Intersection with the Extrapolation option
unchecked:

Intersection with the Extrapolation option checked:

Quick Surface Reconstruction
●
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The Intersect non coplanar line segments check box enables you to perform an intersection on
two non-intersecting lines.
When checking this option, both Extend linear supports for intersection options are checked too.
Intersection between the light green line and the
blue line: the intersection point is calculated after
the blue line is extrapolated

Intersection between the pink line and the blue
line: the intersection is calculated as the midpoint of minimum distance between the two lines

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
●

●

If you select a body or a hybrid body containing both solid and wireframe elements as
input, only the solid elements are taken into account to compute the intersection.
Avoid using input elements which are tangent to each other since this may result in
geometric instabilities in the tangency zone.
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Creating Projections
This task shows you how to create geometry by projecting one or more elements onto a support. The
projection may be normal or along a direction.
You can project:
●

a point onto a surface or wireframe support

●

wireframe geometry onto a surface support

●

any combination of points and wireframe onto a surface support.

Generally speaking, the projection operation has a derivative effect, meaning that there may be a
continuity loss when projecting an element onto another. If the initial element presents a curvature
continuity, the resulting projected element presents at least a tangency continuity. If the initial element
presents a tangency continuity, the resulting projected element presents at least a point continuity.
Open the Projection1.CATPart document.

1. Click the Projection icon

.

The Projection Definition dialog box appears as well as the Multi-Selection dialog box allowing to
perform multi-selection.

2. Select the element to be Projected.
You can select several elements to be projected. In this case, the Projected field indicates: x
elements.

Quick Surface Reconstruction
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3. Select the Support element.
4. Use the combo to specify the direction type for the projection:
❍

❍

Normal: the projection is done normal to the support element.

Along a direction: you need to select a line to take its orientation as the translation direction
or a plane to take its normal as the translation direction.
You can also specify the direction by means of X, Y, Z vector components by using the
contextual menu on the Direction field.

Quick Surface Reconstruction
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5. Whenever several projections are possible, you can check the Nearest Solution option to keep
the nearest projection.
The nearest solutions are sorted once the computation of all the possible solutions is performed.
6. Click OK to create the projection element.
The projection (identified as Project.xxx) is added to the specification tree.

Smoothing Parameters
You can smooth the element to be projected by checking either:

●

None: deactivates the smoothing result
With support surface: the smoothing is performed according to the support. As a consequence, the
resulting smoothed curve inherits support discontinuities.

●

Tangency: enhances the current continuity to tangent continuity

●

Curvature: enhances the current continuity to curvature continuity

●

You can specify the maximum deviation for G1 or G2 smoothing by entering a value or using the
spinners.
If the element cannot be smoothed correctly, a warning message is issued.
Moreover, a topology simplification is automatically performed for G2 vertices: cells with a curvature
continuity are merged.

Quick Surface Reconstruction
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Only small discontinuities are smoothed in order to keep the curve's sharp vertices.
Without support surface:
●

3D Smoothing: the smoothing is performed without specifying any support surface. As a
consequence, the resulting smoothed curve has a better continuity quality and is not exactly laid down
on the surface.
As a consequence, you may need to activate the Tolerant laydown option. Refer to the Customizing
General Settings chapter.
This option is available if you previously select the Tangency or Curvature smoothing type.
With 3D smoothing option checked:

With 3D smoothing option unchecked:

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.
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Selecting Using Multi-Output
This capability enables to keep the specification of a multi-selection input in a single operation.
It is available with the following functionalities:
●
Intersections
●

Projections

●

All transformations: translation, rotation, symmetry, scaling, affinity and axis to axis

●

split

●

Developed wires

Let's take an example using the Projection and Translation functionalities.
Open the Multi-Output1.CATPart document.

1. Click the Projection icon

.

The Projection Definition dialog box appears, as long as the Tools Palette toolbar.

2. Select Translate.1 as first element to be Projected.
❍

❍

If one element is selected and you select another element, it automatically replaces the
element you selected previously, providing the multi-selection panel is closed.
If several elements are selected and you select another element, it is appended to the
elements list.

The selected element (here Translate.1) is highlighted in the specification tree and in the 3D
geometry.
When you select or edit an element aggregated under the multi-output node, either in the
specification tree or in the 3D geometry, its input is highlighted in the 3D geometry, in the
specification tree, and in the multi-selection panel.
In our example, Project.1 has Translate.1 as input, therefore when you select Project.1 in the
specification tree, Translate.1 is highlighted in the 3D geometry, in the specification tree and in
the multi-selection panel.

Quick Surface Reconstruction
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icon to add elements.

The multi-selection dialog box (here Projected) opens.
Multi-selection is now active: all selected elements are displayed in the dialog box.
4. Select Translate.2.

Use the Remove and Replace buttons to modify the elements list.
❍

You can select an element in the list: it is highlighted in the specification tree and in the
3D geometry.

❍

You can select one or more geometrical sets and multi-outputs as inputs of the multiselection.
In that case, all their direct children are selected.

5. Click Close to return to the Projection Definition dialog box.
6. Select Extrude.1 as the Support element.
7. Select Normal as Projection type.
8. Click OK to create the projection elements.
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The projection is identified as Multi Output.1 (Project) in the specification tree.
The created elements are aggregated under Multi Output.1.

You can create several multi-outputs in the specification tree, each one grouping one type of
elements.
9. Click the Translate icon

.

The Translate Definition dialog box appears.

10. Select Translate.1 and Translate.2 as the Elements to be translated.

Quick Surface Reconstruction
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11. Select Direction, distance as the Vector Definition.
12. Select Extract.2 as the Direction.
13. Select -50mm as the Distance.
14. Click OK to create the translated element.

The translation is identified as Multi Output.2 (Translate) in the specification tree and appears
below Multi Output.1.
The created elements are aggregated under Multi Output.2.

Quick Surface Reconstruction
❍

❍

❍

❍

❍

❍

❍

❍

❍
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When editing a multi-output, you can only select the elements belonging to the multioutput in the specification tree (not in the 3D geometry).
When one or several elements are in error under a multi-output (during creation or
edition), an error message is issued after clicking Preview or OK and displays all
features in error.
You can manually delete or deactivate all the elements of a multi-output. As a
consequence, the multi-output feature disappears from the 3D geometry and erroneous
elements can no longer be generated. Similarly, you can activate all the elements of a
deactivated multi-output.
When editing the multi-output, deactivated features are not displayed.
To have further information, refer to the Deactivating Elements chapter.
Multi-selection is available when editing a single feature: double-click it in the
specification tree and click the bag icon to replace it or add new elements.
Multi-outputs and elements aggregated under a multi-output can be edited separately,
simply by double-clicking it in the specification tree. Elements can be modified (added,
replaced, or removed): the corresponding multi-output automatically updates.
Unshared features are aggregated under the parent command that created them and put
in no show in the specification tree.
Shared features are not aggregated under the parent command.
The datum capability is available. If an element is in error, it cannot be created as a
datum element; only elements that could be generated from the multi-selection are
created.
You can move a multi-output to another body. Note that you cannot move some
elements of the multi-output alone but only the whole multi-output.
To have further information, refer to the Managing Geometrical Sets chapter.
You can copy/paste as result a multi-output:
■
if the paste destination is a geometrical set or a solid body, a geometrical set
containing the multi-output's elements is created
■

if the paste destination is an ordered geometrical set or a solid body, an ordered
geometrical set containing the multi-output's elements is created

Refer to Pasting Using the Paste Special... Command in the CATIA Infrastructure User's
Guide for further information.
❍

If an element of a multi-output is in error while being updated, the multi-output itself
appears in the Update Diagnosis dialog box. Note that you can delete the multi-output,
not the erroneous element.
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Domain Creation
You can use the following tools to create domains:
Clean Contour
Adjust nodes
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CleanContour Creation
This task shows how to create a CleanContour.

●

●

●

This action complies now with a feature-based approach.
Therefore standard selection tools, including the user selection filter and the geometrical element filter,
can be used.
For further information, please refer to Selecting Using a Filter in the Infrastructure User's Guide.

A CleanContour is created from selected edges or curves, ordered or not,
that are chained into an open or closed contour:
●
Each input element is cleaned (burred or trimmed),
●

Continuity or fixity constraints are applied to those elements and taken into account during the cleaning,

●

After the creation of the result CleanContour curve, all input curves are sent to the NoShow.

●

It is possible to create a datum curve (instead of the feature) by activating Create Datum in the "Tools" bar.

●

●

Multi-domain elements are not accepted as input.
If you select such an element, e.g. an Adjusted Node.x feature, the following message is displayed
requesting you to select each sub-element separately.

It may be impossible to create a Closed Contour from the input curves:

In that case you have to clear the Closed Contour option.
●

It is no longer possible to create a multi-domain CleanContour.

The CleanContour action sets the chaining order of the curves to create a contour.
In some cases (especially with long curves) the chaining may lead to an unexpected result.
You may need to slice curves or edges in order to solve this chaining incompatibility.
For further information, see "Curves Slice ".
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original curves: CleanContour impossible

●

sliced curves
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CleanContour

Open the CleanContour1.CATPart from the samples directory

1. Click the CleanContour icon

. The CleanContour dialog box is displayed.

By default, the options Closed Contour, Automatic Tangent Constraint and Global deformation are checked.
Their status is modal.

Quick Surface Reconstruction
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2. Select the curves. The default constraints are displayed on each curve.
The curves are listed in the dialog box :

3. Change the constraint on a curve by simply clicking on the text or using the contextual menu.

The default constraint conditions for a featurized Clean Contour are:
●

●

if the input curve is the boundary of a surface or a curve supported directly or indirectly by a surface,
the default constraint is Fixed. It is editable.
For all other input curves, the default constraint is Free.
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If you want to replace one curve by another, pick the curve to replace and then the new curve.
There are several ways to modify the list of the elements selected:
First method:
a. Pick the name of the curve you want to delete in the list of the elements selected in the dialog box.
b. Call the contextual menu and click Remove.
The curve is removed from the list, and is no longer highlighted in the graphic zone.
This is useful when the curve to remove is too short to be selected graphically.

Second method:
a. Use the Undo/Redo function to deselect the curves you have previously selected.
Third method:
a. Pick the curve in the graphic zone.
It is removed from the list of the dialog box and is no longer highlighted.

If necessary, you can pick further curves to complete the selection.
The dialog box is updated accordingly:
3D Curve.8 has been replaced by 3D Curve.9:

Page 105

Quick Surface Reconstruction

Version 5 Release 16

The Undo/Redo method is no longer available once you have used one of the two other methods.

The CleanContour computation is based on the minimum distance of the curves.
The deformation allowed may not exceed the hole size.
Priority is given to the parametric restriction over the deformation.
●

●

if the points of the minimum distance between two curves are no endpoints of the curves,
the curves are restricted.

if the points of the minimum distance between two curves are endpoints of the curves,
a point is computed on the segment corresponding to that minimum distance,
weighted by the length of each curve :
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if only one endpoint of a curve is a point of minimum distance,
this endpoint is moved to the point of minimum distance on the other curve.

3. If checked, the Closed Contour option closes the contour, according to the rules above:
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4. If checked, the Automatic Tangent Constraint forces a tangency constraint on the curve
endpoints when the angle of the tangents at those ends is lower than the Max Angle G1 value.

5. The curves are deformed to achieve a CleanContour.

❍

By default, the Global deformation option is checked.
Its status is modal.
Input curves
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If the Global deformation option is checked, the deformation is more evenly distributed
on the whole curves.
The degree and the structure of the curves are kept.

If Global deformation is not checked, the deformation is local and not distributed
along the whole curves.
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6. Click Apply: a proposed CleanContour is displayed in green.

7. Click OK to validate.
A Clean Contour.X feature is created in the specification tree, the input curves are hidden.

In Datum mode, a Curve.x element is created.
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Curves Network
This task will show you how to create a network of constrained curves to be used
in the surfaces network command.
On a first step, you have created characteristic curves on the cloud.
These curves are often approximate and require some preparation:
●
Slicing that cuts curves or edges in several pieces, according to a pseudo-intersection:
there is a pseudo-intersection between two curves if they intersect each other in the view direction
(but not really), and if the mini 3D distance between them at this cutting point is lower than
the parameter Max. Distance.

●

●

Pseudo-intersection of two curves in the view direction

●

Pseudo-intersection of two curves in another view.

Deburring to remove undesirable small curve pieces, based on a Min length criterion.
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Then, you can create a network from these cleaned curves according to the following:
●
A network is a set of closed and connected contours, named wires,
●

a contour is a set of connected edges, it is necessarily closed but not limited to 3 or 4 sides,

●

an edge belongs to one contour (free border edge) or 2 contours (common edge),

●

if there are no free border edges, the network is closed,

●

a node is the topological encounter point of two or more edges.
These edges may belong to different contours.

Once the action has detected the topology (node, contours, free border edges),

the curves are adapted to the network internal constraints such as:
●

●

Connection constraints on nodes
(all edges ending on a common node must be connected on this point).

Tangency constraints between two edges on a node.

Open the SurfNetwork.CATPart from the samples directory.
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1. Click the Curves Network icon. The dialog box is displayed.

2. It consists of 4 tab pages:

●

Preparation,

●

Constraints,

●

Freeze,

●

Display.

Stay in the Preparation tab and select the curves to clean.
They are displayed in the dialog box.
You can:
●
select a CleanContour, a Curves network or a Join of curves,
their curves will be added to the list.
●

remove a curve from the list:

❍

pick the curve again in the graphic area, or

❍

pick the curve again in the specification tree, or

❍

pick the curve you want to remove in the list of the dialog box and
use the contextual menu Remove.
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select additional curves, they will be added to the list.

3. Select the mesh as the Support. Click Apply.

Before computing the network, the action searches overlapping curves.
If some are detected, a message is displayed:

The overlapping curves are displayed in magenta

The wires are then computed and displayed. The push button Deleting wire is now available.
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A wire is computed on each "loop" of curves, plus a large one on the "loop" formed by
the external curves because the network is considered as closed by default.
If your network does not form a closed volume, you usually do not need this large wire
(it would create an additional surface as you create surfaces from the curves network).
In the same way, you can remove wires corresponding to holes in your part.

4. Push the Deleting wire button to activate the wire selection. The large wire is highlighted
and a Delete wire button becomes available.
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5. Push the Delete wire button to remove this wire.

●

In the cases where you want to create a surface on a network of curves with a hole in it,
i.e. without filling one or several wires, use the Deleting wire button to activate the wire selection,
select the wire by picking two of its edges, and push the Delete wire.

●

If you do not remove the large wire, an information message is displayed as you push OK.

●

The parameters Max distance and Filtering are those used in the Curves Slice command.
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6. Go to the Constraints tab to define constraints. The existing constraints are highlighted,
as a green dot for continuity constraints on nodes, as a blue line for tangency constraints,
as a red curve for fixed curves.

❍

The constraints are applied globally on the whole network.

❍

Continuity constraints on nodes are implicit and cannot be removed.

7. The Node tolerance defines the maximum distance between edges extremities to consider
these edges connected on a node.
You can modify this value, but it cannot be smaller than the Max distance parameter.
The Node tolerance is visualized as a green sphere whose radius is equal to the Node tolerance.
The size of this sphere is updated when you modify the Node tolerance value.
You can move the sphere using the cursor.
8. Tangency constraints are activated by the Automatic tangency check box.
You can edit the value of the tangency angle. Push Apply after each modification.
9. Check Projection on support to compute the network from the projections of the curves on the mesh.
The curves projected are smoothed, with the Smoothing tolerance. This parameter can be edited.
It is applied to all curves.
10. You can choose between a global or a local deformation constraint
(available for all deformable edges).
This constraint is applied during the geometric adaptation step.
If the Global deformation check box is set, edges deformations are done along the entire length
of the edges.
Example of global deformation:
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Example of local deformation:

Push the Default constraints to revert to the default constraints.

11. Go to the Freeze tab page to select curves that must remain fixed.

12. Pick a curve to fix it. It is displayed in red in the graphic area and displayed in the dialog box.
Pick it again or use the contextual menu Remove to free it.

Page 119

Quick Surface Reconstruction

Version 5 Release 16

❍

You can freeze only curves that have been selected in the preparation tab.

❍

An edge of a face is automatically and definitely fixed.

❍

Free border edges are fixed by default but you can free them.

❍

The action provides a constraint solver to search conflicts between constraints.

❍

A message is displayed at the end of the search.

❍

When all constraints have been checked, conflicts are highlighted in magenta.

❍

Modify the constraints to solve the existing conflicts before creating the wires.
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13. If necessary, go to the Display tab page to visualize defects or gaps on the curves.

14. Check Distances at nodes to display the minimum 3D distance between two curves at
their pseudo-intersection.

They are displayed in yellow with the exception of the greatest minimum distance found
that is displayed in black.
Click on this black label to update the Max distance in the Preparation tab with a value
that will take all curves pseudo-intersection into account.
15. Check Spikes to display deviation or curvatures spikes:
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Push the
icon to display the deviation spikes between the network curves
and the input curves,

Push the
icon to display the deviation spikes between the network curves
nd the support mesh,
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Push the
icon to display the curvature spikes on the network curves.
Spikes within the tolerance are displayed in green,
spikes exceeding the tolerance are displayed in red.

16. Use the Spikes scale slider to define the size of the spikes

17. and the Spikes density slider to define their density:

18. Check Max deviation and:
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Push the
icon to display the maximum deviation between the network curves and
the input curves,

Push the
icon to display the maximum deviation spikes between the network curves
and the support mesh.
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●

You can combine Spikes and Max deviation.

●

When Max deviation alone is checked, the greatest corresponding spike is displayed.

●

The Max deviation is not relevant for the

●

curvature icon.

Although this is possible, we recommend that you do not combine Max deviation
with Distances at nodes as it would be difficult to read the combined information.
You should check these options in turn.
19. Push OK to validate the network and exit the dialog box.
A CurvesNetwork element is created in the specification tree.
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Surface Creation
This chapter deals with the creation of surfaces in Quick Surface Reconstruction.
Basic Surface Recognition
PowerFit
Creating Multi-sections Surfaces
Surfaces Network
Automatic Surface
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Basic Surface Recognition
This task shows you how to recognize the basic shapes of a part
and how to create the corresponding editable surfaces.
Open the Canonic1.CATPart from the samples directory.

1. Click on the Basic Surface Recognition icon

.

The Basic Surface Recognition dialog box is displayed.

2. First identify visually the portions of the part made of the basic surfaces,
i.e. planes, cylinders, spheres, cones.
3. Then activate each of those portions in turn and let the application recognize and
create the surface. The name of the cloud selected is displayed at the top of the dialog box.
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The Activate action is available within the Basic Surface Recognition action:
●
Pick the cloud of points or mesh as you enter the Basic Surface Recognition action.
●

Start the Activate action and pick a cloud of points or mesh
(the one you have previously picked or another if need be).

●

Activate the area you want to work on.

●

Exit the Activate action.

●

Pick the area you have just activated and start the Basic Surface Recognition.

The portion of the cloud of points or mesh to recognize can also be activated
before entering the Basic Surface Recognition.
4. Select the type of surface to detect or choose the Automatic option and
click Apply to visualize the shape.

5. For each type of surface, you can choose to let the application compute the surface
or you can set some data:
❍

For a plane: the normal to the plane and its passing point,

❍

For a sphere: the center and the radius,

❍

For a cylinder: the radius, the axis and the center,

❍

For a cone: none,

❍

For the automatic option: the maximum plane error.

Those data are also displayed in the dialog box when the surfaces are
computed by the application.
6. You can activate the corresponding fields by checking their names and
edit the values as necessary before creating the surfaces.
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If you choose a shape type to recognize, you can edit its geometric properties
(Axis, Center, Radius) by activating the corresponding check boxes and entering new values.
If the shape recognized is a plane, you can edit it graphically, using the extension
(arrows) and rotation (circle) manipulators.

If you choose the Automatic option, you cannot modify the geometric properties of the shape
directly.
Once the shape has been recognized, check the corresponding shape type to make
the corresponding properties editable.
Click Apply to take those modifications into account.
7. Check the Spike option to display the deviation between the canonic surface and the original part.
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8. Push the More>> button to display the statistics on the action.

9. Click OK to create the shape.

10. Double-click the shape to edit it, if required:

Page 130

Quick Surface Reconstruction

Version 5 Release 16

Page 131

The following features are created in the specification tree:
An extrusion element named Plane.x with its components,
The normal to that plane named PlaneNormal.x and its components
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An extrusion element named Cylinder.x with its components,
The axis of that cylinder named CylinderAxis.x and its components.

A feature sphere named Sphere.x and its components

A rotation element named Cone.x and its components,
The axis of that cone named ConeAxis.x and its components.
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PowerFit

This task shows how to use PowerFit.
PowerFit is used to create:
●

an untrimmed surface supported by one cloud of points or one mesh and/or curves,

●

a surface supported or not by one cloud of points or one mesh and trimmed by an external boundary.

Original mesh and boundary

Untrimmed surface supported by the mesh
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Surface supported by the mesh and trimmed by the boundary

Open the PowerFit1.CATPart from the Sample directory.
This model consists of a mesh (Polygon) and a join (Join.2).
1. Click on the PowerFit icon

. The dialog box is displayed:

This action is modal: the values used are re-displayed the next time you open this dialog box.
2. Enter the mesh and/or the curves to process,
set the constraints and parameters, click Apply to preview the result,
and OK to validate it. A Surface.x element is created in the specification tree.
The segmentation display is erased.
Below, you will find explanations on:
❍

Input elements,

❍

Constraints,

❍

Parameters,

❍

Information,

Page 134

Quick Surface Reconstruction
❍

Version 5 Release 16

Counterdraft detection.

3. Select the element(s) to be processed:

❍

either a cloud of points or a mesh or a portion of these.
You may process only one cloud or one mesh at a time.
Once selected, it is sent in the NoShow space.

❍

or curves,
■

■

■

The curves form either a closed set of curves or an open set of curves with only one hole in it.
You can make the curves continuous either during their construction or using the clean contour action.
You can either select a whole clean contour from the specification tree, or by picking one of its vertex
(the clean contour is highlighted), or pick curves (the curves are highlighted).
If one curve of the clean contour is linked to a face, the tangency continuity is not proposed
if you pick the curve. It is proposed if you pick the clean contour.

■

Those input curves are not modified and are sent to the NoShow space.

■

If a trimmed surface is created, the edges of the face will be the curves computed from the input curves.

Open set of curves with its topological closing line
Closed set of curves (no curve is created as such, but as the edge of the trimmed surface, if any)
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Open set of curves
This type of open set of curves is not accepted:

❍

or both.

4. Check the Init Surface box if you want to enter one. I
f you select an init surface, its name is displayed in the field Init Surface.

❍

The init surface helps improve the result surface, especially in rounded areas.

❍

You can either enter it yourself or let the application compute it in the direction
of the largest curve.

❍

The init surface must be larger than the domain to process.

5. Enter a Tolerance i.e. the mean maximum deviation between the surface created and the cloud of points
or mesh, i.e. the deviation may be higher at some places. This field is editable.
6. Choose the way the input curves are taken into account:

❍

as Constraint: the computed surface will go through them,

❍

Trim: the surface is computed, then the curves are projected onto it to trim it.

❍

or Selection: the computation is based on the points located inside the curves.
Continuity may be requested on the input curves regarding the surface to create:
❍
G-1: free. Applies to the Trim or the Selection options.
❍

G0: point continuity. Applies to the Constraint option.

❍

G1 : tangent continuity. Applies to the Constraint option.

By default, the continuity requested in the Join action are proposed by the PowerFit action.
You can change them by simply clicking on the text or using the contextual menu.
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You may want to select a join.
If this join contains a sliced surface edge, or a split CleanContour that contains a sliced surface edge,
with a tangency constraint that you want to keep, pick the curves one by one, graphically,
i.e. do not select a join by picking one vertex, nor select the elements in the specification tree.
In short:

Input

Information

Output

The surface is computed on the points.
It is not trimmed.

Points or meshs

Miscellaneous curves

No outer boundary.
No points.

This case is not dealt with.

Miscellaneous curves +
points

No outer boundary.
Points.

This case is not dealt with.

Option: Constraint
Possible constraints: G0,
G1.

The surface is computed on the curves.
The curves become the edges of the surface.

Option: Selection
Possible constraint: G-1

The surface is computed on the points located inside
the curves.
The surface is not trimmed.

or Curves (Outer
boundary).
No points.

or
Curves + points
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Option: Trim
Possible constraint: G-1
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The surface is computed on the points.
The curves are then projected on the surface to trim it.

Option: Constraint
The surface is computed on the points and the curves.
Possible constraints: G0 or
The curves become the edges of the surface.
G1

7. Enter the Order and Segments:
❍

❍

❍

❍

❍

These parameters apply globally to the surface computed.
They are maximum values.
The actual values are computed automatically by the action.
PowerFit creates a NURBS surface, controlled by the tolerance (i.e. Tolerance),
the number of segments and their order.
Whenever possible, this surface consists of one single segment,
otherwise, it is made of several segments.
This surface may then be trimmed by the curves.

You can increase the order of the segments, thus reducing their number, or vice-versa.
If the number of segments is x, this means that the surface computed will consist of a
maximum of x segments, or less.
The default number of segments is 64, the maximum number is 2048.
If the order of segments is y, this means that each segment will have a maximum number
of y control points in each direction, or less. The segment order may vary from 3 to 15.
❍

❍

Increasing the order of the segments may result in an oscillating surface,
even if this is not visible.
Push the Show Information button and check the Segmentation option to display
the segmentation of the computed surface.

8. If necessary, enter Advanced parameters:
You may want to impose an order and a number of segments in both U and V direction.
To do so, check Advanced. The Order and Segments fields above are no longer available.
You can edit the fields below to :
❍
enter the number of segments in each direction,
❍

enter the order of segments in each direction,

❍

swap the values in U and V.

Click Apply to restart the computation.
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9. Enter Gap: G0, i.e. the distance between the surface and the boundary curves.
Since there is more noise on points than on curves, the Tolerance may be higher than the GO Gap.
The default value is 1.

10. Enter Gap: G1, i.e. the tangency tolerance between two contiguous surfaces (in blue below).
The default value is 0.5.

11. Enter the Tension:
Possible values are between 0 and 4.
Use a higher value to have a smoother (but less tense) surface.

Please note that since the shape is constrained by the points, the effect of this parameter is limited.

12. Enter the Radius: when the cloud of points is noisy, it is difficult to have the surface going through
all the points and the curves (risk of undulations).
The points inside a circular pipe centered on the curve are deleted,
and you may want to set the radius of that pipe.

When you check this option, a blue sphere is displayed on the extremity of the first curve,
representing this radius (if you have selected at least one curve and a cloud of points or a mesh).
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If two curves are not distant enough, all the points between them may be deleted,
making the computation of the surface impossible.

13. Push the Show information button to check the required options and display statistics.
14. Check the Spikes option to display the deviations.
15. Check the Segmentation option to display

❍

the segmentation on the surfaces computed,

❍

the number of segments and order in U,

❍

the number of segments and order in V.

16. Use the Deviation field to enter the value above which the deviation spikes will be displayed.
When you first enter the action, the Deviation value is the same as the Tolerance.
Once a surface has been computed, the Deviation value is the computed one.
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You must first click Apply to compute the surface and to display the deviation spikes.

17. You can use one or more edges of an existing surface to compute a new surface with PowerFit.
Check the Connect Checker option to display the connection analysis between the existing surface and
the new surface.

The Connect Checker is not available on surface edges that have been previously sliced.
❍

You must first click Apply to compute the surface and to display the connection analysis.

❍

Click on OK or Cancel to exit the Quick Violation Analysis and return to the PowerFit dialog box .

❍

Click on Full to display more analysis options.

❍

More information is available in the Connect Checker section.

18. Information on the points for the parameters taken into account by the computation are available in
the box at the bottom of the dialog box (no dynamic display):

❍

❍

❍

❍

the maximum deviation found between the points of the cloud and the surface,
the mean deviation found between the points of the cloud and the surface.
This deviation should be as small as possible.
the standard deviation, i.e. the dispersion of the points around the mean deviation.
A small standard deviation indicates that most points are within the mean deviation,
i.e. that there are only few outliers.
the percentage of points of the cloud that are below the mean deviation.

Counterdraft detection
●

Generally, when a counterdraft or opposite points are detected, a message is displayed in the dialog box,
and no surface is computed. You can solve the problem by activating a portion of the cloud of points
and restarting the computation.
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When PowerFit is used to compute a trimmed surface from the points of a cloud of points
and curves that form the surface boundaries, these curves define a prismatic trap with infinite height
and a view direction. The points used for the computation are all the points contained in this trap.
Therefore, counterdraft or opposite points may alter the computation.
Counterdraft:

Opposite points:

PowerFit can select the required points up to a certain level:
❍
The points are separated into two zones, according to the direction of the normal of the triangles.
This selection is easy in the above cases
(the equator line is the separation between the two zones for the counterdraft, for the opposite points,
the zones are already well delimited). The incorrect zone is not taken into account in the computation.
❍

The selection is harder in such cases:

According to the normal of their triangles, the points belong to two zones,
shown in black and in yellow in our example.
The points surrounded in black form one zone,
the points surrounded in yellow form another zone,
both zones contain points that should not be taken into account.
Such cases are not yet dealt with successfully.
❍

In short, the points that PowerFit recognizes as unwanted for the computation are correctly eliminated.
However, some points may still be taken into account, whereas they should not.
This may lead to a defective result.
In such cases, you should activate yourself the requested zone, with the Activation command.

●

This is possible with meshs, not with cloud of points.

●

All triangles considered belong to the same mesh and their orientation is coherent.
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Creating Multi-sections Surfaces
This task shows how to create a multi-sections surface and includes the following functionalities:
●

Edit

●

Smooth parameters

●

Spine

●

Relimitation

●

Canonical Element

●

Coupling

You can generate a multi-sections surface by sweeping two or more section curves along an automatically
computed or user-defined spine. The surface can be made to respect one or more guide curves.
Open the Loft1.CATPart document.

1. Click the Multi-sections Surface icon

.

The Multi-sections Surface Definition dialog box appears.

2. Select two or more planar section curves.

Quick Surface Reconstruction
❍

❍
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The curves must be continuous in point.
You can select tangent surfaces for the start and end section curves. These tangent surfaces
must not be parallel to the sections.

A closing point can be selected for a closed section curves.
3. Click Preview.
Here is a multi-sections surface defined by three planar sections:

Sections can be 3D curves with following restrictions:
❍
the intersection between one 3D profile and all guides must be coplanar (if three guides or more
are defined)
❍

in case of a user-defined spine, this spine must be normal to the plane implicitly obtained
above.

4. If needed, select one or more guide curves.
Guide curves must intersect each section curve and must be continuous in point.
The first guide curve will be a boundary of the multi-sections surface if it intersects the first extremity of
each sections curve.
Similarly, the last guide curve will be a boundary of the multi-sections surface if it intersects the last
extremity of each section curve.
Here is a multi-sections surface defined by 2 planar sections and 2 guide curves:

You can make a multi-sections surface tangent to an adjacent surface by selecting an end section that
lies on the adjacent surface. In this case, the guides must also be tangent to the surface.
In Figure 2 a multi-sections surface tangent to the existing surface has been created:
Figure 1:
Figure 2:
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You can also impose tangency conditions by specifying a direction for the tangent vector (selecting a
plane to take its normal, for example). This is useful for creating parts that are symmetrical with respect
to a plane. Tangency conditions can be imposed on the two symmetrical halves.
Similarly, you can impose a tangency onto each guide, by selection of a surface or a plane (the direction
is tangent to the plane's normal). In this case, the sections must also be tangent to the surface.
5. Click OK to create the multi-sections surface.
The surface (identified as Multi-sections Surface.xxx) is added to the specification tree.
Extremum points are now aggregated under the parent command that created them and put in no show
in the specification tree.

Editing a Multi-sections Surface
It is possible to edit the multi-sections surface reference elements by first selecting a curve in the dialog box list,
or by selecting the text on the figure, then choosing a button to either:

●

remove the selected curve

●

replace the selected curve by another curve

●

add another curve

Quick Surface Reconstruction
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More possibilities are available with the contextual menu and by right-clicking on the red text or on
the object. For example, it is possible to remove and replace tangent surfaces and closing points.
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The following example illustrates the result when the tangency condition is removed between the
blue multi-sections surface and the adjacent surface:

Defining Smooth Parameters
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In the Smooth parameters section, you can check:
●
the Angular Correction option to smooth the lofting motion along the reference guide curves. This may be
necessary when small discontinuities are detected with regards to the spine tangency or the reference guide
curves' normal. The smoothing is done for any discontinuity which angular deviation is smaller than 0.5
degree, and therefore helps generating better quality for the resulting multi-sections surface.
●

the Deviation option to smooth the lofting motion by deviating from the guide curve(s).

❍

❍

If you are using a both Angular Correction and Deviation options, it is not guaranteed that the
spine plane be kept within the given tolerance area. The spine may first be approximated with the
deviation tolerance, then each moving plane may rotate within the angular correction tolerance.
Do not specify a deviation on a multi-sections surface, solid or volume that should be in contact
with guide curves.

Selecting a Spine
In the Spine tab page, select the Spine check box to use a spine that is automatically computed or select a
curve to impose that curve as the spine.

●

●

●

It is strongly recommended that the spine curve be normal to each section plane and must be continuous in
tangency. Otherwise, it may lead to an unpredictable shape.
If the plane normal to the spine intersects one of the guiding curves at different points, it is advised to use
the closest point to the spine point for coupling.
You can create multi-sections surfaces between closed section curves. These curves have point continuity at
their closing point.
This closing point is either a vertex or an extremum point automatically detected and highlighted by the
system.
By default, the closing points of each section are linked to each other.
The red arrows in the figures below represent the closing points of the closed section curves. You can change
the closing point by selecting any point on the curve.
A new closing point has been imposed to get a nonThe surface is twisted:
twisted surface:
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Relimitating the Multi-sections Surface
The Relimitation tab lets you specify the relimitation type.
You can choose to limit the multi-sections surface only on the Start section, only on the End section, on both, or
on none.
Open the Loft3.CATPart document.

a. when none of the options are checked: the swept surface is extrapolated up to the spine limits.
b. when both options are checked: the multi-sections surface is limited to corresponding sections
c. when one or both options are unchecked: the multi-sections surface is swept along the spine:
❍
if the spine is a user spine, the multi-sections surface is limited by the spine extremities or by the first
guide extremity met along the spine.
❍

❍

❍

if the spine is an automatically computed spine, and no guide is selected: the multi-sections surface is
limited by the start and end sections
if the spine is an automatically computed spine, and one or two guides are selected: the multisections surface is limited by the guides extremities.
if the spine is an automatically computed spine, and more than two guides are selected: the spine
stops at a point corresponding to the barycenter of the guide extremities. In any case, the tangent to
the spine extremity is the mean tangent to the guide extremities.
Both options checked:
End section option unchecked:
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After the multi-sections surface is relimited, the following constraint needs to be fulfilled: the
plane normal to the spine defined at the relimitation point must intersect the guide(s) and the
point(s) resulting from this intersection must belong to the section.

Using a Canonical Element
Use the Canonical portion detection check button in the Canonical Element tab to automatically detect planar
surfaces to be used as planes for features needing one in their definition.

Initial multi-sections surface with planar faces:

Using a planar face as reference for a sketch:

Resulting sketch:
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Coupling
This task presents the three kinds of coupling during the creation of the multi-sections surface surface:
●
coupling between two consecutive sections
●

coupling between guides

●

manual coupling

These couplings compute the distribution of isoparameters on the surface.
Open the Loft2.CATPart document.

Coupling between two consecutive sections
This coupling is based on the curvilinear abscissa.
1. Click the Multi-sections Surface icon

.

The Multi-sections Surface Definition dialog box appears.
2. Select the two consecutive sections.
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3. Click OK to create the multi-sections surface.

If you want to create a coupling between particular points, you can add guides or define the coupling
type.
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Coupling between guides
This coupling is performed by the spine.
If a guide is the concatenation of several curves, the resulting multi-sections surface will contain as many
surfaces as curves within the guide.
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Several coupling types are available, depending on the section configuration:
●
Ratio: the curves are coupled according to the curvilinear abscissa ratio.

●

●

●

Tangency: the curves are coupled according to their tangency discontinuity points. If they do not have the
same number of points, they cannot be coupled using this option.

Tangency then curvature: the curves are coupled according to their tangency continuity first then
curvature discontinuity points. If they do not have the same number of points, they cannot be coupled using
this option.
Vertices: the curves are coupled according to their vertices. If they do not have the same number of
vertices, they cannot be coupled using this option.

Manual Coupling
If the number of vertices differ from one section to another, you need to perform a manual coupling.
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1. Select the sections for the multi-sections surface, and check their orientations.
2. In the Coupling tab, choose the Tangency option and click Preview.
An error message is displayed as the number of discontinuity points on the first section is greater than on
the other two sections.
The points that could not be coupled, are displayed in the geometry with specific symbol depending on
the selected mode, along with coupling lines:

❍

❍

In Tangency mode: uncoupled tangency discontinuity points are represented by a square.

In Tangency then curvature mode:
■
uncoupled tangency discontinuity points are represented by a square
■

❍

uncoupled curvatures discontinuity points are represented by a empty circle

In Vertices mode: uncoupled vertices are represented by a full circle

3. Click in the coupling list, or choose Add in the contextual menu, or using the Add button, and manually
select a point on the first section.
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The Coupling dialog box is displayed.

4. Select a corresponding coupling point on each section of the multi-sections surface.
The Coupling dialog box is updated consequently, and the coupling curve is previewed, provided the
Display coupling curves option is active.
When a coupling point has been defined on each section, this dialog box automatically disappears.

5. Click OK.
The multi-sections surface is created as defined with the coupling specifications.
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The same multi-sections surface without coupling and with Ratio option would have looked like this:

Note the increased number of generated surfaces.

●

●

●

You can create coupling point on the fly, using the Create coupling point
contextual menu item (click in the 3D area to display the contextual menu) instead
of selecting an existing point.
To edit the coupling, simply double-click the coupling name in the list (Coupling
tab) to display the Coupling dialog box. Then you select the point to be edited from
the list and create/select a replacing coupling point, then click OK.
Use the contextual menu on the coupling list to edit defined couplings.

Version 5 Release 16

Quick Surface Reconstruction

Page 158

Surfaces Network
This task will show you how to create a surface on a curves network.

Create a network of curves from the SurfNetwork.CATPart from the samples directory.
1. Click the Surfaces Network icon

. The dialog box is displayed.

2. Select the curves network you have created (mandatory),
as well as the mesh as the Cloud.

3. Select Init Surface box if you want to enter one.
The init surface helps the computation by giving the shape of the result surface.
You can either enter it yourself or let the application compute it in the direction of the largest
curve.

Quick Surface Reconstruction

Version 5 Release 16

Page 159

If you select an init surface, its name is displayed in the field Init Surface.
❍

❍

It is not necessary to use a support Cloud or a Init Surface, but they may improve the
output.
The init surface must be larger than the domain to process.

4. The curves network is displayed, with a green V marker on each wire, meaning the wire will be
filled.

5. You can fill all the wires automatically (this is the proposed default) or you can fill the wires one by
one.
6. If you do not want to fill a wire:
❍

❍

either click on its marker, it will turn into a red X marker. The wire will not be filled.
(click the marker again to reselect the wire, if necessary),
or place the cursor on a marker and use the contextual menu:
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❍

Selected and Not selected apply to a single wire,

❍

Select all and De-Select all apply to the whole network,

❍

Swap Selection reverses the selection.
Remove Surface allows you to suppress a surface you are not happy with
or that you prefer to fill later.

❍

7. Constraints are set on edges shared by two wires.

represents a point continuity

represents a tangency continuity

To change the type of a constraint:

●

either click on its marker. This will act as a toggle,

●

or place the cursor on a marker and use the contextual menu:

●

●

Point Continuity and Tangent Continuity apply to a single
constraint,
All Point Continuity and All Tangent Continuity apply to
the whole network.
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is the mean maximum deviation between the surface created

and the cloud of points or mesh, i.e. the deviation may be higher at some places. This field is
editable.
9. You can set Gap: G0, which is the distance between the surface and the boundary curves.
Since there is more noise on points than on curves, the Tolerance may be higher than the GO
Gap.
The default value is 1.

10. You can set Gap: G1, which is the tangency tolerance between two contiguous surfaces (in blue
below).
The default value is 0.5.

11. You can set the Radius:
❍

when the cloud of points is noisy, it is difficult to have the surface going through all the points
and the curves (risk of undulations).
The points inside a circular pipe centered on the curve are deleted, and you may want to set
the radius of that pipe.

Quick Surface Reconstruction
❍
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When you check this option, a blue sphere is displayed on the extremity of the first curve,
representing this radius
(if you have selected at least one curve and a cloud of points or a mesh).

If two curves are not distant enough, all the points between them may be deleted,
making the computation of the surface impossible.

12. You can set the Tension:
Possible values are between 0 and 4.
Use a higher value to have a smoother (but less tense) surface.
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13. You can set Standard: Order, Segments:
These parameters apply globally to the surface computed. They are maximum values.
The actual values are computed automatically by the action.
Surfaces Network creates a NURBS surface, controlled by the tolerance (i.e. Tolerance),
the number of segments and their order.
Whenever possible, this surface consists of one single segment,
otherwise, it is made of several segments.
This surface may then be trimmed by the curves.

You can increase the order of the segments, thus reducing their number, or vice-versa.
❍

❍

If the number of segments is x, this means that the surface computed will consist of
a maximum of x segments, or less.
The default number of segments is 64, the maximum number is 2048.
If the order of segments is y, this means that each segment will have a maximum number
of y control points in each direction, or less.
The segment order may vary from 3 to 15.
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14. You can set Advanced: Order and Segments in U and V. You may want to impose an order
and a number of segments in both U and V direction. To do so, go to the Advanced tab.
You can edit the fields to :

●

enter the number of segments in each direction,

●

enter the order of segments in each direction.

Click Apply to restart the computation.
●

●

Increasing the order of the segments may result in an oscillating
surface,
even if this is not visible.
Entering a global number of Segments in the Standard tab is
different
from entering the square roots of the global value for the
Segments in U and in V
in the Advanced tab:
if you enter a global value of 64 segments in the Standard tab,
this is a maximum value,
that may be distributed in 14 segments in U and 4 in V,
whereas if you enter 8 segments in U and 8 segments in V,
the maximum number of segments in U will be 8, the surfaces
computed will thus be different.

15. You can select Compute with ribbons.
This option is only available if a mesh is selected and is used when a tangent continuity is
required between the wires.
The wires curves are projected on the mesh and a tangency ribbon is computed on the mesh
around the curve projection, and then taken into account for the computation of the filling surface.
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16. Use the Reset parameters button to reset the parameters, if necessary.

17. Push the Apply button. The filling surface is computed. A progress bar is displayed.

18. Go to the Results/Display tab.
Information on the points for the parameters taken into account by the computation are available
in the box at the top of the tab (no dynamic display):
❍

the maximum deviation found between the points of the cloud and the surface,

❍

the mean deviation found between the points of the cloud and the surface.
This deviation should be as small as possible.

❍

the percentage of points of the cloud that are below the mean deviation.
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19. Check the Spikes option to display the deviations.
20. Check the Segmentation option to display

●

the segmentation on the surfaces computed,

●

the number of segments and order in U,

●

the number of segments and order in V.

21. Use the Deviation field

to enter the value

above which the deviation spikes will be displayed.
When you first enter the action, the Deviation value is the same as the Tolerance.
Once a surface has been computed, the Deviation value is the computed one.

Quick Surface Reconstruction

Version 5 Release 16

Page 167

22. By default, the options Display selection and Display constraints are checked.
You can uncheck them according to your needs.

23. Once you are satisfied, click OK to create the result:
the surfaces are assembled (Tolerance = 0.1 mm)
❍

If the assembly does not respect the tolerance an error message is issued.

❍

If the assembly failed, an error message is issued and the surfaces are created separately.

A Surface.xx element is created in the specification tree.
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Automatic Surface
This task will show you how to create surfaces automatically from a mesh.
●
The Automatic Surface command adapted to many types of shapes.
●

It can create complex surfaces with a minimum set of Nurbs.

●

It can take holes into account.

The input required is a mesh (not a cloud of points):
●

it may not have non-manifold vertices or triangles,

●

it must be a mono-cell mesh, without non-connex zones,

Sharp edges are not preserved.

Open the AutomaticSurf.CATPart from the samples directory.
1. Click the Automatic Surface icon

.

2. Select Sample as the Mesh. The

is now available and enables you to hide or show the mesh.

3. Enter the Mean surface deviation,
i.e. the average deviation between the surface that will be created and the input mesh,
computed on all mesh vertices.
4. Click Preview to preview the surface.
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5. Click More to have access to statistics and some display options:

The Statistics are:
●

●

●

●

●

output faces:
global count of faces contained in the output surface,
Max surface deviation:
value of the maximum deviation between the surface and the mesh,
also displayed with the spikes,
Max free edges deviation:
value of the maximum deviation between the free edges and the mesh,
also displayed with the spikes,
Mean surface deviation:
value of the mean deviation between the surface and the mesh,
xx% of yyy points Ok:
percentage of the measured points that are under the Mean surface deviation.

6. Select Spikes to visualize the deviations between the mesh and the surface:

●

●

The points with the maximum deviation on the surface or
on free edges are displayed on a small yellow rectangle,
with the corresponding value of the deviation.
Deviation enables you to display only the spikes on points
with a deviation greater than this value.

●

Negative and positive deviations are displayed in different colors.

●

Push

to visualize the deviations on the surface:
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Push
to visualize the deviations on the free edges
(only availbable when free edges exist):

7. Click OK. Surface.2 is created.

Tuning parameters
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Surface detail
Helps you increase or decrease the respect of mesh details on the resulting surface:
the higher the value, the higher the respect of details.
The proposed range value is just an indication. It can be edited through its contextual menu:

●

The Surface detail is set to 500:

●

The Surface detail is set to 1000:
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Free edge tolerance
Chordal value used to sample the mesh boundaries.
Select this option to improve the quality of the surface with respect to the mesh boundaries.
●

Free edge tolerance is not selected:

●

Free edge tolerance is selected:

Target ratio
Ratio of measured points with a surface deviation under the Mean surface deviation value.
●

The actual ratio obtained may be different (greater or lower) than the one you have requested.

●

A ratio next to 100 is time consuming.
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If the Mean surface deviation or the Target ratio requested cannot be reached,
the surface is created and a message is displayed.
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Operations
This chapter deals with operations in Quick Surface Reconstruction.
Joining Surfaces or Curves
Splitting Geometry
Trimming Geometry
Extrapolating Surfaces
Curves Slice
Adjust Nodes
CleanContour Split
Edge Fillet
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Joining Surfaces or Curves
This task shows how to join surfaces or curves.
This involves:
●
using the check options
●

removing sub-elements

●

using the federation capability

Open the Join1.CATPart document.

1. Click the Join icon

.

The Join Definition dialog box appears.

In Part Design workbench, the Join capability is available as a contextual command named 'Create
Join' that you can access from Sketch-based features dialog boxes.
2. Select the surfaces or curves to be joined.
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3. You can edit the list of elements to be joined:
❍

by selecting elements in the geometry:
■
Standard selection (no button clicked):
when you click an unlisted element, it is added to the list
when you click a listed element, it is removed from the list
■

■

❍

Add Mode:
when you click an unlisted element, it is added to the list
when you click a listed element, it remains in the list
Remove Mode:
when you click an unlisted element, the list is unchanged
when you click a listed element, it removed from the list

by selecting an element in the list then using the Clear Selection or Replace Selection
contextual menu items.
If you double-click the Add Mode or Remove Mode button, the chosen mode is permanent,
i.e. successively selecting elements will add/remove them. However, if you click only once,
only the next selected element is added or removed.
You only have to click the button again, or click another one, to deactivate the mode.

4. Right-click the elements from the list and choose the Check Selection command.
This lets you check whether an element to be joined presents any intersection (i.e. at least one
common point) with other elements prior to creating the joined surface. If this command is not
launched, possible intersections will not be detected.
The Checker dialog box is displayed, containing the list of domains (i.e. sets of connected cells)
belonging to the selected elements from the Elements To Join list.
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5. Click Preview.
❍

❍

An Information message is issued when no intersection is found.

When an element is self-intersecting, or when several elements intersect, a text is displayed on
the geometry, where the intersection is detected.

6. Click Cancel to return to the Join Definition dialog box.
7. Right-click the elements again and choose the Propagation options to allow the selection of
elements of same dimension.
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Distance Propagation: the tolerance corresponds to the Merging distance value.
Angular Propagation: the tolerance corresponds to the Angular Threshold value, if defined.
Otherwise, it corresponds to the G1 tolerance value as defined in the part.

Each new element found by propagation of the selected element(s) is highlighted and added to the
Elements To Join list.
Note that:
❍
The initial element to propagate cannot be a sub-element,
❍

Forks stop the propagation,

❍

Intersections are not detected.

8. Click Preview in the Join Definition dialog box.
The joined element is previewed, and its orientation displayed. Click the red arrow to invert it if
needed.

The join is oriented according to the first element in the list. If you change this element, the join's
orientation is automatically set to match the orientation of the new topmost element in the list.

Using the check options

9. Check the Check tangency option to find out whether the elements to be joined are tangent. If
they are not, and the option is checked, an error message is issued when you click Preview...
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... and elements in error are highlighted in the 3D geometry once you have clicked OK in the
Update Error dialog box:

10. Check the Check connexity option to find out whether the elements to be joined are connex. If
they are not, and the button is checked, an error message is issued indicating the number of
connex domains in the resulting join and elements in error are highlighted in the 3D geometry.
When clicking Preview, the free boundaries are highlighted, and help you detect where the
joined element is not connex.
If two elements are not connex and the Check connexity option is deselected, the MultiResult Management dialog box is displayed.
11. Check the Check manifold option to find out whether the resulting join is manifold.
The Check manifold option is only available with curves.
Checking it automatically checks the Check connexity option.
12. You can check the Simplify the result option to allow the system to automatically reduce the
number of elements (faces or edges) in the resulting join whenever possible.
13. You can check the Ignore erroneous elements option to let the system ignore surfaces and
edges that would not allow the join to be created.
14. You can also set the tolerance at which two elements are considered as being only one using the
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Merging distance.
By default, the value is set to 0.001 mm and corresponds to the value defined in Tools ->
Options. To find out more about the merging distance value, refer to the General Settings
chapter.
15. Check the Angular Threshold option and specify the angle value below which the elements are to
be joined.
If the angle value on the edge between two elements is greater than the Angle Tolerance
value, the elements are not joined. This is particularly useful to avoid joining overlapping
elements.

Removing Sub-Elements
16. Click the Sub-Elements To Remove tab to display the list of sub-elements in the join.

These sub-elements are elements making up the elements selected to create the join, such as
separate faces of a surface for example, that are to be removed from the join currently being
created.
You can edit the sub-elements list as described above for the list of elements to be joined.
17. Check the Create join with sub-elements option to create a second join, made of all the subelements displayed in the list, i.e. those that are not to be joined in the first join.
❍

This option is active only when creating the first join, not when editing it.

❍

A message is displayed to inform you of the creation of a second join.

18. Click OK to create the joined surface or curve.
The surface or curve (identified as Join.xxx) is added to the specification tree.
Sometimes elements are so close that it is not easy to see if they present a gap or not, even though they
are joined. Check the Surfaces' Boundaries option from the Tools -> Options -> General -> Display > Visualization menu item.
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Using the Federation Capability

The purpose of the federation is to regroup several elements making up the joined surface or curve that
will be detected together with the pointer when selecting one of them. This is especially useful when
modifying linked geometry to avoid re-specifying all the input elements.
Open the Join2.CATPart document.
1. Create the join as usual, selecting all elements to be joined.
(Make sure you do not select Sketch.1).
2. From the Join Definition dialog box, click the Federation tab, then select one of the elements
making up the elements federation (providing the No federation and All propagation modes are
not selected).
You can edit the list of elements taking part in the federation as described above for the list of
elements to be joined.
3. Choose a propagation mode, the system automatically selects the elements making up the
federation, taking this propagation mode into account.
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No federation: no element can be selected
All: all elements belonging to the resulting joined curve/surface are part of the federation.
Therefore, no element can be explicitly selected.

Point continuity: all elements that present a point continuity with the selected elements and
the continuous elements are selected.

Tangent continuity: all the elements that are tangent to the selected element, and the ones
tangent to it, are part of the federation.
Here, only the top faces of the joined surface are detected, not the lateral faces.
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To federate a surface and its boundaries in tangency, you need to select the face as well as
the edges: both face and edges will be federated.
❍

No propagation: only the elements explicitly selected are part of the propagation.

4. Choose the Tangency continuity propagation mode.
5. Move to the Part Design workbench (select Start -> Mechanical Design -> Part Design), select
the Sketch.1, and click the Pad

icon to create an up to surface pad, using the joined surface

as the limiting surface.

6. Select the front edge of the pad, and create a 2mm fillet using the Edge Fillet icon

.
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7. Double-click Sketch.1 from the specification tree, then double-click the constraint on the sketch to
change it to 10mm from the Constraint Definition dialog box.
Sketch prior to modification lying over two
faces:

8. Exit the sketcher

Sketch after modification lying over one face only:

.

The up to surface pas is automatically recomputed even though it does not lie over the same faces
of the surface as before, because these two faces belong to the same federation. This would not be
the case if the federation including all top faces would not have been created, as shown below.
9. Double-click the joined surface (Join.1) to edit it, and choose the No propagation mode.
10. Click OK in the Join Definition dialog box.
A warning message is issued, informing you that an edge no longer is recognized on the pad.
11. Click OK.
The Update Diagnosis dialog box is displayed, allowing you to re-enter the specifications for the
edge, and its fillet.
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You then need to edit the edge and re-do the fillet to obtain the previous pad up to the joined
surface.
12. Select the Edge.1 line, click the Edit button, and re-select the pad's edge in the geometry.
13. Click OK in the Edit dialog box.
The fillet is recomputed based on the correct edge.
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Splitting Geometry
This task shows how to split a surface or wireframe element by means of a cutting element.
You can split a wireframe element by a point, another wireframe element or a surface; or a surface by a wireframe element or
another surface.
●

Keeping or Removing Elements

●

Intersecting and extrapolating

●

Splitting Wires

●

Splitting a surface by a curve or a surface by a surface

●

Splitting closed surfaces by two connex surfaces or curves

●

Splitting Volumes

Open the Split1.CATPart document.

1. Click the Split icon

.

The Split Definition dialog box appears.

2. Select the element to be split.
You should make your selection by clicking on the portion that you want to keep after the split.
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You can select several elements to cut. In that case, click the Element to cut field again or click the bag icon
.
The Elements to cut field opens. Select as many elements as needed. Click Close to return to the Split Definition
dialog box. The number of selected elements is displayed in the Element to cut field.

Use the Remove and Replace buttons to modify the elements list.
When several elements to cut are selected, the selected portions are not taken into account as parts to keep. The
parts to be kept depend on the type of the cutting element (point, curve, surface, etc.) and the orientation of
cutting elements and the elements to cut.
Use the Other side button to reverse the portion to be kept, element by element.
3. Select the cutting element.
A preview of the split appears. You can change the portion to be kept by selecting that portion.
You can also select the portion to be kept by clicking the Other side button.
This option applies on all selected elements to cut.

You can select several cutting elements. In that case, note that the selection order is important as the area to be
split is defined according to the side to be kept in relation to the current splitting element.
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You can create a Join as the splitting element, by right-clicking in the Cutting Elements field and choosing the
Create Join item.
If you split a surface and you keep both sides by joining the resulting splits, you cannot access the internal subelements of the join: indeed, splits result from the same surface and the cutting elements are common.
4. Click OK to split the element.
The created element (identified as Split.xxx) is added to the specification tree.
In the case several elements to cut were used, the created elements are aggregated under a Multi-Output.xxx feature.

In the illustrations below, the top-left line is the first splitting element. In the left illustration it defines an area that
intersects with the other three splitting curves, and in the illustration to the right, these three elements are useless to
split the area defined by the first splitting element.

Would you need to remove, or replace, one of these cutting elements, select it from the list and click the Remove or
Replace button.

Keeping or Removing Elements
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The Elements to remove and Elements to keep options allows to define the portions to be removed or kept when performing
the split operation.
1. Click in the field of your choice to be able to select the elements in the 3D geometry.
2. Right-click in the field either to clear the selection or display the list of selected elements.
Only the selected element is removed.
All other elements are kept:

The selected elements are kept.
All other elements are removed:

❍

❍

You must select sub-elements as elements to keep or to remove; otherwise, a warning message is issued.

You can also select a point to define the portion to keep or to remove.
A contextual menu is available on the Elements to remove and Elements to keep fields.
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You do not need to select elements to keep if you already selected elements to remove and vice-versa.
Check the Keep both sides option to retain the other side of the split element after the operation. In that case
it appears as aggregated under the first element.
Therefore both split elements can only be edited together and the aggregated element alone cannot be deleted.
If you use the Datum mode, the second split element is not aggregated under the first one, but two datum
surfaces are created.
Avoid splitting geometry when the intersection between the element to cut and the cutting element is merged
with an edge of the element to cut.
In that case, you can use the Elements to remove and Elements to keep options to remove the positioning
ambiguity.
In case there are several elements to cut, the Keep/Remove and Keep both sides options only apply on the
first selected element.

Intersections and extrapolations
●

Check the Intersections computation option to create an aggregated intersection when performing the splitting operation.
This element will be added to the specification tree as Intersect.xxx.

In case there are several elements to cut, the Intersections computation option only applies on the first selected
element.
●

Uncheck the Automatic extrapolation option if do not you want the automatic extrapolation of the cutting curve.
When a splitting curve is extrapolated, the extrapolation will performed on the original curve, providing the underlying
geometry (that is the curve) is long enough to be used for the extrapolation.
If the Automatic extrapolation option is unchecked, an error message is issued when the cutting element needs to be
extrapolated, and the latter is highlighted in red in the 3D geometry.
This option is available in the case of a split surface/curve or surface/surface.
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Splitting Wires
●

When splitting a wire (curve, line, sketch and so forth) by another wire, you can select a support to define the area that will
be kept after splitting the element. It is defined by the vectorial product of the normal to the support and the tangent to the
splitting element.
This is especially recommended when splitting a closed wire.
The non disconnected elements of the element to cut are kept in the result of the split.
Splitting with no support selected, first solution:
Splitting with no support selected, second solution:

Splitting with a selected support (xy plane), first solution:Splitting with a selected support (xy plane), second solution:

Splitting a surface by a curve or a surface by a surface
The following steps explain how split a surface by a curve or another surface.

Split surface/curve
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1. First, the cutting element (the curve) is laid down the surface.

2. Then, the result of step 1 is tangentially extrapolated in order to split the surface correctly (as shown in following figure).
However, when this extrapolation leads to the intersection of the cutting element with itself prior to fully splitting the
initial element, an error message is issued as there is an ambiguity about the area to be split.

If the cutting element does not reach the free edges of the element to cut, an extrapolation in tangency is
performed using the part of the cutting element that lays down the surface.

Split surface/surface
Open the Split2.CATPart document.
1. First, an intersection (the green wire) is created between the two surface elements.

2. Then, the result of the intersection is automatically extrapolated in tangency up to the closest free edges of the element
to cut.
The result of the extrapolation is used as the cutting element and the split is created.
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Note that it is not the cutting element which is extrapolated but the result of the intersection.
If the result of the split is not what was expected, it is also possible to manually extrapolate the cutting element
with the extrapolate feature before creating the split.
3. Extrapolate the cutting element (the red surface) in order to fully intersect the element to cut.

4. Then, use the extrapolated surface as the cutting element to split the surface.
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Avoid using input elements which are tangent to each other since this may result in geometric instabilities in
the tangency zone.
In case surfaces are tangent or intersect face edges, use the border edge of the cutting surface to split the
element to cut:
■
Delimit the boundary of the cutting surface, then
■

project this boundary onto the surface to split, then

■

use this projection as the cutting element

The last two steps may be optional if the tangency constraint between the two surfaces has been clearly defined
by the user during the surface creation.

❍

The following cases should be avoided when possible (especially when the tangency constraint between the two
surfaces has not been clearly defined by the user during the surface creation), as the result of the positioning is
likely to be indeterminate and the result of the intersection to be unstable.
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Splitting Closed Surfaces by Two Connex Surfaces or Curves
When splitting a closed surface or a curve by connex elements, an error message is issued. You need to create a join feature of
non connex elements and cut the closed surface or curve with this join feature.
Open the Split3.CATPart document.

1. Click the Join icon
.
The Join Definition dialog box appears.
2. Select Split.1 and Inverse.1 as the surfaces to be joined.
Be careful that both surfaces or curves to join have coherent orientations. If it is not the case, use the Invert
command to invert the orientation of one of the two surfaces or curves.
Note that coherent orientations means same orientations as the faces or edges of an equivalent connex splitting
surface or curve:
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3. Uncheck the Check connexity option.
4. Click OK to create the joined surface.
.
5. Click the Split icon
The Split Definition dialog box is displayed.
6. Select Surface.1 as the Element to cut and Join.1 as the Cutting element.
7. Click OK to split the closed surface.

If the orientation of the elements composing the joined surface or curve is incoherent, an error message is issued
when creating the split surface.

Splitting Volumes
This capability is only available with Generative Shape Optimizer.
Providing the element to be cut is a volume and the cutting element is a volume or a surface, you can choose whether you want
the result of the split to be a surface or a volume. To do so, switch to either Surface or Volume option. This switch only
concerns volumes since the transformation of a surface can only be a surface.
Note that the switch between surface and volume is grayed out when editing the feature.
If the result of the split is a volume, the split is a modification feature. If the result of the split is a surface, the split is a creation
feature.
To have further information about volumes, please refer to the Creating Volumes chapter.
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The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Trimming Geometry
This task shows you how to trim two or more surface or wireframe elements.
Open the Trim1.CATPart document.

1. Click the Trim icon

.

The Trim Definition dialog box appears.
2. Select the trim mode:
❍

Standard

❍

Pieces

Standard
With this mode, one portion of the selected element (surface or wire) is kept and the list of trimmed elements is ordered.
The following options are explained hereafter:
●
Selecting a Support
●

Keeping or Removing Elements

●

Simplifying the result

●

Intersecting and extrapolating
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1. Select the two surfaces or two wireframe elements to be trimmed.

A preview of the trimmed elements appears and the list of trimmed elements is updated:

You can change the portion to be kept by selecting that portion:
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2. Click OK to trim the surfaces or wireframe elements.
The trimmed feature (identified as Trim.xxx) is added to the specification tree.

You can also select the portions to be kept by clicking the Other side / next element and Other side /
previous element buttons.
Clicking the Other side / previous element
Clicking the Other side / next element button:
button:

Selecting a Support
When trimming wires (curve, line, sketch and so forth) by another wire, you can select a support to define the area that
will be kept after trimming the element. It is defined by the vectorial product of the normal to the support and the
tangent to the trimming element.
This is especially recommended when trimming a closed wire.
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In our example, the Sketch composed of two lines (Sketch.11) is trimmed by the circle (Sketch.10).
Resulting trimmed element without support selection: Resulting trimmed element with support selection:

Keeping or Removing Elements
The Elements to remove and Elements to keep options allows to define the portions to be removed or kept when
performing the trim operation.
1. Click in the field of your choice to be able to select the elements in the 3D geometry.
2. Right-click in the field either to clear the selection or display the list of selected elements.
Only the selected portion is removed. All other
Only the selected portion is kept. All other elements are
elements are kept:
removed:

You can also select a point to define the portion to keep or to remove.
A contextual menu is available on the Elements to remove and Elements to keep fields.
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You do not need to select elements to keep if you already selected elements to remove and vice-versa.
Avoid trimming geometry when the intersection between the trimmed elements is merged with an edge
of one of the elements.
In that case, you can use the Elements to remove and Elements to keep options to remove the
position ambiguity.

Simplifying the Result
Check the Result simplification button to allow the system to automatically reduce the number of faces in the resulting
trim whenever possible.

Intersecting and extrapolating
●

Check the Intersections computation button to create an aggregated intersection when performing the trimming
operation. This element will be added to the specification tree as Intersect.xxx.

Refer to the Splitting Geometry chapter in the case surfaces are tangent or intersect face edges.
●

Uncheck the Automatic extrapolation option if you do not want the automatic extrapolation of the elements to
trim.
If the Automatic extrapolation button is unchecked, an error message is issued when the elements to trim need to
be extrapolated, and the latter are highlighted in red in the 3D geometry.

To be able to trim the two surfaces or wireframe elements, check the Automatic extrapolation option.
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The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

Pieces
With this mode, all trimmed curves are split together, all selected portions are kept and the list of trimmed curves is
unordered.
This mode is only available with curves.
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1. Select the elements to be trimmed, as shown below:

A preview of the trimmed elements appears and the list of trimmed curves is updated:

You can deselect a sub-element by selecting it again.
2. Click OK to trim the curves.
The trimmed feature (identified as Trim.xxx) is added to the specification tree.

●

Check the Check connexity option to find out whether the curves to be trimmed are
connex. If they are not, and the option is checked, an error message is issued indicating
the number of connex domains in the resulting trimmed feature.
The resulting feature is highlighted, and help you detect where the trimmed feature is not
connex.

●

Check the Check manifold option to find out whether the resulting trimmed feature is
manifold.

●

Use the Remove and Replace buttons to modify the elements list.

●

The following capability is available: Stacking Commands.
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For both modes:
●
At creation, when you switch from one mode to the other, the list of selected elements is automatically reinitialized.
●

You cannot modify the mode at edition.
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This task shows you how to extrapolate a surface boundary.
Open the Extrapolate1.CATPart document.

1. Click the Extrapolate icon

.

The Extrapolate Definition dialog box appears.

2. Select a surface Boundary.
3. Select the surface to be Extrapolated.
4. Select the extrapolation type:
❍

Length: enter the value in the Length field or use the manipulators in the 3D geometry.
It is not advised to enter a negative value in the Length field.

❍

Up to: the Up to field is enabled. Select an element belonging to the same support as the surface to be extrapolated (surface or plane).
This option is only available with the Tangent continuity type.

5. Specify the Limit of the extrapolation by either:
❍

entering the value of the extrapolation length

❍

selecting a limit surface or plane

❍

using the manipulators in the geometry.

6. Specify the Continuity type:
❍

Tangent

❍

Curvature

Tangent:

Curvature:
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7. Specify Extremities conditions between the extrapolated surface and the support surface.
This option is now available with the Curvature continuity type.
❍

Tangent: the extrapolation sides are tangent to the edges adjacent to the surface boundary.

❍

Normal: the extrapolation sides are normal to the original surface boundary.

Tangent (Tangent continuity):

Normal (Curvature continuity):

8. Specify the Propagation type:
❍

Tangency continuity to propagate the extrapolation to the boundary's adjacent edges.

❍

Point continuity to propagate the extrapolation around all the boundary's vertices.

Tangent continuity:

Point continuity:

9. Click OK to create the extrapolated surface.
The surface (identified as Extrapol.xxx) is added to the specification tree.
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Additional Parameters
●

Check the Constant distance optimization option to perform an extrapolation with a constant distance and create a surface without
deformation.
This option is not available when the Extend extrapolated edges option is checked.

Open the Extrapolate4.CATPart document.
1.
2.
3.
4.

Select Boundary.1 as the Boundary and Surface.1 as the surface to be Extrapolated.
Set a Length of 10mm.
Check the Constant distance optimization option.
Click OK to create the extrapolated surface.

Constant distance optimization option checked

●

Constant distance optimization option unchecked

The Internal Edges option enables to determine a privileged direction for the extrapolation. You can select one or more edges (in the following
example we selected the edge of Surface.1) that will be extrapolated in tangency. You can also select a vertex once you have selected an edge in
order to give an orientation to the extrapolation.
●

You can only select edges in contact with the boundary.

●

This option is not available with the Curvature continuity type and with the Wireframe and Surface product.

One edge selected

Two edges selected

●

Check the Assemble result option if you want the extrapolated surface to be assembled to the support surface.

●

Check the Extend extrapolated edges to reconnect the features based on elements of the extrapolated surface.
This option is especially useful if you work within an ordered geometrical set environment.
Open the Extrapolate3.CATPart document.
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1. Set Extrude.1 as the current object.
2. Select the boundary of Extrude.1 and Extrapol.1 as the surface to be extrapolated.
Extrude.3 is automatically rerouted, as well as all edges based on Extrude.1.
❍

❍

This option is only available when both Continuity and Extremity types are specified as Tangent, and when the Assemble result
option is checked.
It is not available when the Constant distance optimization option is checked.
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Slicing curves
This task will show you how to slice curves or edges.
(The color of the curves have been changed to several shades of blue in the picture below).
The clean contour action sets the chaining order of the curves to create a contour.
In some cases (especially with long curves) the chaining may lead to an unexpected result.
You may need to slice curves or edges in order to solve this chaining incompatibility.
●
original curves: clean contour impossible

●

sliced curves
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clean contour

The Curves Slice action cuts curves or edges in several pieces, according to a pseudo-intersection:
there is a pseudo-intersection between two curves if they intersect each other in the view direction
(but not really), and if the mini 3D distance between them at this cutting point is lower than the
parameter Max. Distance.
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●

Pseudo-intersection of two curves in the view direction

●

in another view.

Open the Slice1.CATPart from the samples directory.
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1. Activate the Geometrical set using the Define in Work Object contextual menu.
2. Click the Curves Slice icon

. The Curves Slice dialog box is displayed.

3. Select the curves or the edges to slice.
The list of the selected curves or edges is displayed in the Selected curves field.
You can remove an element from this list by selecting it again.
You can then resume the selection of the elements.

4. Click Apply. The resulting segments and the cutting point on each curve are pre-visualized.
Curves overlaps are detected automatically and displayed in magenta:
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There is no information message, no distance label, only a yellow square:
the curves do intersect each other.

A message may inform you that the curves or edges do not "pseudo-intersect"
each other with respect to the Max distance parameter.
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These curves do not intersect each other, whatever the Max distance parameter.
There is no solution.

The curves will intersect each other if you set the Max distance parameter to
a value higher than that indicated in the message.

5. Click More >> to display the Max distance parameter: Its default value is 1mm.
Max distance is the minimum orthogonal distance between two curves above which
one considers the two curves do not "pseudo-intersect" each other.
Increase this value according to your needs and click Apply.

6. By default, the Distances at nodes are not displayed.
When this option is checked, the Distances at nodes
(i.e. the mini 3D distances between the two curves of a pseudo-intersection)
are displayed in yellow with the exception of the largest one that is displayed in black.
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Double-click on this black label to update automatically the value of Max distance
in the dialog box, with a slightly higher value.

7. Very tiny segments may be created.
To avoid it, check the Filtering box (former Min Length), and set the Filtering value
(i.e. the minimum length of the segments created) value according to your needs.
8. Click OK to validate the result. The input curves are sent to the NoShow,
A new body Slice.x is created in the specification tree, under the current working body,
containing the segments created.
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Adjust Nodes
It is difficult to re-create surfaces from a network of curves and
to make sure that they are perfectly continuous.
This task shows how to improve a node of the network to this purpose:
●

●

the action modifies a set of curves arriving at a same node so that they have the same extremity
(G0 continuity) and the same tangent plane at this node (G1 continuity).
this ensures that all surfaces built on each mesh arriving at this node are continuous in tangency.

The curves may be simple curves, 3D curves, face edges...
Curves are deformed :
●

●

to be made G0 continuous (passage continuity) in all cases,
to be made G1 continuous (tangency continuity) according to your needs
(for example, you do not want to apply a tangency continuity constraint on a sharp edge).

It is also possible to make two curves tangent to each other.
Only the curves constrained to the tangent plane are made tangent to each other.
The curves set to Continuous only cannot be made tangent.
The G0 continuity can be tuned up using the Maximum deviation parameter
i.e. the maximum distance between the input curve and the deformed curve.
The G1 continuity can be tuned up using the Max Angle G1 parameter,
below which curves are made tangent to each other.
●
This action complies now with a feature-based approach.
●

The result of Adjust Node feature is a multi-domain curve.

Since the result of Adjust Node feature is a multi-domain curve,
the deletion of one of its input curves may result in an update error for features
that use the adjusted node as input.

Quick Surface Reconstruction
●

●

●

●
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Therefore standard selection tools, including the user selection filter and the geometrical element
filter,
can be used.
For further information, please refer to Selecting Using a Filter in the Infrastructure User's Guide.
After the creation of the result Adjust Node, all input curves are sent to the NoShow.
It is possible to create datum curves (instead of the feature) by activating Create Datum in the "Tools"
bar.
Multi-domain and multi-edges elements are not accepted as input.
If you select such an element, the following messages are displayed requesting you
to select each sub-element separately by activating the Geometrical Element Filter of the User
Selection Filter.

Open the AdjustNode01.CATPart from the samples directory.

1. Define an In Work Object.
2. Click the Adjust nodes icon

. The Adjust Node dialog box is displayed.

By default, Max Angle G1 and Global deformation are checked.
Their status and that of Max deviation are modal
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3. Select the curves to adjust. They are listed in the Selected Curves field.
You can deselect a curve by picking it, or select another curve.
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By default, the curves are "Continuous and tangent"
Click of the label of a curve, or right-click to launch its contextual menu,
to change its status.

The available statuses are:
❍

Continuous and tangent: the deformed curves are G0 continuous and
tangent to the computed tangency plane.

❍

Continuous: the deformed curves are only G0 continuous.

❍

Fixed: the curves are not deformed. In particular, face edges are fixed and remain fixed.

4. Click Apply. The deformations are computed:

❍

The curves selected are highlighted,

❍

The curves modified are displayed in green,

❍

If there are tangency constraints, the tangency plane is displayed in white,

❍

Its vector are displayed in pink,

The maximum deviation is also displayed on the most deformed curve,
not necessarily on that deformation spot.
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The curves are deformed to reach the required continuity.
By default, the Global deformation option distributes the deformation more evenly on the whole
curves.
The degree and the structure of the curves are kept.
Clear this option for a local deformation, meaning the curves are deformed at their extremities.
The result may not be satisfactory. In that case, you can:
❍

Check the Max deviation option and enter the value of the maximum allowed deviation.
At the Apply, the deformation of the curves is computed and displayed.
If the deformation is greater than the requested tolerance, no adjusted node can be created.
You have to modify this tolerance.

❍

Make sure the Max Angle G1 option is checked to force a tangency constraint on the curve
endpoints when the angle of the tangents at those ends is lower than the Max Angle G1
value.
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5. Click OK to validate the action. The Multi-Result Management dialog box is displayed.
Select the option you require and click OK.

6. Click OK to validate.
An Adjusted.Node.X feature is created in the specification tree, the input curves are hidden.
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In Datum mode, x new curves are created while the x input curves are hidden.
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●

This action processes one node at a time.

●

There must be more than one curve to adjust.

●

Several non continuous fixed curves may lead to inconsistencies.

●

If some curves are deformed too far apart with respect to the tolerance,
the adjustment cannot be computed and an error message is displayed.
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Splitting CleanContours
This task will show you how to split a closed CleanContour by a curve.
The output is two open CleanContours.
This may be necessary to create satisfying PowerFit surfaces:
when the surface created from a mesh and a CleanContour does not respect the accuracy requested,
plitting the CleanContour in two and creating two surfaces may be the solution.
Open the SplitCleanContour1.CATPart from the samples directory.

1. Click the CleanContour Split icon

. The Split CleanContour dialog box is displayed.

2. Select a CleanContour to split. The CleanContour must be closed.
You can select it either by one vertex or by selecting its components one by one.
3. Go to the Cutting elements field and pick No selection.
When it is highlighted in blue, select a or several cutting curves.
There must be two and only two pseudo-intersections between the cutting curve(s)
and the CleanContour.
4. The name of the curves of the CleanContour and
of the cutting curve(s) are displayed in the dialog box.
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The Split CleanContour action cuts a CleanContour into two CleanContours,
according to a pseudo-intersection:
there is a pseudo-intersection between two curves if they intersect each other in the view direction,
and if the mini 3D distance between them at this cutting point is lower than the parameter Max.
Distance.
5. Click Apply. The split is displayed.

6. Click OK. The two open CleanContours (joins) are created, the curve it trimmed accordingly.
A split.x element is created in the specification tree. It contains the two joins created.

Quick Surface Reconstruction
●

Version 5 Release 16

Page 228

You may want to select a join.
If this join contains a sliced surface edge, or a split CleanContour that contains a sliced surface edge,
with a tangency constraint that you want to keep, pick the curves one by one, graphically,
i.e. do not select a join by picking one vertex, nor select the elements in the specification tree.

Possible problems
If the input CleanContour is not closed, the gap is displayed and no computation is started.

A closed CleanContour as a cutting element may cause an ambiguity.
A message asks you which part of the cutting CleanContour you want to use.
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The Max distance parameter may be too low. Set a higher value and try again.

For example, the curve seems correct in the view direction,
but the 3D distance is higher than the set Max distance (in our example, 1mm).

Page 229

Quick Surface Reconstruction

Version 5 Release 16

The cutting curve is not suitable. Modify it and try again.

You may enter several curves as cutting elements, but they must be connex:
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It is not possible to split a CleanContour made of one element like this one
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Creating Edge Fillets
Edge fillets are useful to provide a transitional surface along a sharp internal edge of a surface.
This task shows how to create a constant radius fillet along the internal edge of a joined surface.
The fillet surface is obtained by rolling a sphere over the selected edge.
Open the EdgeFillet1.CATPart document.
1. Click the Edge Fillet icon

.

2. Select the edge to be filleted.
You can also select a face, provided there is no ambiguity as to the edge(s) to be filleted.

3. The Edge Fillet Definition dialog box appears.
4. Use the combo to select the desired type of extremity for the fillet:
❍

Straight: no tangency constraint is imposed at the connecting point between the fillet
and the initial support, generating sometimes a sharp angle.
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Smooth: a tangency constraint is imposed at the connection between the fillet surface
and the support surfaces, thus smoothing the connection

❍

Maximum: the fillet surface is limited by the longest selected edge

❍

Minimum: the fillet surface is limited by the shortest selected edge

5. Enter the value of the fillet Radius.
A preview of the fillet appears.

6. You can choose the Propagation type:
❍

Tangency: the fillet is propagated up to the first edge that is not continuous in tangency.

❍

Minimal: the fillet is propagated up to the first geometric limitation.

Use the More >> button to access further options: Edge(s) to keep and Limiting element and Blend
corner.
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7. Click OK to create the fillet surface.
The surface (identified as EdgeFillet.xxx) is added to the specification tree.

●

Check the Trim support elements option to relimit the support elements and assemble them to the
fillet.

Keeping Edges
You may also need to explicitly indicate edges that should not be filleted, if a radius is too large for
example.
In this case you cannot select boundary edges to be kept, but only internal edges, i.e. edges limiting two
faces.
1. Open the EdgeFillet2.CATPart document.

2. Proceed as above, but once you have selected the edge to be filleted,
click the More to expand the dialog box,
then click the Edge(s) to keep field and select the edge you wish to keep.
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This edge is displayed in pink, meaning that it will not be affected by the fillet operation.

If you have difficulties selecting the edge, use the up/down arrows to display the
preselection Navigator.
3. Then, click OK to create the fillet surface.

Limiting Fillets
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While creating the fillet, you can limit it by selecting an element (plane or surface)
that intersects it completely:
1. Once the edge to be filleted has been selected, and the radius keyed in,
click Preview then the More button.

2. Click in the Limiting element field, then select the trimming element.
These elements can be either surfaces, planes or points on edges.
An arrow indicates which portion of the fillet is to be retained.

❍

❍

It is now possible to use one or more limiting elements.
You can define a limiting element just by clicking a point on one of the selected edges to be
filleted.

3. Click on this arrow to inverse it, if needed, to retain the opposite side of the fillet.
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4. Click OK to create the limited fillet. In the illustration, the limiting surface has been hidden.

●

●

You can create limiting elements just by clicking on the edge to be filleted.
The application displays this element as a blue disk.

Make sure that the limiting element is not larger than the initial element, as illustrated here.
In this case, decrease the size of the limiting element as prompted by the warning message.
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Trimming Overlapping Fillets
In some cases, fillets may be overlapping.
The Trim ribbons option lets you solve this by trimming the fillets where they overlapping.
Open the EdgeFillet3.CATPart document.
1. Click the Edge Fillet icon

and, using the Ctrl key,

select the edges at the base of the cylinder and the one along the vertical surface.

2. Click Preview.
The two fillets clearly overlap.

3. In the Edge Fillet Definition dialog box, check the Trim ribbons option and click OK.
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Note that the Trim ribbons option is available with the Tangency propagation mode:
●

In Minimal mode, the Trim ribbons option is grayed, as it is implicitly active.
The results would be trimmed fillets, and no propagation:
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In Tangency mode, with the Trim ribbons option unchecked, the fillets intersect,
with no trimming, and the propagation is performed

In Tangency mode, with the Trim ribbons option checked, the fillets are trimmed
and the propagation is performed.

Reshaping corners:
Sometimes, while filleting, you can see that corners resulting from the operation are not satisfactory.
The new capability "Blend Corners" lets you quickly reshape these corners.

Version 5 Release 16

Quick Surface Reconstruction

Page 241

Open the BlendCorner1.CATPart document.

1. Click the Edge Fillet icon

and fillet the edges as shown using 5mm as the radius value.

2. Taking a closer look at the corner, you can notice that the edges need to be rounded again.

3. After launching the Edge Fillet dialog box to edit the fillet, click the More>> button to access
additional options.

4. Click the Blend corner(s) button to detect the corner to reshape. In our example, only one
corner is detected.
The application shows it in the geometry area (3D text).

Quick Surface Reconstruction
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When the application detects several corners, it is not possible to reshape just a few of them:
all of them will be edited.
The setback distance field determines for each edge a free area measured from the vertex along the
edge.
In this area, the system adds material so as to improve the corner shape.
5. Enter a value in the setback distance field. For example 13.

6. Click Preview to examine the result.

7. To edit the distance for the top edge, click "13" and enter "22" as the new value in the Setback
distance field.

8. Repeat the operation for the edge below using the same distance value
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9. Click OK to confirm the operation. The corner is reshaped.
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Transformations
This chapter deals with transformations in Quick Surface Reconstruction.
Performing a Symmetry on Geometry
Translating Geometry
Rotating Geometry
Transforming Geometry by Scaling
Transforming Geometry by Affinity
Transforming Elements From an Axis to Another
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Performing a Symmetry on Geometry
This functionality is P2 for FreeStyle Shaper, Optimizer, and Profiler.
This task shows you how to transform geometry by means of a symmetry operation.
Open the Transform1.CATPart document.

1. Click the Symmetry icon

.

The Symmetry Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by symmetry.
3. Select a point, line or plane as Reference element.
The figure below illustrates the resulting symmetry
when the line is used as reference element:

The figure below illustrates the resulting
symmetry when the point is used as
reference element:
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4. Click OK to create the symmetrical element.
The element (identified as Symmetry.xxx) is added to the specification tree.
❍

You can select an axis system as the Element to be transformed, providing it was
previously created.
The element is identified as Symmetry.xxx in the specification tree, however the
associated icon is the axis system's

❍

❍

❍

❍

.

Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Translating Geometry
This task shows you how to translate one, or more, point, line or surface element.
Open the Translate1.CATPart document.

1. Click the Translate icon

.

The Translate Definition dialog box appears as well as the Tools Palette.
2. Select the Element to be translated.
3. Select the Vector Definition.

Direction, distance
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4. Select a line to take its orientation as the translation direction or a plane to take its normal as the
translation direction.
You can also specify the direction by means of X, Y, Z vector components by using the contextual
menu on the Direction field.
5. Specify the translation Distance by entering a value or using the spinners.

Point to Point

Quick Surface Reconstruction

4. Select the Start point.
5. Select the End point.

Coordinates
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4. Define the X, Y, and Z coordinates.
In the example besides, we chose 50mm as X, 0mm as Y, and -100 as Z.
5. When the command is launched at creation, the initial value in the Axis System field is the
current local axis system. If no local axis system is current, the field is set to Default.
Whenever you select a local axis system, the translated element's coordinates are changed with
respect to the selected axis system so that the location of the translated element is not changed.
This is not the case with coordinates valuated by formulas: if you select an axis system, the
defined formula remains unchanged.
This option replaces the Coordinates in absolute axis-system option.

6. Click OK to create the translated element.
The element (identified as Translate.xxx) is added to the specification tree.
The original element is unchanged.

●

You can select an axis system as the Element to be translated,
providing it was previously created.
The element is identified as Translate.xxx in the specification
tree, however the associated icon is the axis system's

●

●

●

.

Use the Hide/Show initial element button to hide or show the
original element for the translation.
Choose whether you want the result of the transformation to be a
surface or a volume by switching to either Surface or Volume
option.
This capability is only available with the Generative Shape
Optimizer product.
This switch only concerns volumes since the transformation of a
surface can only be a surface. Thus in case of multi-selection of
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is grayed out
when editing the feature.
To have further information about volumes, refer to the
corresponding chapter.
Use the Repeat object after OK checkbox to create several
translated surfaces, each separated from the initial surface by a
multiple of the Distance value.
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Simply indicate in the Object Repetition dialog box the number of
instances that should be created and click OK.

●

●

●

●

If you select a solid as the input element, the result will either be
a surface or a volume.
The selection of the feature prevails over the selection of the subelement.
To select a sub-element, you need to apply the ''Geometrical
Element'' filter in the User Selection Filter toolbar.
For further information, refer to the Selecting using a Filter
chapter in the CATIA Infrastructure User's Guide.
You can edit the translated element's parameters. Refer to
Editing Parameters to find out how to display these parameters in
the 3D geometry.
The following capabilities are available: Stacking Commands and
Selecting Using Multi-Output.
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Rotating Geometry
This task shows you how to rotate geometry about an axis.
Open the Transform1.CATPart document.

1. Click the Rotate icon

.

The Rotate Definition dialog box appears as well as the Tools Palette.

2. Define the rotation type:
❍

❍

Axis-Angle (default mode): the rotation axis is defined by a linear element and the angle is
defined by a value that can be modified in the dialog box or in the 3D geometry (by using the
manipulators).
Axis-Two Elements: the rotation axis is defined by a linear element and the angle is defined
by two geometric elements (point, line or plane)
■

Axis/point/point: the angle between the vectors is defined by the selected points and their
orthogonal projection onto the rotation axis.
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Axis/point/line: the angle between the vector is defined by the selected point and its
orthogonal projection onto the rotation axis and the selected line.

■

Axis/point/plane: the angle between the vector is defined by the selected point and its
orthogonal projection onto the rotation axis and the normal to the selected plane.
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■
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Axis/line/line: the angle between the direction vectors of the projection is defined by the
two selected lines in the plane normal to the rotation axis.
In case both lines are parallel to the rotation axis, the angle is defined by the intersection
points of the plane normal to the rotation axis and these lines.

■

Axis/line/plane: the angle is defined between the selected line and the normal to the plane.

Quick Surface Reconstruction

■

❍
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Axis/plane/plane: the angle is defined between the normals to the two selected planes.

Three Points: the rotation is defined by three points.
■

The rotation axis is defined by the normal of the plane created by the three points passing
through the second point.

■

The rotation angle is defined by the two vectors created by the three points (between
vector Point2-Point1 and vector Point2-Point3):
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The orientation of the elements (lines or planes) is visualized in the 3D geometry by a red arrow.
You can click the arrow to invert the orientation and the angle is automatically recomputed. By
default, the arrow is displayed in the direction normal to the feature (line or plane).
For instance, in the plane/plane mode, the arrow is displayed on each plane:

3. Select the Element to be rotated.
4. Select the inputs depending on the chosen rotation type.
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5. Click OK to create the rotated element.
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The element (identified as Rotate.xxx) is added to the specification tree.

Optional Parameters
●

●

Use the Hide/Show initial element button to hide or show the original element for the translation.
Choose whether you want the result of the transformation to be a surface or a volume by switching to
either Surface or Volume option.
This capability is only available with Generative Shape Optimizer.
This switch only concerns volumes since the transformation of a surface can only be a surface. Thus in
case of multi-selection of volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.

●

Use the Repeat object after OK checkbox to create several rotated surfaces, each separated from
the initial surface by a multiple of the Angle value.
Simply indicate in the Object Repetition dialog box the number of instances that should be created and
click OK.

The Repeat object after OK capability is not available with the Axis-Two Elements and
Three Points rotation types.
●

You can select an axis system as the Element to be rotated, providing it was previously created.
The element is identified as Rotate.xxx in the specification tree, however the associated icon is the
axis system's

.

Quick Surface Reconstruction
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●

●

●
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If you select a solid as the input element, the result will either be a surface or a
volume.
Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the
User Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA
Infrastructure User's Guide.
You can edit the rotated element's parameters. Refer to Editing Parameters to find out
how to display these parameters in the 3D geometry.
The following capabilities are available: Stacking Commands, Selecting Using MultiOutput, Measure Between and Measure Item.

Version 5 Release 16

Quick Surface Reconstruction

Page 260

Transforming Geometry by Scaling
This task shows you how to transform geometry by means of a scaling operation.
Open the Transform1.CATPart document.

1. Click the Scaling icon

.

The Scaling Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by scaling.
3. Select the scaling Reference point, plane or planar surface.
4. Specify the scaling Ratio by entering a value or using the drag manipulator.
The figure below illustrates the
resulting scaled element when the
plane is used as reference element
(ratio = 2):

5. Click OK to create the scaled element.

The figure below illustrates the resulting scaled element
when the point is used as reference element (ratio = 2):
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The element (identified as Scaling.xxx) is added to the specification tree.
You can use the Repeat object after OK checkbox to create several scaled surfaces, each
separated from the initial surface by a multiple of the initial Ratio value.
Simply indicate in the Object Repetition dialog box the number of instances that should be created
and click OK.

❍

❍

❍

❍

Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Transforming Geometry by Affinity
This task shows you how to transform geometry by means of an affinity operation.
Open the Transform1.CATPart document.

1. Click the Affinity icon

.

The Affinity Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed by affinity.
3. Specify the characteristics of the Axis system to be used for the affinity operation:
❍

the Origin (Point.1 in the figures below)

❍

the XY plane (the XY plane in the figures below)

❍

the X axis (Line.1 in the figures below).

4. Specify the affinity Ratios by entering the desired X, Y, Z values.
The figure below illustrates the resulting affinity with ratios X = 2, Y =1 and Z=1.
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The figure below illustrates the resulting affinity with ratios X = 2, Y =1 and Z=2.

The figure below illustrates the resulting affinity with ratios X = 2, Y =2.5 and Z=2

5. Click OK to create the affinity element.
The element (identified as Affinity.xxx) is added to the specification tree.
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Use the Hide/Show initial element button to hide or show the original element for the
translation.
Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This capability is only available with the Generative Shape Optimizer product.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
To have further information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using MultiOutput.
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Transforming Elements
From an Axis to Another
This task shows you how to transform geometry positioned according to a given axis system into a new
axis system. The geometry is duplicated and positioned according to the new axis system. One or more
elements can be transformed at a time, using the standard multi-selection capabilities.
See also Defining an Axis System.
Open the Transform2.CATPart document.

1. Click the Axis To Axis icon

.

The Axis to Axis Definition dialog box appears as well as the Tools Palette.

2. Select the Element to be transformed into a new axis system.

3. Select the initial (Reference) axis system, that is the current one.
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4. Select the Target axis system, that is the one into the element should be positioned.

5. Click OK to create the transformed element.
The new geometry is now positioned into the new axis system.
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The element (identified as Axis to axis transformation.xxx) is added to the specification tree.
❍

❍

Use the Hide/Show initial element button to hide or show the original element for the
translation.
You can select an axis system as the Element to be transformed, providing it was
previously created.
The element is identified as Axis to axis transformation.xxx in the specification tree,
however the associated icon is the axis system's

❍

❍

❍

.

Choose whether you want the result of the transformation to be a surface or a volume by
switching to either Surface or Volume option.
This switch only concerns volumes since the transformation of a surface can only be a
surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect
volumes.
Note that the switch between surface and volume is grayed out when editing the feature.
This capability is only available with Generative Shape Optimizer. To have further
information about volumes, refer to the corresponding chapter.
If you select a solid as the input element, the result will either be a surface or a volume.
The selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA
Infrastructure User's Guide.

The following capabilities are also available: Stacking Commands and Selecting Using MultiOutput.
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Segmentation
This chapter deals with segmentation in Quick Surface Reconstruction.
Segmentation by Curvature Criterion
Segmentation by Slope Criterion
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Segmentation by Curvature Criterion
This task will show you how to define areas on a mesh along the curvatures or curvature radii.
There are five curvatures:
●

Maximum,

●

Minimum,

●

Mean,

●

Gaussian,

●

Absolute.

The geometric construction of the maximum and minimum curvatures is the following:
let be a plane containing the normal to the surface in a given point.
This plane cuts the surface along a curve that has a given curvature in this point.
If this plane rotates around the normal, the curvatures of the curves intersecting
the surface will vary between two utmost values.
These two values are the maximum (KM) and the minimum (Km) curvatures.
The mean curvature is equal to (KM+Km)/2.
The utmost values appear where the surface is the most warped.
The mean curvature is largely used to detect irregularities on the surface.
A minimal surface is characterized by a null mean curvature.
The gaussian curvature is equal to KM.Km.
It describes the local shape of a surface in one point:
●

●

●

if it is positive, the point is elliptic,
i.e. the surface has locally the shape of an ellipsoid around that point,
if it is negative, the surface is hyperbolic in this points,
i.e. the local shape is a horse saddle,
it it is null, the surface is parabolic in this point,
i.e. one of the maximum or minimum curvatures is null in this point.
The cone and the cylinder are two surfaces where all points are parabolic.

The absolute curvature is equal to |KM|+|Km|.
It is used to detect the surface areas where the surface is locally almost flat
(the absolute curvature is almost null).
The curvature radii are the inverse of the corresponding curvatures.
Only the maximum and the minimum radii are relevant.
It is carried out on meshes only.
Noisy digitized data are difficult to process.
Open the Curvature01.CATPart from the samples directory.
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1. Click the Segmentation by Curvature Criterion icon.
The Curvature Analysis dialog box is displayed.
2. Select the mesh to analyze.

3. Select the type of analysis from the combo box: Curvature or Radius.
Sweep the mesh with the cursor:
The value of the curvature or the radius is displayed dynamically as you move the cursor:

This is especially helpful to retrieve the value of fillets.
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4. Click the mesh: scans are displayed: combine the types of analysis and
the value in the top spinner box to display scans according to your needs:

5. Use the Filter cursor to remove unwanted points.

6. Click OK to create the result. You can choose to create:
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Scans, either distinct or grouped:

Scans.x elements are created in the specification tree.

❍

or Clouds, that is sub-meshs:

SubMesh.x elements are created in the specification tree.
These meshs can then be processed with the Basic Surface Recognition action, for example.
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Segmentation by Slope Criterion
This task shows you how to perform a slope analysis.
This type of analysis identifies lines on the analyzed element where the deviation
from the slope direction at any points corresponds to a specified value.
The Z axis gives the view direction.
If the deviation angle=0, the lines are the zones of the analyzed element where the normal is orthogonal
to the view direction (apparent contour).
If the deviation angle is different from 0, the lines are the zones where the normal is orthogonal
to the view direction increased by the angle.
Noisy digitized data are difficult to process.
Open the Slope1.CATPart from the samples directory.

1. Click the Segmentation by Slope Criterion icon

and select the mesh.

2. The Segmentation by Slope Criterion dialog box is displayed.
The compass is put on the mesh. By default, the angle is set to 0.

3. Use the Values/Angle field to set the angle of the deviation with the view direction.
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4. Use the Compass/Angle field and the Compass push buttons to set the view direction.
Or manipulate the compass as you wish.
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5. Use the Filter spinner to reduce the number of points of the lines.
6. If you sweep the cursor on the mesh, the deviation angle is displayed.
7. Click OK to create the result. You can choose to create:

❍

Scans, either distinct or grouped:

Scans.x elements are created in the specification tree.
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or Clouds, that is sub-meshs:

Sub Mesh.x elements are created in the specification tree.
These meshs can then be processed with the Basic Surface Recognition action, for
example.
The input mesh is sent to the NoShow.
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Analysis
This chapter deals with analyses in Quick Surface Reconstruction.
Information
Analyzing Distances Between Two Sets of Elements
Performing a Curvature Analysis
Checking Connections Between Surfaces
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Information
This task shows you how to get information on a cloud of points.
Open Info1.CATPart from the samples directory.

1. Click the Information icon

and select a cloud of points.

2. An information box is displayed, with the statistics about the selected cloud:
❍

Bounding box ,and active bounding box,

❍

Number of points, of active points, of selected points, of filtered points,

❍

Total number of triangles and of active triangles.

3. If you select another cloud, the information box is updated with the statistics of that cloud.
4. Push the Close button when you are finished to exit the action.
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Analyzing Distances Between Two Sets of
Elements
This task shows how to analyze the distance between any two geometric elements, or between two sets of
elements.
Open the FreeStyle_11.CATPart document.

1. Select Curve.1.

2. Click the Distance Analysis icon:

The Distance dialog box appears: the Second set state is selected.

3. Select Surface.1.

The distance analysis is computed. Each color identifies all discretization points located at a
distance between two values, as defined in the Color Scale dialog box.

Quick Surface Reconstruction
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When computing the distance between two curves, there is no negative values possible as
opposed to when analyzing the distance between a surface and another element. Indeed,
surfaces present an orientation in all three space directions whereas, in the case of planar
curves for example, only two directions are defined. Therefore the distance is always
expressed with a positive value when analyzing the distance between two curves.
The element which dimension is the smallest (0 for points,1 for curves, 2 for surfaces for
example) is automatically discretized, if needed.
When selecting a set of element, the system compares the greatest dimension of all elements
in each set, and discretizes the one with the smallest dimension.
Use the Invert Analysis button to invert the computation direction. In some cases, when
inverting the computation direction does not make sense, when one of the elements is a plane
for example, the Invert Analysis button is grayed.
If you check the Running point option, you need to move the pointer over the discretized
element to display more precise distance value between the point below the pointer and the
other set of elements.
The projection is visualized and the value is displayed in the geometry area. Note that the
analyzed point is not necessarily a discretized point in this case. This is obvious when a low
discretization value is set, as shown here.

Two analysis modes are available, with corresponding color ramps, provided the Color scale
checkbox is checked.
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a. Full (P2 only): activated by the Full color range

Page 282

icon, it provides a complete analysis

based on the chosen color range. This allows you to see exactly how the evolution of the distance
is performed on the selected element.

b. Limited: activated by the Limited color range
three values and four colors.

, it provides a simplified analysis, with only
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Whichever mode you choose the use of the color scale is identical: it lets you define colors in
relation to distance values.
You can define each of the values and color blocks, therefore attributing a color to all elements
which distance falls into to given values.
●

●

The Auto Min Max button enables to automatically update the minimum and maximum values
(and consequently all values between) each time they are modified.
You can right-click on a color in the color scale to display the contextual menu:

❍

❍

❍

●

Edit: it allows you to modify the values in the color range to highlight specific areas of the
selected surface. The Color dialog box is displayed allowing the user to modify the color
range.

Unfreeze: it allows you to perform a linear interpolation between non defined colors.
The unfreezed values are no longer highlighted in green.
No Color: it can be used to simplify the analysis, because it limits the number of displayed
colors in the color scale. In this case, the selected color is hidden, and the section of the
analysis on which that color was applied takes on the neighboring color.

You can also right-click on the value to display the contextual menu:

Quick Surface Reconstruction

❍

❍

Version 5 Release 16

Page 284

Edit: it allows you to modify the edition values. The Value Edition dialog box is displayed:
enter a new value (negative values are allowed) to redefine the color scale, or use the
slider to position the distance value within the allowed range, and click OK.
The value is then frozen, and displayed in a green rectangle.

Use Max/Use Min : it allows you to evenly distribute the color/value interpolation between
the current limit values, on the top/bottom values respectively, rather than keeping it
within default values that may not correspond to the scale of the geometry being analyzed.
Therefore, these limit values are set at a given time, and when the geometry is modified
after setting them, these limit values are not dynamically updated.
The Use Max contextual item is only possible if the maximum value is higher or equal to
the medium value. If not, you first need to unfreeze the medium value.

Only the linear interpolation is allowed, meaning that between two set (or frozen) colors/values,
the distribution is done progressively and evenly.
The color scale settings (colors and values) are saved when exiting the command, meaning the
same values will be set next time you edit a given distance analysis capability.
However, new settings are available with each new distance analysis.
4. Set the distance analysis type (we checked the Auto Scale button and unchecked the Min/Max
values button):

Projection Space

The Projection Space area helps you define the preprocessing of the input elements used for the
computation.
This frame is only available when analyzing distances between curves.

Quick Surface Reconstruction
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3D
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: elements are not modified and the computation is done between the initial elements.

Projection according to the X
,Y
the projection of selected elements.

, or Z

axis: the computation is done between

Projection according to the compass current orientation
between the projection of selected elements.

: the computation is done

Planar distance
: the distance is computed between a curve and the intersection of the
plane containing that curve.

Measurement Direction

The Measurement Direction area provides options to define how set the direction used for the
distance computation.

●
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Normal distance
elements.

: the distance is computed according to the normal to the other set of

●

Direction according to the X

●

Direction according to the compass current orientation

5. Click the

,Y

, or Z

axis.
.

icon to display the 2D diagram distance analysis window. The latter allows to

visualize the distance evolution.
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Drawing modes:

●

●

Vertical Inverse Scale
vertical scale.
Reframe

: to draw the curves in a linear horizontal scale and and inverse

: to reframe the frame.

6. Click More>> in the Distance dialog box to see, and choose further display and discretization
options:
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●

Color scale: to display the Color Scale dialog box whether the full or the limited color range.

●

Statistical distribution: to display the percentage of points between two values.

This option is only available if the Color Scale checkbox is checked.

●

Min/Max values: to display the minimum and maximum distance values and locations on the
geometry.
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Points: to see the distance analysis in the shape of points only on the geometry (The Spikes
button is unchecked).

Spikes: to see the distance analysis in the shape of spikes on the geometry.
You can further choose to:
❍

set a ratio for the spike size

❍

choose an automatic optimized spike size (Auto scale)

❍

invert the spike visualization on the geometry

❍

display the envelope, that is the curve connecting all spikes together

Use the Texture option to check the analysis using color distribution.

Quick Surface Reconstruction
●

●

●

●
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This option is only available with surface elements in at least one set, providing this set is
discretized.
The distance is computed from this discretized set to the other set. The texture mapping is
computed on the discretized surface.
It is not advised to use it with planar surfaces or ruled surfaces.
Statistical distribution, Min/Max values, and Points cannot be visualized when using the
Texture option.
The visualization mode should be set to Shading with Texture and Edges, and the
discretization option should be set to a maximum (in Infrastructure User's Guide, see
Improving Performances, the 3D Accuracy -> Fixed option should be set to 0.01).
Check the Material visualization option in the View -> Render Style -> Customize View
command to be able to see the analysis results on the selected element. Otherwise a warning
is issued.

Use the Curve Limits option to relimit the discretized curve.
Two manipulators appear at both extremities of the curve: they let you define new start and
end points on the curve.

Start and end points are defined by a ratio of curve length between 0 and 1. If you extend the
curve for instance, this ratio is kept.

●

Use the Max Distance option to relimit the distance: for example, set the value to 150mm.
The maximum value is displayed accordingly on the geometry.
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Use the Discretization option to reduce or increase the number of points of the second set of
elements taken into account when computing the distance.
Automatic trap: to delimit the second set of points to be taken into account for the
computation, in the case of a large cloud of points, thus improving the performances.
Be careful when using the Automatic trap option with certain cloud configurations, such as
spiralling clouds of points for example, as the automatic trap may remove too many points to
generate consistent results.
In this case, it is best to deactivate the check button.

7. Click OK to exit the analysis while retaining it.

The analysis (identified as Distance Analysis.x) is added to the specification tree.
●

●

●

Even though you exit the analysis, the color scale is retained till you explicitly close is. This is
like a shortcut allowing you to modify one of the analyzed elements, which leads to a dynamic
update of the distance analysis, while viewing the set values/colors at all times and without
having to edit the distance analysis.
When analyzing clouds of points, in normal projection type, the distances are computed as the
normal projection of each point of the first cloud onto the triangle made by the three points
closest to that projection onto the second cloud.
As it is a projection, using the Invert Analysis button does not necessarily gives symmetrical
results.
When you select the geometrical set as an input in the specification tree, all the elements
included in this geometrical set are automatically selected too.

The auto detection capability is available from the Dashboard.
You can calculate the minimum distance between two curves along a direction using the
Knowledge Expert product.
For further information, refer to the Knowledge Expert's User's Guide, Reference, Functions
Package, Measures chapter.
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Performing a Curvature Analysis
This task shows how to analyze the curvature of curves, or surface boundaries.

Open the FreeStyle_10.CATPart document.
When analyzing surface boundaries:
●

●

if you select the surface, the analysis is performed on all its boundaries

if you select a specific boundary, the analysis is performed only on this boundary.
Make sure the Geometrical Element Filter selection mode is active from the User Selection Filter toolbar.
This mode lets you select sub- elements.

1. Click the Porcupine Curvature Analysis icon:

2. Select the curve.

Automatically the curvature comb is displayed on the selected curve:
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3. Define the analysis parameters in the Curvature Analysis dialog box.

●

●

Use the Project on Plane checkbox to analyze the projected curve in the selected plane referenced
by the compass.
If you uncheck the Project On Plane option, the analysis is performed according to the curve
orientation. This is the default option.

4. Use the spinners to adjust the number of strikes and modify the density.

5. You can also decide to halve the number of spikes in the comb clicking as many times as wished the /2
button.
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This option is particularly useful when the geometry is too dense to be read but the resulting curve may
not be smooth enough for your analysis needs.
You could just as well double the number of spikes using the X2 button.

6. Similarly, click the /2 button to fine-tune the amplitude (size) of the spikes, and re-compute the analysis
curve accordingly.

7. Click Curvilinear to switch from the Parametric discretization mode to the Curvilinear analysis. You will
get something like this:
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8. Check the Automatic option optimizes the spikes length so that even when zooming in or out, the spikes
are always visible.

9. Check the Logarithm option to display the logarithmic values in the 3D geometry.

Displaying these values does not modify the analysis.

10. Click Reverse, you will get something like this:
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That is the analysis opposite to what was initially displayed. This is useful when from the current
viewpoint, you do not know how the curve is oriented.

11. Use the Particular checkbox to display at anytime the minimum and the maximum points.

Inflection points are displayed only if the Project on Plane and Particular checkboxes are checked.

12. The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in
Curvature, if Radius option is selected.
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You can right-click on any of the spikes and select Keep this Point to keep the current point at this
location.
A Point.xxx appears in the specification tree.
If you check the Particular option, you have more options:

●

Keep all inflection points

●

Keep local minimum (corresponds to the absolute minimum under the running point)

●

Keep local maximum (corresponds to the absolute maximum under running point)

●

●

Keep global minimum (in case there are two curves, the point will be found on one or other of the
curves)
Keep global maximum (in case there are two curves, the point will be found on one or other of the
curves)

13. Finally, click the

icon to display the curvature graph:

The curvature profile and amplitude of the analyzed curve is represented in this diagram.
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When analyzing a surface or several curves, i.e. when there are several curvature analyses on elements
that are not necessarily of the same size for example, you can use different options to view the analyses.
For example, when analyzing a surface, by default you obtain this diagram, where the curves color match
the ones on the geometry.

●

Same vertical length

: all curves are displayed according to the same vertical length, regardless

of the scale:

●

Same origin
scale:

: all curves are displayed according to a common origin point on the Amplitude
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Vertical logarithm scale
: all curves are displayed according to a logarithm scale for the
Amplitude, and a linear scale for the Curve parameter:

Depending on the chosen option, values displayed in the diagram are updated.
The last icon

is used to reframe the diagram within the window, as you may move and zoom it within

the window.
14. Right-click a curve and choose one of the following options from the contextual menu:
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●

Remove: removes the curve

●

Drop marker: adds Points.xxx in the specification tree

●
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Change color: displays the Color selector dialog box that enables you to change the color of the
curve.

15. Slide the pointer over the diagram to display the amplitude at a given point of the curve.
You can slide the pointer over the diagram and the 3D analysis.
Click the x in the top right corner to close the diagram.

16. Click OK in the Curvature Analysis dialog box once you are satisfied with the performed analysis.

The analysis (identified as Curvature Analysis.x) is added to the specification tree.
In case of clipping, you may want to temporarily modify the Depth Effects' Far and Near Limits. See
Setting Depth Effects in Infrastructure User Guide.
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Checking Connections Between Surfaces

This task shows how to analyze how two surfaces are connected, following a blend, match, or fill
operation for example.
Three types of analyses are available:
❍

❍

❍

Distance: the values are expressed in millimeters.
When the minimal distance between two vertices is inferior to 1 micron, the vertices are merged
and the surface is considered as continuous in point.
Tangency: the values are expressed in degrees
When the angle between two surfaces is inferior to 0.5 degree, the surface is considered as
continuous in tangency.
Curvature: the values are expressed in percentage.

Open the FreeStyle_08.CATPart document.

1. Select both surfaces to be analyzed.

2. Click the Connect Checker icon:

The Connect Checker dialog box is displayed as well as another dialog box showing the color
scale and identifying the maximum and minimum values for the analysis type.
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The Auto Min Max button enables to automatically update the minimum and maximum values
(and consequently all values between) each time they are modified.
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Check the Internal edges option if you want to analyze the internal connections.
By default, the check box is unchecked.
Two cases are available:
●

●

Surfaces are isolated.
Only geometrical connections are checked, that is all pairs of neighboring surface edges
within the tolerance given by the Maximum gap.
Depending on the Maximum gap value, interference connections may be detected, for
instance when surfaces have a size smaller the Maximum gap. In this case, you must
decrease the Maximum gap value or join the surfaces to be analyzed (see next point)
Surfaces are joined (using the Join command for instance) and the Internal edges option is
checked.
Topological connections are checked first, that is all edges shared by two topological
surfaces. Then, the corresponding pairs of surface edges are checked to detect any
geometrical connections within the tolerance given by the Maximum gap.

3. Choose the analysis type to be performed: Distance, Tangency or Curvature.

4. Set the Maximum gap above which no analysis will be performed. All elements apart from a
greater value than specified in this field are considered as not being connected, therefore do
not need to be analyzed.
Be careful not to set a Maximum gap greater than the size of the smallest surface present in
the document.

In the color scale, the Auto Min Max button enables to automatically update the minimum
and maximum values (and consequently all values between) each time they are modified.
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You can right-click on a color in the color scale to display the contextual menu:

❍

Edit: it allows you to modify the values in the color range to highlight specific areas of
the selected surface. The Color dialog box is displayed allowing the user to modify the
color range.
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Unfreeze: it allows you to perform a linear interpolation between non defined colors.
The unfreezed values are no longer highlighted in green.
No Color: it can be used to simplify the analysis, because it limits the number of
displayed colors in the color scale. In this case, the selected color is hidden, and the
section of the analysis on which that color was applied takes on the neighboring color.

You can also right-click on the value to display the contextual menu:

❍

❍

Edit: it allows you to modify the edition values. The Value Edition dialog box is
displayed: enter a new value (negative values are allowed) to redefine the color scale,
or use the slider to position the distance value within the allowed range, and click OK.
The value is then frozen, and displayed in a green rectangle.

Use Max/Use Min : it allows you to evenly distribute the color/value interpolation
between the current limit values, on the top/bottom values respectively, rather than
keeping it within default values that may not correspond to the scale of the geometry
being analyzed. Therefore, these limit values are set at a given time, and when the
geometry is modified after setting them, these limit values are not dynamically
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updated.
The Use Max contextual item is only possible if the maximum value is higher or equal
to the medium value. If not, you first need to unfreeze the medium value. Only the
linear interpolation is allowed, meaning that between two set (or frozen) colors/values,
the distribution is done progressively and evenly.
The color scale settings (colors and values) are saved when exiting the command, meaning the
same values will be set next time you edit a given draft analysis capability.
However, new settings are available with each new draft analysis.
5. Check the analysis results on the geometry.

Here we are analyzing the distance between the surfaces. Each color section indicates on the
geometry the distance between the surfaces.

There may be a tangency discontinuity while a curvature continuity exists. This may appear for
instance in the case of two non tangent planar surfaces.
From the Connect Checker dialog box, you can choose a number of visualization and
computation options:
●

the comb: that is the spikes corresponding to the distance in each point

●

the envelope: that is the curve connecting all spikes together

●

Information: that is the minimum and maximum values displayed in the 3D geometry

Finally, the scaling option lets you define the visualization of the comb. In automatic mode the
comb size is zoom-independent and always visible on the screen, otherwise you can define a
coefficient multiplying the comb exact value.
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6. Check the Information button:

Two texts are displayed on the geometry localizing the minimum and maximum values of the
analysis as given in the Connect Checker dialog box.

You can also choose the discretization, that is the numbers of spikes in the comb (check the
Comb option to see the difference).
The number of spikes corresponds to the number of points used for the computation:
●

Light: 5 spikes are displayed.
This mode enables to obtain consistent results with the visualization of sharp edges.
An edge is considered as sharp if its tangency deviation is higher than 0.5 degree. To only
detect tangency deviations on sharp edges, specify a deviation of 0.5 degree minimum.
To visualize sharp edges, make sure the View -> Render Style -> Shading with Edges
and Hidden Edges option is checked.

●

Coarse: 15 spikes are displayed

●

Medium: 30 spikes are displayed

●

Fine: 45 spikes are displayed
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The Full result is only available with the Generative Shape Design 2 product.
The number of selected elements and the number of detected connections are displayed below
the color range.
7. Click the Quick... button to obtain a simplified analysis taking into account tolerances.

The comb is no longer displayed.
The Connect Checker dialog box changes to this dialog box.
The Maximum gap and information are retained from the full analysis.
The maximum deviation value is also displayed on the geometry.
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You can use the check button to select one or several analyses (up to three). As a
consequence, the colorful area displaying the deviation tolerance between the surfaces shows
the continuity whose value is the lowest.
In the case you select several types of continuity, the Information button is grayed out.

●

●

You can check the Overlapping button to highlight where, on the common boundary, the
two surfaces overlap. In this case the other analysis types are deactivated.
You can check the Information button to display the minimum and maximum values in
the 3D geometry, or uncheck it to hide the values.

In P1 mode, only the quick analysis is available.

8. Use the spinners to define the deviation tolerances.

For example, the red area indicates all points that are distant of more than 0.1 mm.
The maximum deviation values on the current geometry are displayed to the right of the dialog
box.

9. Click OK to create the analysis.
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The analysis (identified as Surface Connection Analysis.x) is added to the specification tree (P2
only).
This allows the automatic update of the analysis when you modify any of the surfaces, using
the control points for example.
If you do not wish to create the analysis, simply click Cancel.
●

●

●

●

You can edit the color range in both dialog boxes by double-clicking the color range
manipulators (Connect Checker) or color areas (Quick Violation Analysis) to display the
Color chooser.
If you wish to edit the Connection Analysis, simply double-click it from the specification
tree.
If you no longer need the Connection Analysis, right-click Connection Analysis in the
specification tree, and choose Delete.
The curvature difference is calculated with the following formula: (|C2 - C1|) / ((|C1 +
C2|) / 2)
The result of this formula is between 0% et 200%.

In the case of a curvature analysis type, the result is not guaranteed if a tangency
discontinuity exists.
●

●

You can analyze internal edges of a surface element, such as a Join for example, by
selecting only one of the initial elements:

You can create an analysis on an entire geometrical set simply by selecting it in the
specification tree.

Quick Surface Reconstruction
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Creating Points
This task shows the various methods for creating points:
●
by coordinates
●

on a curve

●

on a plane

●

on a surface

●

at a circle/sphere center

●

tangent point on a curve

●

between

Open the Points3D1.CATPart document.

1. Click the Point icon

.

The Point Definition dialog box appears.
2. Use the combo to choose the desired point type.

A new lock button

is available besides the Point type to prevent an automatic change of the type

while selecting the geometry. Simply click it so that the lock turns red
.
For instance, if you choose the Coordinates type, you are not able to select a curve. May you want to
select a curve, choose another type in the combo list.

Coordinates

Quick Surface Reconstruction
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●

Enter the X, Y, Z coordinates in the current axis-system.

●

Optionally, select a Reference Point.
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The corresponding point is displayed.
●

When the command is launched at creation, the initial value in the Axis System field is the current
local axis system. If no local axis system is current, the field is set to Default.
Whenever you select a local axis system, the point's coordinates are changed with respect to the
selected axis system so that the location of the point is not changed. This is not the case with points
valuated by formulas: if you select an axis system, the defined formula remains unchanged.
This option replaces the Coordinates in absolute axis-system option.
If you create a point using the coordinates method and an axis system is already defined and
set as current, the point's coordinates are defined according to current the axis system. As a
consequence, the point's coordinates are not displayed in the specification tree.
The current local axis system must be different from the absolute axis.

On curve

Quick Surface Reconstruction
●

●

●
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Select a curve.
Optionally, select a reference point.
If this point is not on the curve, it is projected onto the curve.
If no point is selected, the curve's extremity is used as reference.
Select an option point to determine whether the new point is to be created:
❍
at a given distance along the curve from the reference point
❍

●

Version 5 Release 16

a given ratio between the reference point and the curve's extremity.

Enter the distance or ratio value.
If a distance is specified, it can be:
❍
a geodesic distance: the distance is measured along the curve
❍

an Euclidean distance: the distance is measured in relation to the reference point (absolute value).
The corresponding point is displayed.

It is not possible to create a point with an euclidean distance if the distance or the ratio
value is defined outside the curve.
You can also:
■
click the Nearest extremity button to display the point at the nearest extremity of the curve.
■

click the Middle Point button to display the mid-point of the curve.
Be careful that the arrow is orientated towards the inside of the curve (providing the curve is
not closed) when using the Middle Point option.

●

use the Reverse Direction button to display:
❍
the point on the other side of the reference point (if a point was selected originally)
❍

●

the point from the other extremity (if no point was selected originally).

click the Repeat object after OK if you wish to create equidistant points on the curve, using the
currently created point as the reference, as described in Creating Multiple Points and Planes in the
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Wireframe and Surface User's Guide.
You will also be able to create planes normal to the curve at these points, by checking the Create
normal planes also option, and to create all instances in a new geometrical set by checking the
Create in a Body option. If the latter option is not checked, instances are created in the current
geometrical set.

❍

❍

If the curve is infinite and no reference point is explicitly given, by default, the reference
point is the projection of the model's origin
If the curve is a closed curve, either the system detects a vertex on the curve that can be
used as a reference point, or it creates an extremum point, and highlights it (you can then
select another one if you wish) or the system prompts you to manually select a reference
point.

Extremum points created on a closed curve are aggregated under their parent command and put in no
show in the specification tree.

On plane

Quick Surface Reconstruction

●

●

●

●
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Select a plane.
❍
If you select one of the planes of any local axis system as the plane, the origin of this axis system
is set as the reference point and featurized. If you modify the origin of the axis system, the
reference point is modified accordingly.
Optionally, select a point to define a reference for computing coordinates in the plane.
❍
If no point is selected, the projection of the model's origin on the plane is taken as reference.
Optionally, select a surface on which the point is projected normally to the plane.
❍
If no surface is selected, the behavior is the same.
Furthermore, the reference direction (H and V vectors) is computed as follows:
With N the normal to the selected plane (reference plane), H results from the vectorial product of
Z and N (H = Z^N).
If the norm of H is strictly positive then V results from the vectorial product of N and H (V = N^H).
Otherwise, V = N^X and H = V^N.
Would the plane move, during an update for example, the reference direction would then be
projected on the plane.
Click in the plane to display a point.

Quick Surface Reconstruction
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On surface

●

Select the surface where the point is to be created.

●

Optionally, select a reference point. By default, the surface's middle point is taken as reference.

●

You can select an element to take its orientation as reference direction or a plane to take its normal as
reference direction.
You can also use the contextual menu to specify the X, Y, Z components of the reference direction.

●

Enter a distance along the reference direction to display a point.

●

Choose the dynamic positioning of the point:
❍

Coarse (default behavior): the distance computed between the reference point and the mouse
click is an euclidean distance. Therefore the created point may not be located at the location of the
mouse click (see picture below).
The manipulator (symbolized by a red cross) is continually updated as you move the mouse over
the surface.

Quick Surface Reconstruction

❍
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Fine: the distance computed between the reference point and the mouse click is a geodesic
distance. Therefore the created point is located precisely at the location of the mouse click.
The manipulator is not updated as you move the mouse over the surface, only when you click on
the surface.

Sometimes, the geodesic distance computation fails. In this case, an euclidean distance might be used
and the created point might not be located at the location of the mouse click. This is the case with closed
surfaces or surfaces with holes. We advise you to split these surfaces before creating the point.

Circle/Sphere center

Quick Surface Reconstruction

●

Select a circle, circular arc, or ellipse, or

●

Select a sphere or a portion of sphere.
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A point is displayed at the center of the selected element.

Tangent on curve
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Select a planar curve and a direction line.
A point is displayed at each tangent.
The Multi-Result Management dialog box is displayed because several points are generated. Refer to
the Managing Multi-Result Operations chapter.

Between

●

●

Select any two points.

Enter the ratio, that is the percentage of the distance from the first selected point, at which the new
point is to be.
You can also click Middle Point button to create a point at the exact midpoint (ratio = 0.5).
Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not
closed) when using the Middle Point option.

●

Use the Reverse direction button to measure the ratio from the second selected point.

Quick Surface Reconstruction
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If the ratio value is greater than 1, the point is located on the virtual line beyond the selected
points.
3. Click OK to create the point.
The point (identified as Point.xxx) is added to the specification tree.

●

●

Parameters can be edited in the 3D geometry. For more information, refer
to the Editing Parameters chapter.
You can isolate a point in order to cut the links it has with the geometry
used to create it. To do so, use the Isolate contextual menu. For more
information, refer to the Isolating Geometric Elements chapter.
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Creating Lines
This task shows the various methods for creating lines:
●

point to point

●

point and direction

●

angle or normal to curve

●

tangent to curve

●

normal to surface

●

bisecting

It also shows you how to create a line up to an element, define the length type and automatically reselect
the second point.
Open the Lines1.CATPart document.

1. Click the Line icon

.

The Line Definition dialog box is displayed.
2. Use the drop-down list to choose the desired line type.
A line type will be proposed automatically in some cases depending on your first element selection.

A new lock button

is available besides the Line type to prevent an automatic change of the type

while selecting the geometry. Simply click it so that the lock turns red
.
For instance, if you choose the Point-Point type, you are not able to select a line. May you want to select a
line, choose another type in the combo list.

Defining the line type
Point - Point

Quick Surface Reconstruction

●

●
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Select two points.
A line is displayed between the two points.
Proposed Start and End points of the new line are shown.

If needed, select a support surface.
In this case a geodesic line is created, i.e. going from one point to the other according to the shortest
distance along the surface geometry (blue line in the illustration below).
If no surface is selected, the line is created between the two points based on the shortest distance.

Quick Surface Reconstruction
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If you select two points on closed surface (a cylinder for example), the result may be unstable.
Therefore, it is advised to split the surface and only keep the part on which the geodesic line will
lie.

●

●

Specify the Start and End points of the new line, that is the line endpoint location in relation to the
points initially selected.
These Start and End points are necessarily beyond the selected points, meaning the line cannot be
shorter than the distance between the initial points.
Check the Mirrored extent option to create a line symmetrically in relation to the selected Start and
End points.
The projections of the 3D point(s) must already exist on the selected support.

Point - Direction

Quick Surface Reconstruction

●

●
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Select a reference Point and a Direction line.
A vector parallel to the direction line is displayed at the reference point.
Proposed Start and End points of the new line are shown.

Specify the Start and End points of the new line.
The corresponding line is displayed.
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Select a reference Curve and a Support surface containing that curve.
❍
If the selected curve is planar, then the Support is set to Default (Plane).
❍

If an explicit Support has been defined, a contextual menu is available to clear the selection.

●

Select a Point on the curve.

●

Enter an Angle value.

A line is displayed at the given angle with respect to the tangent to the reference curve at the selected
point. These elements are displayed in the plane tangent to the surface at the selected point.
You can click on the Normal to Curve button to specify an angle of 90 degrees.
Proposed Start and End points of the line are shown.
●

●

Specify the Start and End points of the new line.
The corresponding line is displayed.
Click the Repeat object after OK if you wish to create more lines with the same definition as the
currently created line.
In this case, the Object Repetition dialog box is displayed, and you key in the number of instances to
be created before pressing OK.

As many lines as indicated in the dialog box are created, each separated from the initial line by a
multiple of the angle value.
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You can select the Geometry on Support check box if you want to create a geodesic line onto a
support surface.
The figure below illustrates this case.
Geometry on support option not checked:
Geometry on support option checked:

This line type enables to edit the line's parameters. Refer to Editing Parameters to find out more.

Tangent to curve

Quick Surface Reconstruction

●
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Select a reference Curve and a point or another Curve to define the tangency.
❍
if a point is selected (mono-tangent mode): a vector tangent to the curve is displayed at
the selected point.
❍

If a second curve is selected (or a point in bi-tangent mode), you need to select a support plane.
The line will be tangent to both curves.
■
If the selected curve is a line, then the Support is set to Default (Plane).
■

If an explicit Support has been defined, a contextual menu is available to clear the selection.

Quick Surface Reconstruction
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When several solutions are possible, you can choose one (displayed in red) directly in the
geometry, or using the Next Solution button.
Line tangent to curve at a given point:
Line tangent to two curves:

●

Specify Start and End points to define the new line.
The corresponding line is displayed.

Normal to surface
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Select a reference Surface and a Point.
A vector normal to the surface is displayed at the reference point.
Proposed Start and End points of the new line are shown.

If the point does not lie on the support surface, the minimum distance between the point and the
surface is computed, and the vector normal to the surface is displayed at the resulted reference point.
●

Specify Start and End points to define the new line.
The corresponding line is displayed.
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Bisecting

Version 5 Release 16

Page 332

Quick Surface Reconstruction
●

●

●

●

●
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Select two lines. Their bisecting line is the line splitting in two equals parts the angle between these
two lines.
Select a point as the starting point for the line. By default it is the intersection of the bisecting line and
the first selected line.
Select the support surface onto which the bisecting line is to be projected, if needed.
Specify the line's length by defining Start and End values (these values are based onto the default
start and end points of the line).
The corresponding bisecting line, is displayed.
You can choose between two solutions, using the Next Solution button, or directly clicking the
numbered arrows in the geometry.

3. Click OK to create the line.
The line (identified as Line.xxx) is added to the specification tree.

●

●

●

●

●

●

Regardless of the line type, Start and End values are specified by entering
distance values or by using the graphic manipulators.
Start and End values should not be the same.
Check the Mirrored extent option to create a line symmetrically in relation
to the selected Start point.
It is only available with the Length Length type.
In most cases, you can select a support on which the line is to be created.
In this case, the selected point(s) is projected onto this support.
You can reverse the direction of the line by either clicking the displayed
vector or selecting the Reverse Direction button (not available with the
point-point line type).
Parameters can be edited in the 3D geometry. For more information, refer
to the Editing Parameters chapter.

Quick Surface Reconstruction
●
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You can isolate a line in order to cut the links it has with the geometry used
to create it. To do so, use the Isolate contextual menu. For more
information, refer to the Isolating Geometric Elements chapter.

You cannot create a line of which points have a distance lower than the
resolution.

Creating a line up to an element
This capability allows you to create a line up to a point, a curve, or a surface.
It is available with all line types, but the Tangent to curve type.

Up to a point
●

Select a point in the Up-to 1 and/or Up-to 2 fields.
Here is an example with the Bisecting line type, the Length Length type, and a point as Up-to 2
element.

Up to a curve

Quick Surface Reconstruction
●
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Select a curve in the Up-to 1 and/or Up-to 2 fields.
Here is an example with the Point-Point line type, the Infinite End Length type, and a curve as the
Up-to 1 element.

Up to a surface
●

Select a surface in the Up-to 1 and/or Up-to 2 fields.
Here is an example with the Point-Direction line type, the Length Length type, and the surface as the
Up-to 2 element.

●

●

If the selected Up-to element does not intersect with the line being created, then an
extrapolation is performed. It is only possible if the element is linear and lies on the
same plane as the line being created.
However, no extrapolation is performed if the Up-to element is a curve or a surface.
The Up-to 1 and Up-to 2 fields are grayed out with the Infinite Length type, the Upto 1 field is grayed out with the Infinite Start Length type, the Up-to 2 field is
grayed out with the Infinite End Length type.

●

The Up-to 1 field is grayed out if the Mirrored extent option is checked.

●

In the case of the Point-Point line type, Start and End values cannot be negative.
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Defining the length type
●

Select the Length Type:
❍
Length: the line will be defined according to the Start and End points values
❍

Infinite: the line will be infinite

❍

Infinite Start Point: the line will be infinite from the Start point

❍

Infinite End Point: the line will be infinite from the End point
By default, the Length type is selected.
The Start and/or the End points values will be grayed out when one of the Infinite
options is chosen.

Reselecting automatically a second point
This capability is only available with the Point-Point line method.

1. Double-click the Line icon

.

The Line dialog box is displayed.
2. Create the first point.
The Reselect Second Point at next start option appears in the Line dialog box.
3. Check it to be able to later reuse the second point.
4. Create the second point.
5. Click OK to create the first line.
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The Line dialog box opens again with the first point initialized with the second point of the first
line.
6. Click OK to create the second line.

To stop the repeat action, simply uncheck the option or click Cancel in the Line Definition
dialog box.
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Creating Planes
This task shows the various methods for creating planes:
●

offset from a plane

●

parallel through point

●

angle/normal to a plane

●

through three points

●

through two lines

●

through a point and a line

●

through a planar curve

●

normal to a curve

●

tangent to a surface

●

equation

●

mean through points

Open the Planes1.CATPart document.

1. Click the Plane icon

.

The Plane Definition dialog box appears.
2. Use the combo to choose the desired Plane type.
Once you have defined the plane, it is represented by a green square symbol, which you can
move using the graphic manipulator.

A new lock button

is available besides the Plane type to prevent an automatic change of the type

while selecting the geometry. Simply click it so that the lock turns red
.
For instance, if you choose the Through two lines type, you are not able to select a plane. May you want
to select a plane, choose another type in the combo list.

Offset from plane

Quick Surface Reconstruction
●

●

●
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Select a reference Plane then enter an Offset value.
A plane is displayed offset from the reference plane.

Use the Reverse Direction button to reverse the change the offset direction, or simply
click on the arrow in the geometry.
Click the Repeat object after OK if you wish to create more offset planes.
In this case, the Object Repetition dialog box is displayed, and you key in the number of
instances to be created before pressing OK.

As many planes as indicated in the dialog box are created (including the one you were
currently creating), each separated from the initial plane by a multiple of the Offset value.

Parallel through point

Quick Surface Reconstruction

●
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Select a reference Plane and a Point.

A plane is displayed parallel to the reference plane and passing through the selected point.

Angle or normal to plane

Quick Surface Reconstruction

●

●
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Select a reference Plane and a Rotation axis.
This axis can be any line or an implicit element, such as a cylinder axis for example. To
select the latter press and hold the Shift key while moving the pointer over the element,
then click it.
Enter an Angle value.

The plane is displayed such as its center corresponds to the projection of the center of the
reference plane on the rotation axis. It is oriented at the specified angle to the reference
plane.
●

●

Check the Project rotation axis on reference plane option if you wish to project the
rotation axis onto the reference plane. If the reference plane is not parallel to the rotation
axis, the created plane is rotated around the axis to have the appropriate angle with regard
to reference plane.
Check the Repeat object after OK option if you wish to create more planes at an angle
from the initial plane.
In this case, the Object Repetition dialog box is displayed, and you key in the number of
instances to be created before pressing OK.
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Version 5 Release 16

Page 342

As many planes as indicated in the dialog box are created (including the one you were
currently creating), each separated from the initial plane by a multiple of the Angle value.
Here we created five planes at an angle of 20 degrees.

This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find
out how to display these parameters in the 3D geometry.

Through three points

●

Select three points.

The plane passing through the three points is displayed. You can move it simply by dragging
it to the desired location.
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Through two lines

●

●

Select two lines.
The plane passing through the two line directions is displayed.
When these two lines are not coplanar, the vector of the second line is moved to the first line location
to define the plane's second direction.

Check the Forbid non coplanar lines option to specify that both lines be in the same plane.

Quick Surface Reconstruction
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Through point and line

●

Select a Point and a Line.

The plane passing through the point and the line is displayed.
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Through planar curve

●

Select a planar Curve.

The plane containing the curve is displayed.

Normal to curve
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●

Select a reference Curve.

●

You can select a Point. By default, the curve's middle point is selected.
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It can be selected outside the curve.

A plane is displayed normal to the curve with its origin at the specified point. The normal is
computed at the point on the curve that is the nearest to the selected point.

Tangent to surface
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●
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Select a reference Surface and a Point.

A plane is displayed tangent to the surface at the specified point.
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Equation

●

●

●

Enter the A, B, C, D components of the Ax + By + Cz = D plane equation.
Select a point to position the plane through this point, you are able to modify A, B, and C
components, the D component becomes grayed.

When the command is launched at creation, the initial value in the Axis System field is the
current local axis system. If no local axis system is current, the field is set to Default.
Whenever you select a local axis system, A, B, C, and D values are changed with respect to
the selected axis system so that the location of the plane is not changed. This is not the
case with values valuated by formulas: if you select an axis system, the defined formula
remains unchanged.
This option replaces the Coordinates in absolute axis-system option.

Quick Surface Reconstruction
●

●
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Use the Normal to compass button to position the plane perpendicular to the compass
direction.

Use the Parallel to screen button to parallel to the screen current view.

Mean through points
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Select three or more points to display the mean plane through these points.

It is possible to edit the plane by first selecting a point in the dialog box list then choosing
an option to either:
❍
Remove the selected point
❍

Replace the selected point by another point.

3. Click OK to create the plane.
The plane (identified as Plane.xxx) is added to the specification tree.

●

●

Parameters can be edited in the 3D geometry. For more information, refer to the
Editing Parameters chapter.
You can isolate a plane in order to cut the links it has with the geometry used to
create it. To do so, use the Isolate contextual menu. For more information, refer to
the Isolating Geometric Elements chapter.
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Creating Circles
This task shows the various methods for creating circles and circular arcs:
●

center and radius

●

center and point

●

two points and radius

●

three points

●

center and axis

●

bitangent and radius

●

bitangent and point

●

tritangent

●

center and tangent

Open the Circles1.CATPart document.
Note that you need to put the desired geometrical set in current to be able to perform the corresponding
scenario.
1. Click the Circle icon

.

The Circle Definition dialog box appears.
2. Use the drop-down list to choose the desired circle type.

A new lock button

is available besides the Circle type to prevent an automatic change of the type

while selecting the geometry. Simply click it so that the lock turns red
.
For instance, if you choose the Center and radius type, you are not able to select an axis. May you want
to select an axis, choose another type in the combo list.

Center and radius

Quick Surface Reconstruction
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●

Select a point as circle Center.

●

Select the Support plane or surface where the circle is to be created.

●
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Enter a Radius value.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
For a circular arc, you can specify the Start and End angles of the arc.

If a support surface is selected, the circle lies on the plane tangent to the surface at
the selected point.
Start and End angles can be specified by entering values or by using the graphic
manipulators.
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Center and point

●

Select a point as Circle center.

●

Select a Point where the circle is to be created.

●

Select the Support plane or surface where the circle is to be created.
The circle, which center is the first selected point and passing through the second point or
the projection of this second point on the plane tangent to the surface at the first point, is
previewed.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
For a circular arc, you can specify the Start and End angles of the arc.

Two points and radius

Quick Surface Reconstruction

●

●

Select two points on a surface or in the same plane.
Select the Support plane or surface.
You can select a direction as the support. The support is calculated using this
direction and the two input points. The plane passing through the two points and
whose normal is closest to the given direction is computed as follows:
❍

❍

Let's take V1 as the vector P1P2, where P1 and P2 are the input
points.
Let's take V2 as the user direction (which can be the compass
direction).

❍

Compute V3 = V1 X V2 (cross product).

❍

Compute V4 = V3 X V1 (cross product).

❍

The support plane is normal to V4 and passing through P1 and P2.

❍

●
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Note that if V2 is orthogonal to V1, V4 = V2 and the support plane is
normal to V2 (user direction).

Enter a Radius value.
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The circle, passing through the first selected point and the second point or the projection of
this second point on the plane tangent to the surface at the first point, is previewed.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two
selected points as end points.
You can use the Next Solution button, to display the alternative arc.

With a plane as Support

Three points

With a direction as Support (the computed plane is
shown in blue)

Quick Surface Reconstruction
●
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Select three points where the circle is to be created.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two of the
selected points as end points.

Center and axis

Quick Surface Reconstruction
●
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Select the axis/line.
It can be any linear curve.

●

Select a point.

●

Enter a Radius value.

●
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Set the Project point on axis/line option:
❍
checked (with projection): the circle is centered on the reference point and projected
onto the input axis/line and lies in the plane normal to the axis/line passing through the
reference point. The line will be extended to get the projection if required.
❍

unchecked (without projection): the circle is centered on the reference point and lies in
the plane normal to the axis/line passing through the reference point.

With projection

Bi-tangent and radius

Without projection

Quick Surface Reconstruction

●

●

●
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Select two Elements (point or curve) to which the circle is to be tangent.
Select a Support surface.
If one of the selected inputs is a planar curve, then the Support is set to Default
(Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear
the selection in order to select the desired support.
This automatic support definition saves you from performing useless selections.
Enter a Radius value.
Several solutions may be possible, so click in the region where you want the circle to be.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
For a circular arc, you can specify the trimmed or complementary arc using the two tangent
points as end points.

You can select the Trim Element 1 and Trim Element 2 check boxes to trim the first
element or the second element, or both elements.
Here is an example with Element 1 trimmed.

These options are only available with the Trimmed circle limitation.

Bi-tangent and point
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●

●

●
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Select a point or a curve to which the circle is to be tangent.
Select a Curve and a Point on this curve.
The point will be projected onto the curve.
Select a Support plane or planar surface.
If one of the selected inputs is a planar curve, then the Support is set to Default
(Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear
the selection in order to select the desired support.
This automatic support definition saves you from performing useless selections.
Several solutions may be possible, so click in the region where you want the circle to be.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed.
Complete circle:

Trimmed circle:
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Complementary trimmed circle:

You can select the Trim Element 1 and Trim Element 2 check boxes to trim the first
element or the second element, or both elements.
Here is an example with both elements trimmed.

These options are only available with the Trimmed circle limitation.

Tritangent
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Select three Elements to which the circle is to be tangent.
Select a Support planar surface.
If one of the selected inputs is a planar curve, then the Support is set to Default
(Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear
the selection in order to select the desired support.
This automatic support definition saves you from performing useless selections.
Several solutions may be possible, so select the arc of circle that you wish to create.
Depending on the active Circle Limitations icon, the corresponding circle or circular arc is
displayed. The first and third elements define where the relimitation ends.
For a circular arc, you can specify the trimmed or complementary arc using the two tangent
points as end points.
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You can select the Trim Element 1 and Trim Element 3 check boxes to trim the first
element or the third element, or both elements.
Here is an example with Element 3 trimmed.

❍

❍

These options are only available with the Trimmed circle limitation.
You cannot create a tritangent circle if an input point lies on an input wire. We
advise you to use the bi-tangent and point circle type.

Center and tangent
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There are two ways to create a center and tangent circle:
1. Center curve and radius:
❍

Select a curve as the Center Element.
Select a Tangent Curve.
Enter a Radius value.

2. Line tangent to curve definition:
❍
Select a point as the Center Element.
❍

Select a Tangent Curve.
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If one of the selected inputs is a planar curve, then the Support is set to Default
(Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the
selection in order to select the desired support.
This automatic support definition saves you from performing useless selections.
The circle center will be located either on the center curve or point and will be tangent
to tangent curve.
Note that only full circles can be created.

3. Click OK to create the circle or circular arc.
The circle (identified as Circle.xxx) is added to the specification tree.

Using the Diameter/Radius options
●

You can click the Radius button to switch to a Diameter value. Conversely, click the Diameter button
to switch back to the Radius value.
This option is available with the Center and radius, Two point and radius, Bi-tangent and
radius, Center and tangent, and Center and axis circle types.
Note that the value does not change when switching from Radius to Diameter and vice-versa.

Using the Axis Computation option
●

You can select the Axis computation check box to automatically create axes while creating or
modifying a circle. Once the option is checked, the Axis direction field is enabled.
❍

If you do not select a direction, an axis normal to the circle will be created.

❍

If you select a direction, two more axes features will be created: an axis aligned with the reference
direction and an axis normal to the reference direction.

In the specification tree, the axes are aggregated under the Circle feature. You can edit their
directions but cannot modify them.
If the datum mode is active, the axes are not aggregated under the Circle features, but one ore three
datum lines are created.
Axis normal to the circle:
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Axis aligned with the reference direction (yz plane):

Axis normal to the reference direction (yz plane) :

●

If you select the Geometry on Support option and the selected support
is not planar, then the Axis Computation is not possible.

●

You can select the Geometry on Support check box if you want the
circle to be projected onto a support surface.
In this case just select a support surface.
This option is available with the Center and radius, Center and point,
Two point and radius, and Three points circle types.

●

When several solutions are possible, click the Next Solution button to
move to another arc of circle, or directly select the arc you want in the 3D
geometry.

●

A circle may have several points as center if the selected element is made
of various circle arcs with different centers.
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Parameters can be edited in the 3D geometry. For more information, refer
to the Editing Parameters chapter.
You can isolate a plane in order to cut the links it has with the geometry
used to create it. To do so, use the Isolate contextual menu. For more
information, refer to the Isolating Features chapter.
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Interoperability
Quick Surface Reconstruction complies with the following CATIA V5 standards:
Points in Generative Shape Design
Updating Parts
Using the Historical Graph
Creating Datums
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Points in Generative Shape Design
This task shows you how to use points from a cloud of points in Generative Shape Design.
Open the Interoperability.CATPart from the samples directory. We used the Line Definition for our
example, but the operating mode is the same for all creation action requiring points.
1. Select the type of creation from the combo list of the dialog box.
2. Go to the next Point field and choose Create Point from the contextual menu.

3. The Point Definition dialog box is displayed.
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4. Click a point on the cloud. Its coordinates are displayed in the Point Definition dialog box. Click
OK to confirm the creation of this point.
5. In the main dialog box, go to the next Point field and repeat the above steps as many times as
necessary.
6. If necessary, push the Point icon on the right of the Point field to modify the point you have
created: the Point Definition dialog box is displayed and updated according to your pick on the
cloud.
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Updating Parts
This page explains how and when you should update your design. The following topics are discussed:
●
Overview
●

What Happens When the Update Fails? (scenario)

●

Canceling Updates

●

Interrupting Updates (scenario)

●

Update All Command

Overview
The point of updating a part is to make the application take your very last operation into account. Although some operations
such as confirming the creation of features (clicking OK) do not require you to use the Update command because by default
the application automatically does it, some changes to sketches, features etc. require the rebuild of the part.

To warn you that an update is needed, the application displays the update symbol next to the part's name
geometry in bright red.

and shows the

Keep in mind that:
●

●

To update the feature of your choice, just right-click that feature and select Local Update.
Besides the update modes, you can also choose to visualize the update on the geometry as it is happening by checking the
Activate Local Visualization option from the Tools > Options > Infrastructure > Part Infrastructure, General tab.
In this case, as soon as you have clicked the Update icon
❍
the geometry disappears from the screen;
❍

:

each element is displayed as it is updated, including elements in No Show mode. Once they have been updated, they
remain in No Show mode.

Two Update Modes
To update a part, the application provides two update modes:
●

●

automatic update, available in Tools > Options > Infrastructure > Part Infrastructure. If selected, this option lets
the application update the part when needed.
manual update, available in Tools > Options-> Infrastructure > Part Infrastructure: lets you control the updates of
your design. What you have to do is just click the Update All icon
whenever you wish to integrate modifications.
The Update capability is also available via Edit > Update and the Update contextual menu item. A progression bar
indicates the evolution of the operation.

What Happens When the Update Fails?
Sometimes, the update operation is not straightforward because for instance, you entered inappropriate edit values or because
you deleted a useful geometrical element. In both cases, the application requires you to reconsider your design. The following
scenario exemplifies what you can do in such circumstances.
Open the Update3.CATPart document.
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1. Enter the Sketcher to replace the circular edge of the initial sketch with a line, then return to Part Design.

The application detects that this operation affects the shell. A yellow symbol displays on the feature causing trouble i.e.
the shell in the specification tree. Moreover, a dialog box appears providing the diagnosis of your difficulties and the
preview no longer shows the shell:

To resolve the problem, the dialog box provides the following options. If you wish to rework Shell.1, you can:
❍

Edit it

❍

Deactivate it

❍

Isolate it

❍

Delete it

2. For the purposes of our scenario that is rather simple, click Shell.1 if not already done, then Edit.
The Feature Definition Error window displays, prompting you to change specifications. Moreover, the old face
you have just deleted is now displayed in yellow.
The text Removed Face is displayed in front of the face, thus giving you a better indication of the face that has
been removed. Such a graphic text is now available for Thickness and Union Trim features too.
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3. Click OK to close the window.
The Shell Definition dialog box appears.
4. Click the Faces to remove field if not already done and select the replacing face.

5. Click OK to close the Shell Definition dialog box and obtain a correct part. The shell feature is rebuilt.

Canceling Updates
You can cancel your updates by clicking the Cancel button available in the Updating...dialog box.

Interrupting Updates
This scenario shows you how to update a part and interrupt the update operation on a given feature by means of a useful
message you previously defined.
Open the Update.CATPart document and ensure that the manual update mode is on.
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1. Right-click Hole.1 as the feature from which the update will be interrupted and select the Properties contextual menu
item.
The Properties dialog box is displayed.
2. Check the Associate stop update option. This option stops the update process and displays the memo you entered in
the blank field. This capability is available in manual or automatic update mode.

3. Enter any useful information you want in the blank field. For instance, enter "Fillet needs editing".
4. Click OK to confirm and close the dialog box.
The entity Stop Update.1 is displayed in the specification tree, below Hole.1, indicating that the hole is the last feature
that will be updated before the message window displays.

5. Edit Sketch.1, which will invoke an update operation.
When quitting the Sketcher, the part appears in bright red.

6. Run the update operation by clicking the

icon.

The Updating... as well as the Stop Update message windows are displayed. The Stop Update windows displays your
memo and lets you decide whether you wish to stop the update operation or continue it.

Version 5 Release 16

Quick Surface Reconstruction

Page 374

7. Click Yes to finish.
The part is updated. You can now edit the fillet if you consider it necessary.
Using this capability in automatic update mode, the Stop Update dialog box that displays is merely informative.

8. If you decide not to use this capability any longer, you can either:
❍

right-click Hole.1, select Properties and check the Deactivate stop update option: the update you will perform
will be a basic one. To show that the capability is deactivated for this feature, red parentheses precede Stop
Update.1 in the specification tree:

❍

.

right-click Stop Update.1 and select Delete to delete the capability.

Update All Command
The Update All command synchronizes copied solids linked to external references, but also updates the whole geometry of the
part. For information about external references, refer to Handling Parts in a Multi-document Environment in the Part Design
User's Guide.
There are cases where the command also displays the Replace Viewer window. This window either helps you redefine directions
if needed or is merely informative and therefore lets you check the validity of your geometry.
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Using the Historical Graph

This task shows how to use the Historical Graph.
Open any .CATPart document containing elements.
1. Select the element for which you want to display the historical graph.

2. Click the Show Historical Graph icon
The Historical Graph dialog box appears.

The following icon commands are available:
❍
Add graph
❍

Remove graph

❍

Reframe graph

❍

Surface or Part graph representation

❍

Parameters filter

❍

Constraints filter

3. Just close the dialog box to exit this mode.

.
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Creating Datums
This task shows how to create geometry with the History mode deactivated.
In this case, when you create an element, there are no links to the other entities that were used to
create that element.
1. Click the Create Datum icon
❍

❍

❍

❍

to deactivate the History mode.

It will remain deactivated until you click on the icon again.
If you double-click this icon, the Datum mode is permanent. You only have to click
again the icon to deactivate the mode.
A click on the icon activates the Datum mode for the current or the next command.
The History mode (active or inactive) will remain fixed from one session to another: it is
in fact a setting.
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Display Options and Graphic Properties
This task shows how to change the display option of clouds of points.
Open the Visu1.CATPart model the from the samples directory.
It consists of four clouds of points:
●
a mesh,
●

a cloud of points,

●

a set of scans,

●

a set of grids.

Their default colors are respectively:
●
orange,
●

green,

●

cyan,

●

cyan.

The display options are available from the Cloud Display Options box.
Further graphic properties are available from the Edit/Properties menu, in the Graphic tab.
From the Cloud Display Options box, you can:
●

Choose the sampling of clouds of points (N of 100 points are displayed).

●

Choose to display scans or grids as polylines, points, or both.

●

Choose to display triangles, free edges, non-manifold edges of meshes.
You can also choose their display mode: flat or smooth.

From the Edit/Properties menu, you can:
●

Choose the fill color of the mesh and its transparency level,

●

Choose the color and symbol of the points of a cloud,

●

Choose the color, type and thickness of scans and grids,

●

Choose to elements pickable or not.

Cloud Display Options box
The images below are only examples.

Quick Surface Reconstruction

1. Click the Cloud Display icon
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at the bottom of the screen.

The Cloud Display Option dialog box is displayed.

2. Select the cloud to modify. Display options are proposed according to the type of the cloud
selected:
Following options are not yet available:
❍
Protected,
❍

Orientation,

❍

Shrink,

❍

Normal.
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3. Choose the display options:

❍

For the cloud of points, you can choose to display only a percentage of the points making the
cloud,
using the Sampling option.
By default, 100% of the points are displayed. You can change this value with the associated
spinner.

Sampling=100

Sampling=25

The Symbol options are not available in that box, but in the Graphic Properties menu.
❍

For the sets of scans or grids, you can display them as line of points or points or both:

Quick Surface Reconstruction
❍
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For the mesh, you can:
■
display the triangles,

■

visualize only the vertices for a lighter display
(do not forget to de-activate the Smooth, Flat or Triangles options)

instead of
■

the free edges in yellow,

■

the non-manifold facets and their vertices in bold white lines.
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If you choose the display of triangles, the triangles accepting a non-manifold edge have
their edges displayed as regular white lines.

■

display the mesh as a smooth or a flat mesh.
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or

The free edges displayed are those of the complete cloud of points:
●
if you activate only a portion of a cloud of points, the free edges of that portion are not displayed.

Quick Surface Reconstruction

●

●

●
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if you remove a portion of a cloud of points, the free edges of the remaining portion are displayed.

If you move a cloud of points or a mesh, its graphic display options (not the graphic properties) are
lost.
The display options are not saved in the CATPart while the graphic properties are.
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Edit/Properties menu (Graphic tab)
For more information about this menu, please refer to the Displaying and Editing Graphic Properties
chapter in the CATIA Infrastructure user's guide.
The images below are only examples.
You can access this menu through Edit/Properties, or through the contextual menu of the element,
or display the Graphic Properties toolbar (View/Toolbars/Graphic Properties).
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or

●

The color displayed in the Graphic Properties toolbar applies to meshes only.

●

The graphic properties are saved in the CATPart.

●

Use Fill/Color and Transparency to modify the color and transparency of meshs:
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Please note that :
●
the color of mesh free edges is yellow, and is not editable,
●

the color of non-manifold edges is white, and is not editable,

●

the default color of scans has changed to cyan.

For a higher transparency quality, go to Tools/Options/Display/Performances and check the High
(Alpha blending) option.
●

●

●

Use Edges/Color, Line type and Thickness to modify the display of scans and grids or of the
triangles of a mesh :

Use Points/Color and Symbol to modify the display of clouds of points:

Use the Pickable check box to make an element pickable or not, and choose the pick option in the
list below.
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Managing Geometrical Sets
Geometrical sets enable to gather various features in a same set or sub-set and organize the specification
tree when it becomes too complex or too long. You can put any element you wish in the geometrical set,
it does not have to be structured in a logical way. The order of these elements is not meaningful as their
access as well as their visualization is managed independently and without any rule.
This task shows how to manage geometrical sets within the specification tree. This involves:
●

inserting a geometrical set

●

removing a geometrical set

●

changing body

●

sorting the contents of a geometrical set

●

reordering elements

You will find other useful information in the Managing Groups and Hiding/Showing chapters.
●

●

●

●

You can insert and manipulate geometrical sets in the specification tree in much the same way as you
manage files in folders. For instance, you can copy/paste elements from a geometrical set to a target
geometrical set.
These management functions have no impact on the part geometry.
When loading the Generative Shape Design workbench, a Geometrical Set automatically becomes the
current body.
This also means that only the results of the Hybrid Body, i.e. the result of all the operations performed
on geometry, is visible and not any intermediate state of the Hybrid Body.
You can define the Generative Shape Design feature that is to be seen when working with another
application, such as Generative Structural Analysis for example.
To do this, while in the Generative Shape Design workbench:
1. Choose the Tools -> External View... menu item.
The External View dialog box is displayed.
2. Select the element belonging to a Geometrical Set that should always been seen as the
current element when working with an external application.
3. Click OK in the dialog box.

The selected element will be the visible element in other applications, even if other
elements are created later in the .CATPart document, chronologically speaking.
To check whether an external view element has already been specified, choose the
Tools -> External View... menu item again. The dialog box will display the name of
the currently selected element. This also allows you to change elements through the
selection of another element. Note that you cannot deselect an external view element
and that only one element can be selected at the same time.
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Open any .CATPart document containing Geometrical Sets.
You can also open the GeometricalSets2.CATPart document.

Inserting a Geometrical Set
1. In the specification tree, select an element as the location of the new geometrical set.
This element will be considered as a child of the new geometrical set and can be a geometrical set
or a feature.
2. Select the Insert -> Geometrical Set menu command.
The Insert Geometrical Set dialog box is displayed.
The Features list displays the elements to be contained in the new geometrical set.
3. Enter the name of the new geometrical set.
4. Use the Father drop-down list to choose the body where the new geometrical set is to be inserted.
All destinations present in the document are listed allowing you to select one to be the father
without scanning the specification tree. They can be:
❍

geometrical sets

❍

parts

5. Select additional entities that are to be included in the new geometrical set.

If all selected entities belong to the same geometrical set, the father of the new geometrical
set is automatically set to the father of these entities.
6. Click OK to create the geometrical set at the desired location.
The result is immediate. CATIA displays this new Geometrical Set.x, incrementing its name in
relation to the pre-existing bodies, in the specification tree. It is created after the last current
geometrical set and is underlined, indicating that it is the active geometrical set. The next created
element is created within this geometrical set.
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You cannot create a geometrical set within an ordered geometrical set and vice versa.
You can check the Create a Geometrical Set when creating a new part option in Tools > Options -> Infrastructure -> Part Infrastructure -> Part Document tab if you wish
to create a geometrical set as soon as you create a new part. For more information about
this option, please refer to the Customizing section of the Part Design User's Guide.

Removing a Geometrical Set
Two methods are available:
1. If you want to delete the geometrical set and all its contents:

●

Right-click the geometrical set then select the Delete contextual command.
2. If you want to delete the geometrical set but keep its contents:
This is only possible when the father location of the geometrical set is another geometrical set.
This is not possible when the father location is a root geometrical set.

●

Right-click the desired geometrical set then select the Geometrical Set.x object -> Remove
Geometrical Set contextual command.
The geometrical set is removed and its constituent entities are included in the father geometrical set.
You cannot delete a feature within a geometrical set created on the fly. Indeed this geometrical
set is considered as private and can only be deleted globally.

Moving Elements of a Geometrical Set to a New Body
1. From the specification tree, select the element then choose the Geometrical Set.object ->
Change Geometrical Set... item from the contextual menu.
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Multi-selection of elements of different types is supported. However, note that the
contextual menu is not available, and that you can access this capability using the Edit
menu item.
The Change geometrical set dialog box is displayed, listing all the possible destinations.

2. Select the Destination body where the geometrical set is to be located.
Here we selected GeometricalSet.3.
You can do so by selecting the body in the specification tree, or using the drop-down list from the
dialog box.
By default, if you select a body, the geometrical set is positioned last within the new body.
However, you can select any element in the new body, before which the moved geometrical set
will be located.
3. Select the element above which the one you already selected is to be inserted.
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You can directly select this positioning element. In this case the Destination field is automatically
updated with the Body to which this second element belongs.
4. Click OK to move the geometrical set to the new body.
The element selected first is moved to its new location in the specification tree, but geometry
remains unchanged.

❍

❍

Check the Move unshared parents option to move all parents of the first selected element to
its new location, provided these parents are not shared by any other element of the initial
body.
In this case, all the unshared parents are highlighted prior to the move.
Check the Move all parents option to move all parents of the first selected element to its new
location, regardless of whether these parents are used (shared) by any other element of the
initial body.
In this case, all the parent elements are highlighted prior to the move.
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You can move a whole branch, i.e. a whole body and its contents, at a time.
Here we moved GeometricalSet.3 last in GeometricalSet.1.

You cannot move some elements of a multi-output alone to another body: only the whole
multi-output can be moved.

Sorting the Contents of a Geometrical Set
You may need to sort the contents of a Geometrical Set, when the geometric elements no longer appear
in the logical creation order. In that case, use the Auto-sort capability to reorder the Geometrical Set
contents in the specification tree (geometry itself is not affected).
The Geometrical Set.1 contains two extruded surfaces based on point-point lines. The specification tree
looks like this:
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1. Right-click Geometrical Set.1 from the specification and choose the Geometrical Set.1 object ->
AutoSort command.

Instantly, the contents of the Geometrical Set are reorganized to show the logical creation
process.
The geometry remains unchanged.

Reordering Elements within a Geometrical Set
This capability enables you to reorder elements inside the same geometrical set.
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1. Right-click Geometrical Set.1 from the specification tree and choose the Geometrical Set.1
object -> Reorder Children command.
The Reorder Children dialog box is displayed.
2. Select an element.
3. Use the arrows to move an element up or down.

Reordering Features
The Reorder command allows you to move a feature in a Geometrical Set. These features can be:
●
solids
●

shape features

●

sketches

Replacing Features
This capability is only available on shape features.
Please refer to the Replacing or Moving Elements chapter in the Part Design User's Guide.
To manage this capability, the Do replace only for elements situated after the In Work Object
option is available in Tools -> Options -> Part Infrastructure -> General tab. It allows you to make
the Replace option possible only for features located below the feature in Work Object and in the same
branch.
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Workbench Description
This chapter describes the menus, sub-menus, items and toolbars of the Quick Surface Reconstruction.

Menu Bar
Creation Toolbars
Analysis Toolbars
Specification Tree
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Menu Toolbar
This chapter describes the menus available in Quick Surface Reconstruction. Other menus are documented in
the Infrastructure User's Guide.
Start SmarTeam File Edit View Insert Tools Windows Help

Start

Starts Quick Surface
Reconstruction
Workbench

Insert
Geometrical set

Managing Geometrical
Sets

Ordered geometrical set

Managing Ordered
Geometrical Sets

Cloud Edition

Cloud Edition

Scan Creation

Scan Creation

Curve Creation

Curve Creation

Domain Creation

Domain Creation

Surface Creation

Surface Creation

Operations

Operations

Transformations

Transformations

Quick Surface Reconstruction
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Segmentation

Segmentation

Analysis

Analysis

WireFrame

WireFrame

Activation

Activating a Portion of
a Cloud of Points

Cloud Edition
Scan Creation
Curve Projection
Planar Sections
Free Edges

Projecting Curves
Cutting a Cloud of
Points or a Mesh by
Planar Sections
Creating Free Edges

Curve Creation

Curve from Scan

Creating Associative
3D Curves and
Creating Associative
3D Curves on Scans
Curves from Scans

Sketch from Scan

Sketch from Scan

Intersection
Projection

Creating Intersections
Creating Projections

3D Curve
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Domain Creation
Clean Contour

Clean Contour
Creation

Curves Network

Curves Network

Surface Creation

Surfaces Network

Basic Surface
Recognition
PowerFit
Creating Lofted
Surfaces
Surfaces Network

Automatic Surface

Automatic Surface

Join

Joining Surfaces or
Curves

Extrapolate

Extrapolating
Surfaces

Split

Splitting Geometry

Trim

Trimming Geometry

Curves Slice

Slicing curves

Adjust Nodes

Adjust Nodes

Split CleanContour

Splitting
CleanContour

Edge Fillet

Creating Edge Fillets

Translate
Rotate

Translating Geometry
Rotating Geometry
Transforming
Geometry by Scaling
Performing a
Symmetry on
Geometry
Transforming
Geometry by Affinity
Transforming
Elements from an
Axis to Another

Basic Surface Recognition
Power Fit
Multi-sections Surface

Operations

Transformations
Scale
Symmetry
Affinity
Axis To Axis
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Segmentation
Segmentation by Curvature
Segmentation by Slope

Segmentation by
Curvature Criterion
Segmentation by
Slope Criterion

Analysis
Information
Distance Analysis
Curvature Analysis
Connect Checker

Information
Analyzing Distances
Between Two Sets of
Elements
Performing a
Curvature Analysis
Checking Connections
Between Surfaces

WireFrame

Tools

Point

Creating Points

Line

Creating Lines

Plane

Creating Planes

Circle

Creating Circle

Quick Surface Reconstruction
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Display Options and
Graphic Properties

Quick Surface Reconstruction
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Creation Toolbars
This chapter describes the menus available in Quick Surface Reconstruction. Other menus are documented in
the Infrastructure User's Guide.
Geometrical Sets
Cloud Edition
Scan Creation
Curve Creation
Domain Creation
Surface Creation
Operations
Transformations
Segmentation
Analysis
WireFrame
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Geometrical Sets
For

See

Geometrical Sets

Managing Geometrical Sets

Ordered geometrical set Managing Ordered Geometrical Sets

Page 402

Quick Surface Reconstruction

Version 5 Release 16

Cloud Edition
For

See

Activate Activating a Portion of a Cloud of Points
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Scan Creation
For

See

Project Curves

Projecting Curves

Planar Sections Cutting a Cloud of Points or a Mesh by Planar Sections
Free Edges

Creating Free Edges
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Curve Creation
For
3D Curve

See
Creating Associative 3D Curves and
Creating Associative 3D Curves on a Scan of Cloud

Curves from Scans Curves from Scans
Sketch from Scan Sketch from Scan
Intersection

Creating Intersections

Projection

Creating Projections
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Domain Creation
For

See

Clean Contour

Clean Contour Creation

Curves Network Curves Network
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Surface Creation
For

See

Basic Surface Recognition Basic Surface Recognition
PowerFit

PowerFit

Multi-sections Surface

Creating Lofted Surfaces

Surfaces Network

Surfaces Network

Automatic Surface

Automatic Surface
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Cloud and Curve Operations
For

See

Join

Joining Surfaces or Curves

Extrapolate

Extrapolating Surfaces

Split

Splitting Geometry

Trim

Trimming Geometry

Curves Slice

Slicing Curves

Adjust nodes

Adjust Nodes

Split CleanContourSplitting CleanContours
Edge Fillet

Creating Edge Fillets
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Transformations
For:

See:

Translate

Translating Geometry

Rotate

Rotating Geometry

Symmetry Performing a Symmetry on Geometry
Scale

Transforming Geometry by Scaling

Affinity

Transforming Geometry by Affinity

Axis to AxisTransforming Elements from an Axis to Another
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Cloud Segmentation
For

See

Segmentation by Curvature Criterion Segmentation by Curvature Criterion
Segmentation by Slope Criterion

Segmentation by Slope Criterion
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Cloud Analysis
For

See

Information

Information

Distance Analysis

Analyzing Distances between two Sets of Elements

Curvature Analysis Performing a Curvature Analysis
Connect Checker

Checking Connections between Surfaces
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WireFrame
For

See

Point Creating Points
Line

Creating Lines

Plane Creating Planes
Circle Creating Circle
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Tools Toolbar
This chapter deals with:
Cloud Display Options Display Options and Graphic Properties
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Specification Tree

Within the Quick Surface Reconstruction workbench, you can generate a number of elements
that are identified in the specification tree by the following icons.
If you open a CATPart generated with other CATIA applications, other icons may appear in the specification tree.
Please note that the pictures below are only example. The names and contents of elements will vary according to your actions.

Further information on general symbols in the specification tree are available in Symbols Used in the Specification Tree.
Icon

Action

Icon

Action

Geometrical Sets

Group

Project Curves

Planar sections

Create Free Edges

3D Curve
Curve from Scans

Intersection

Projection

Clean Contour

Basic Surface Recognition

Basic Surface Recognition
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Basic Surface Recognition

Basic Surface Recognition

Powerfit, Surfaces Network

Curves Network

Loft Surface
Symmetry

Axis to Axis

Scale

Rotate

Translate

Affinity

Segmentation by Curvature or
Slope Criterion

Segmentation by Curvature or
Slope Criterion

Join

Adjust Nodes

Split

Trim

Extrapolate

Edge Fillet

Curves Slice

Split CleanContour

Distance Analysis

Curvature Analysis

Connect Checker
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Glossary

B
boundary

A boundary of trimmed or natural surfaces is defined by a clean contour.

C
clean contour A clean contour is a set of curves or surface edges, joined, ordered, eventually trimmed,
with G0, G1 or G2 continuity constraints.
curves

They may be created through:
●
sketches on meshs,
●

smoothing of scans,

●

blending of curves,

●

canonic recognition (line, circle),

●

accuracy checking.

S
scans

They can be obtained by :
●
the identification of feature points (boundaries, sharp edges, breaks in curvature, inflection
lines),
●

sketches on meshs.

segmentation This operation defines zones on the cloud of points through:
●
curvature criteria,
●

normal criteria (isoslope, outlines),

●

feature recognition (sphere, cylinder, plane, cone),

●

threshold of distance deviation from a given surface,

●

It may include scans or curves.

●

It may be automatic, manual or both.

Quick Surface Reconstruction

Version 5 Release 16

Index
Numerics
3D Curve
3D Curve on Scan

A
adding split points
curve from scans
advanced
powerfit
surfaces network
affinity
all point continuity
surfaces network
all tangent continuity
surfaces network
analysis
porcupine curvature
analyzing
curvature
distance between elements
surface connections
angle
segmentation by slope criterion
associative curve
creating
automatic
sketch from scan
automatic surface
free edge tolerance
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mean surface deviation
mesh
spikes
statistics
surface detail
target ratio
automatic tangency
curves network
automatic tangent constraint
cleancontour
AutoSort Geometrical Set
command
axis to axis

B
basic surface recognition
input
output

C
canceling
Update
checking connections
between surfaces
chordal error
project curves
circle
bi-tangent and point
bi-tangent and radius
center and axis
center and tangent
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point center and radius
sketch from scan
three points
tritangent
two points
two points and radius
cleancontour
automatic tangent constraint
closed contour
constraint on curves
editing the list of elements
how it works
closed contour
cleancontour
closed sections
multi-sections surfaces
cloud
surfaces network
cloud display
cloud display options
graphic properties
polyline and point
sampling
triangles
cloud display options
cloud display
color scale
command
3D Curve
Activate
Adjust Nodes
Affinity
Automatic Surface
AutoSort Geometrical Set
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Axis to Axis
Basic Surface Recognition
Change Body
Circle
CleanContour
CleanContour Split
Cloud Display
Connect Checker
Create Datum
Create Free Edges
Curve from Scans
Curves Network
Curves Slice
Distance Analysis
Edge Fillet
Extrapolate
Information
Insert Geometrical Set
Intersection
Join
Line
Multi-Sections Surface
Planar Sections
Plane
Point
Porcupine Curvature Analysis
PowerFit
Project Curves
Projection
Properties
Remove Geometrical Set
Reorder Body
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Rotate
Scaling
Segmentation by Curvature Criterion
Segmentation by Slope Criterion
Show Historical Graph
Sketch from Scan
Split
Surfaces Network
Symmetry
Translate
Trim
Update
compass
segmentation by slope criterion
compute with ribbons
surfaces network
connect checker
powerfit
constant radius
fillets
constrain on element
curve from scans
constraint
sketch from scan
constraint on curves
cleancontour
constraints
curves network
powerfit
surfaces network
contextual menu item
Properties
continuity
powerfit
corner
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reshaping
counterdraft
powerfit
coupling
multi-sections surfaces
create curves
planar sections
project curves
creating
associative curve
circles
circular arcs
datum
elements by affinity
elements by intersection
elements by projection
elements by rotation
elements by scaling
elements by symmetry
line
multi-sections surfaces
plane
creating point
curvature
analyzing
curvature analysis
curve from scans
curve from scans
adding split points
constrain on element
curvature analysis
interpolation
max. order
max. segments
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maximum deviation
maximum order
smoothing
split angle
tolerance
curves network
automatic tangency
constraints
default constraints
delete wire
deleting wire
display
freeze
max distance
min length
node tolerance
overlapping curves
projection on support
smoothing tolerance
support
curves overlaps
slicing curves

D
default constraints
curves network
delete wire
curves network
deleting wire
curves network
de-select all
surfaces network
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deviation
powerfit
surfaces network
display
curves network
display constraints
surfaces network
display selection
surfaces network
distance analysis

E
edges
filleting
editing the list of elements
cleancontour
elements
split
translating
elements by affinity
creating
ellipse
sketch from scan
extrapolate
extrapolating
surfaces

F
filleting
edges
fillets
constant radius
filter
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segmentation by curvature criterion
filtering
slicing curves
free edge tolerance
automatic surface
free edges
freeze
curves network

G
gap
powerfit
surfaces network
graphic properties
cloud display
guide
planar sections

H
historical graph
how it works
cleancontour

I
impose tangency
sketch from scan
influence area
planar sections
information
powerfit
init surface
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surfaces network
input
basic surface recognition
input elements
powerfit
Insert Geometrical Set
command
inserting
geometrical sets
interoperability
interpolation
curve from scans
interrupting
Update
intersection

J
join
joining
curves
surfaces

L
limiting curve
planar sections
line
bisecting
normal to surface
point-direction
point-point
sketch from scan
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tangent to curve
up to a curve
up to a point
up to a surface

M
managing
geometrical sets
manual coupling
multi-sections surfaces
max distance
curves network
slicing curves
max. order
curve from scans
max. segments
curve from scans
maximum deviation
curve from scans
maximum order
curve from scans
mean surface deviation
automatic surface
mesh
automatic surface
messages
slicing curves
min length
curves network
moving
geometrical sets
multi-sections surface
multi-sections surfaces
closed sections
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coupling
manual coupling
relimiting

N
node tolerance
curves network
not selected
surfaces network
nothing
sketch from scan

O
order
powerfit
surfaces network
output
basic surface recognition
segmentation by curvature criterion
segmentation by slope criterion
overlapping curves
curves network

P
parameters
powerfit
planar sections
create curves
guide
influence area
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limiting curve
scan type
plane
angle-normal to plane
equation
from equation
mean through points
normal to curve
offset from plane
parallel through point
tangent to surface
through planar curve
through point and line
through three points
through two lines
point
creating
point continuity
surfaces network
polyline and point
cloud display
porcupine curvature
analysis
porcupine curvature analysis
powerfit
advanced
connect checker
constraints
continuity
counterdraft
deviation
gap
information
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input elements
order
parameters
radius
segmentation
segments
show information
spikes
tension
primitive
sketch from scan
project curves
chordal error
create curves
projection direction
type of projection
working distance
projection
projection direction
project curves
projection on support
curves network
Properties
contextual menu item

R
radius
powerfit
surfaces network
relimiting
multi-sections surfaces
Remove Geometrical Set
command
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remove surface
surfaces network
removing
geometrical sets
Reorder Body
command
reordering
geometrical sets
reset parameters
surfaces network
reshaping
corner
results/display
surfaces network
rotate

S
sampling
cloud display
scaling
scan type
planar sections
segmentation
powerfit
surfaces network
segmentation by curvature criterion
filter
output
types
segmentation by slope criterion
angle
compass
output
segments
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powerfit
surfaces network
select all
surfaces network
selected
surfaces network
selecting
using multi-output
show information
powerfit
sketch from scan
automatic
circle
constraint
ellipse
impose tangency
line
nothing
primitive
threshold
tolerance
slicing curves
curves overlaps
filtering
max distance
messages
smoothing
curve from scans
smoothing tolerance
curves network
sorting
geometrical sets
spikes
automatic surface
powerfit
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surfaces network
split
split angle
curve from scans
splitting cleancontours
standard
surfaces network
statistics
automatic surface
support
curves network
surface detail
automatic surface
surfaces network
advanced
all point continuity
all tangent continuity
cloud
compute with ribbons
constraints
de-select all
deviation
display constraints
display selection
gap
init surface
not selected
order
point continuity
radius
remove surface
reset parameters
results/display
segmentation
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segments
select all
selected
spikes
standard
swap selection
tangent continuity
tension
tolerance
swap selection
surfaces network
symmetry

T
tangent continuity
surfaces network
target ratio
automatic surface
tension
powerfit
surfaces network
threshold
sketch from scan
tolerance
curve from scans
sketch from scan
surfaces network
translate
translating
elements
triangles
cloud display
trim
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type of projection
project curves
types
segmentation by curvature criterion

U
Update
canceling
command
interrupting

W
working distance
project curves
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